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DAQ Quick Start Guide
This guide describes how to install NI-DAQ 7.x driver software and a data 
acquisition (DAQ) device and confirm your device is operating properly. 

This guide does not apply to NI-DAQ for the Macintosh operating system. 
Refer to the NI-DAQ for Macintosh distribution.
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Conventions
The following conventions are used in this guide.

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. 

italic Italic text denotes a cross reference or an introduction to a key concept. This 
font also denotes text that is a placeholder for a word or value that you must 
supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, the proper names of disk drives, paths, directories, programs, 
functions, filenames, and extensions.

monospace bold Bold text in this font denotes the messages and responses that the computer 
automatically prints to the screen.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.

Where Do I Start?
Figure 1 shows the steps for installing NI-DAQ 7.x and a DAQ device, and 
where to find the relevant information in the documentation.
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Figure 1.  Installation Process Overview

* Device signal and terminal connections are available online from Measurement & Automation Explorer Help 
for Traditional NI-DAQ and Measurement & Automation Explorer Help for NI-DAQmx, which you access from 
the MAX Help menu. In addition, device signal connections and additional signal information is in the device 
documentation available from the Device Document Browser. Refer to Step 10. Browse or Install Device 
Documentation for instructions on using the device documentation.

Check the NI-DAQ 7.x Readme or the 
Operating System, Application Software, Programming 

and Device Support in NI-DAQ 7.1 section of this guide to see which 
 parts of NI-DAQ 7.x to install and use in your application. Do not  

install NI-DAQ 7.x if your existing applications include 
unsupported components.

NI-DAQmxTraditional 
NI-DAQ 

Use the DAQ Assistant, accessible 
from MAX or NI application software, 
to configure channels and measure-

ment tasks. Refer to the DAQ 
Assistant Help and Measurement 
& Automation Explorer Help for 

NI-DAQmx.

Use MAX to configure 
channels. Refer to Measurement &

Automation Explorer Help for 
Traditional NI-DAQ.

You have installed and configured your devices.

Confirm in the
NI-DAQ 7.x Readme you have

installed the correct version of the application
software. Do you need to 

upgrade? 

Upgrade using the instructions in
the application software.Yes

No

Yes

Install, configure, and test the 
module and/or chassis as described 

in the SCXI Quick Start Guide or 
NI Switches Getting Started Guide.

Configure channels as  
described in the quick start or getting 

started guide for your product. What API 
are you using to program

each device? 

Install your driver software and documentation 
using the instructions in this guide.

Install, configure, and test your DAQ device as described 
in this guide. Helpful information is also in the MAX

 help files for Traditional NI-DAQ and for 
NI-DAQmx, and the device terminal help*.

Read about the new NI-DAQmx application programming
interface (API) and the other API choices in NI-DAQ 7.x,

described in this guide.

Do you need to
install an SCXI or switch 

module? 

No

Are you configuring
an SCXI or a

switch module?

SCXI

switch



DAQ Quick Start Guide 4 ni.com

NI-DAQ 7.x Software
National Instruments measurement devices are packaged with NI-DAQ 
driver software, an extensive library of functions and VIs you can call from 
your application software, such as LabVIEW or LabWindows™/CVI™, to 
program all the features of your NI measurement devices. Measurement 
devices include DAQ devices such as the E Series multifunction I/O (MIO) 
devices, SCXI signal conditioning modules, and switch modules. Driver 
software has an application programming interface (API), which is a 
library of VIs, functions, classes, attributes, and properties for creating 
applications for your device.

NI-DAQ 7.x includes two NI-DAQ drivers, each with its own API, 
hardware configuration, and software configuration. 

• Traditional NI-DAQ is an upgrade of the earlier version of NI-DAQ. 
Traditional NI-DAQ has the same VIs and functions and works the 
same way as NI-DAQ 6.9.3, except that you can use Traditional 
NI-DAQ and NI-DAQmx on the same computer. 

• NI-DAQmx is the latest NI-DAQ driver with new VIs, functions, 
and development tools for programming measurement devices. 
NI-DAQmx has advantages over Traditional NI-DAQ:

– DAQ Assistant—a graphical way to configure channels and 
measurement tasks for your device for use in LabVIEW, 
LabWindows/CVI, and Measurement Studio. You also can use 
the DAQ Assistant to generate NI-DAQmx code based on your 
channels and tasks for use in NI application software programs.

– Increased performance, including faster single-point analog I/O 
and multithreading.

– Simpler, more intuitive APIs for creating DAQ applications using 
fewer functions and VIs than earlier versions of NI-DAQ.

– Expanded functionality in the NI-DAQmx API for LabVIEW, 
including property nodes for data acquisition and improved 
waveform data type support for analog I/O.

– Similar APIs and functionality for ANSI C, LabWindows/CVI, 
and Measurement Studio, including native .NET and C++ 
interfaces.

Who Can Use NI-DAQmx
Install and use NI-DAQmx if the following situations apply:

• You are using Windows.

• You are using only device(s) supported by NI-DAQmx. Refer to the 
Operating System, Application Software, Programming Language, 
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and Device Support in NI-DAQ 7.1 section for the list of supported 
devices.

• If you are using NI application software such as LabVIEW, 
LabWindows/CVI, or Measurement Studio, you must have version 7.x 
of the application software to use NI-DAQmx.

• If you use one of the Measurement Studio .NET languages or a device 
supported only by NI-DAQmx such as the PXI-4204 or PXI-4220 
module, you must use NI-DAQmx.

Who Must Use Traditional NI-DAQ
Install and use Traditional NI-DAQ if one of the following situations apply:

• You have a device that is not supported by NI-DAQmx, such as the 
AT E Series multifunction DAQ devices, or dynamic signal acquisition 
devices.

• You are using the LabVIEW Real-Time (RT) module.

• You are upgrading from NI-DAQ 6.9.x and have existing applications 
that you do not want to port to NI-DAQmx now. 

• You are using a version of LabVIEW, LabWindows/CVI, or 
Measurement Studio earlier than version 7.0.

• You are using Visual Basic 6.0.

Note The earliest version of NI application software supported by Traditional NI-DAQ 
is version 6.0. LabVIEW, LabWindows/CVI, or Measurement Studio versions 6.x can use 
Traditional NI-DAQ from the NI-DAQ 7.x distribution.

No Longer Supported in Traditional NI-DAQ
The following items supported by NI-DAQ 6.9.3 are no longer supported 
in Traditional NI-DAQ. 

• LabVIEW, LabWindows/CVI, or Measurement Studio application 
software versions earlier than 6.0

• Windows 95

• Some older devices, such as the 1200 Series multifunction DAQ 
devices, VXI DAQ devices, or remote SCXI devices.

Refer to the Operating System, Application Software, Programming 
Language, and Device Support in NI-DAQ 7.1 section at the end of 
this guide for the list of supported and unsupported items. 
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How NI-DAQ Fits into Your System
Figure 2 depicts the measurement system overview, showing the path of 
real-world physical phenomena to your measurement application.

Figure 2.  Measurement System Overview
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and manipulates the data so it can appear in a graph, chart, or file for a 
report. The software also controls the measurement system, telling the 
measurement device when and from which channels to acquire or generate 
data.

NI measurement devices and application software are packaged with 
NI-DAQ driver software to program all the features of your 
NI measurement device such as configuring, acquiring, and generating data 
from and sending data to NI measurement devices. Using NI-DAQ saves 
you from having to write these programs yourself. Application software, 
such as LabVIEW, sends the commands to the driver, such as acquire and 
return a thermocouple reading, and then displays and analyzes the data 
acquired.

You can use the NI-DAQ driver from LabVIEW or from any programming 
environment that supports calling dynamic link libraries (DLLs) through 
ANSI C interfaces. Regardless of the programming environment, your 
DAQ application uses NI-DAQ, as illustrated in Figure 2. 

Step 1. Confirm That You Have Installed the Correct 
Application Software Version

Install your NI application software, including LabVIEW, 
LabWindows/CVI, and Measurement Studio, now. You must use 
NI application software version 7.0 or later with NI-DAQmx. You can 
use NI application software version 6.0 or later with Traditional NI-DAQ. 
Refer to the Operating System, Application Software, Programming 
Language, and Device Support in NI-DAQ 7.1 section at the end of this 
guide.

Tip If you have an existing application written with an earlier version of your application 
software or NI-DAQ, make a backup copy of the application. You then can upgrade your 
software and modify the application. If you want to use the original application unchanged 
with the Traditional NI-DAQ API, you can use the backup copy.

Step 2. Uninstall NI-DAQ if You Are Upgrading from a 
Previous Version

If you are upgrading to NI-DAQ 7.x from a previous version, uninstall 
the earlier version of NI-DAQ before installing the current version. Use 
Control Panels»Add/Remove Programs. Refer to ni.com/support/ 
install for operating system-specific uninstallation instructions. 
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Step 3. Install the NI-DAQ 7.x Software

Insert the CD

Caution Do not install NI-DAQ 7.x if your existing applications include unsupported 
components. Before installing the software, refer to the NI-DAQ 7.x Readme on the 
NI-DAQ 7.x CD or the Operating System, Application Software, Programming Language, 
and Device Support in NI-DAQ 7.1 section at the end of this guide.

The NI-DAQ 7.x installer should open automatically. If not, select Start» 
Run. Enter x:\setup.exe, where x is the letter of the CD drive. For 
troubleshooting and operating system-specific instructions, refer to 
the Hardware Installation Wizard at ni.com/support/install.

Tip Install your driver software before installing new devices, or Windows might not 
detect your device, and you might see warnings asking you to install the driver.

Choose the API(s) to Install

Caution NI-DAQ 7.x cannot exist on the same system with earlier versions of NI-DAQ. 
When you install NI-DAQ 7.x, the latest version of Traditional NI-DAQ replaces earlier 
versions of NI-DAQ and any support files installed by the earlier version. Earlier versions 
of NI-DAQ are removed when you install NI-DAQmx. 

NI-DAQ 7.x contains several drivers and their APIs—Traditional NI-DAQ, 
NI-DAQmx, and NI-SWITCH. You can install any or all of the drivers, 
depending on the devices you are using. Refer to Table 3, NI-DAQ 7.1 
Device Support, at the end of this guide to see which API(s) to install 
for the devices in your system. Refer to the NI-DAQ 7.x Software section 
at the beginning of this guide for descriptions of Traditional NI-DAQ and 
NI-DAQmx. 
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Install and use NI-SWITCH to program an NI switch module. NI-SWITCH 
is an IVI-compliant switch instrument driver that supports all NI switch 
modules. NI-SWITCH has an interactive soft front panel for testing and 
troubleshooting switch applications. NI-SWITCH is a driver layer on top 
of the NI-DAQmx and Traditional NI-DAQ drivers. NI-SWITCH 2.1 
requires you to install NI-DAQmx and NI-VISA 3.0. 

Install Support Files
The NI-DAQ 7.x installer detects the NI software installed on the system 
and automatically selects the latest versions of the driver, application 
software, and language support files from the CD. 

 

1. Verify that the installer detected and selected the correct support files 
and the correct version number of the application software and/or 
language. Double-click the plus sign in front of a feature to expand 
the list of feature subcomponents as shown above. You can select 
additional options to install the support files, examples, and 
documentation. Follow the software prompts. 

Note If you install NI-DAQ 7.x first, then later install NI application software version 7.x, 
you must run the NI-DAQ 7.x installer again to install the correct application software 
support. Select Start»Run. Enter x:\setup.exe, where x is the letter of the CD drive.

2. Click Finish. 
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3. When the installer completes, a message opens asking if you want to 
restart, shut down, or exit. 

• If you have an NI 435x device and are using LabWindows/CVI, C, 
C++, Visual Basic, or the VirtualBench-Logger, exit and install 
the software from the NI 435x CD. 

• If you are ready to install your device, shut down.

4. Power off and unplug the computer or PXI chassis. 

Step 4. Unpack the Devices, Accessories, and Cables
Your device is shipped in an antistatic package to prevent electrostatic 
damage (ESD) to the device. ESD can damage several components on 
the device. 

Caution Never touch the exposed pins of connectors.

To avoid such damage, take the following precautions:

• Ground yourself using a grounding strap or by holding a grounded 
object. 

• Touch the antistatic package to a metal part of the computer chassis 
before removing the device from the package. 

Remove the device from the package and inspect the device for loose 
components or any sign of damage. Notify NI if the device appears 
damaged in any way. Do not install a damaged device in the computer, 
PXI chassis, or SCXI chassis. 

Store the device in the antistatic package when the device is not in use.

For safety and compliance information, refer to the device documentation 
packaged with your device, or on the Device Document Browser in the 
NI-DAQ software kit, as described in Step 10. Browse or Install Device 
Documentation.

Step 5. Install the Devices, Accessories, and Cables
If you have more than one DAQ device to install, install them all now. For 
more information about the hardware specifics of your device, such as slot 
requirements, refer to the device documentation as described in Step 10. 
Browse or Install Device Documentation.

If your system includes SCXI switch or SCXI signal conditioning modules 
that will be connected to DAQ devices, first install the DAQ components 
using this guide.
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If your system includes PXI switch modules, refer to the NI Switches 
Getting Started Guide to install and configure PXI switches.

PCI Devices

Caution Make sure the computer is powered off. Follow proper ESD precautions to ensure 
you are grounded before installing the hardware.

Complete the following steps to install a PCI device.

1. Remove the computer cover and the expansion slot cover. 

2. Touch any metal part of the computer to discharge any static electricity.

3. Insert the device into a PCI system slot. Gently rock the device into 
place. Do not force the device into place.

 

4. Screw the device mounting bracket to the computer back panel rail.

5. Replace the computer cover.

Your PCI device is installed.

1 PCI DAQ Device
2 PCI System Slot

3 PC with PCI slot

1
2

3
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PXI Devices

Caution Make sure the PXI chassis is powered off. Follow proper ESD precautions to 
ensure you are grounded before installing the hardware.

Complete the following steps to install a PXI module.

1. Remove the filler panel of an unused PXI slot. For information on 
slot requirements, refer to the device documentation as described 
in Step 10. Browse or Install Device Documentation.

2. Touch any metal part of the chassis to discharge static electricity. 

3. Insert the device into the PXI slot. Use the injector/ejector handle to 
fully insert the device. 

4. Screw the device front panel to the chassis front panel mounting rail.
 

Your PXI device is installed.

1 PXI Chassis
2 PXI Module

3 Screws
4 Injector/Ejector Handle

8

7

6

5

4

3

2

1
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1

2

4

3
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PCMCIA Devices

Caution Make sure the computer is powered off. If your PCMCIA supports hot insertion, 
the computer may be powered on. Follow proper ESD precautions to ensure you are 
grounded before installing the hardware.

You can install an NI PCMCIA device in any available Type II PC Card 
slot. Complete the following steps to install a PCMCIA device.

1. Remove the PCMCIA slot cover on your computer, if any.

2. Insert the PCMCIA bus connector of the PCMCIA device in the 
slot until the connector is firmly seated. NI PCMCIA devices have 
two connectors, a 68-pin PCMCIA bus connector on one end and 
an I/O connector on the other end. The PCMCIA device is keyed 
so that you can insert it only one way. 

3. Attach the I/O cable. Be careful not to put strain on the I/O cable when 
inserting or removing the cable connector. Always grasp the cable by 
the connector you are inserting or removing. Never pull directly on the 
I/O cable to unplug it from the PCMCIA device.

Your PCMCIA device is installed.

1 Computer with PCMCIA slot
2 PCMCIA Socket
3 PCMCIA Device

4 I/O Cable
5 Accessory
6 I/O Signals

®

1

2

4

5

6

DAQCard-700

3
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USB/IEEE 1394 Devices

Caution Follow proper ESD precautions to ensure you are grounded before installing the 
hardware.

Note If you are using the BP-1 battery pack, follow the installation instructions in your 
BP-1 installation guide and disregard step 1. The following instructions are correct if you 
are not using the BP-1 battery pack.

Complete the following steps to install an NI device for USB or 1394.

1. Some NI devices for USB or 1394 require external power.

• If your device has an external power supply, verify that the voltage 
on the external power supply, if any, matches the voltage in your 
area (120 or 230 VAC) and the voltage required by your device. 
Connect one end of the power supply to an electrical outlet and the 
other end to the rear of your device.

• If your device has a power cord, connect one end of the power cord 
to the device and the other end to an electrical outlet.

2. Connect the cable from the computer USB or 1394 port or from any 
other hub or 1394 device to any available USB or 1394 port on the 
device. Tighten the mounting screws, if any, for a firm connection. 
Connect the other end of the USB or 1394 cable to the USB or 
IEEE 1394 port on the device. The following figure shows the 
USB cable and its connectors.

1 Connector to the Computer or 
USB Hub

2 Connector to the Device

1 2
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3. If you have a USB or IEEE 1394 device with a rear panel power switch, 
power on the device. The computer should immediately detect your 
device.

4. When the computer recognizes the USB or IEEE 1394 device, a front 
panel LED blinks or lights up. Refer to your device documentation for 
information on the LED patterns for your device. Refer to Step 10. 
Browse or Install Device Documentation for information on installing 
device documentation using the Device Document Browser.

Your USB/IEEE 1394 device is installed.

Accessories
Install accessories, terminal blocks, and/or SCC modules according to 
the instructions in their installation guides. For SCXI, continue with the 
instructions in this guide through Step 11. Install SCXI or SCXI Switch 
Modules, if Applicable.

Step 6. Power On Your Computer or PXI Chassis
Windows recognizes any newly installed device the first time the computer 
reboots after hardware is installed. On some Windows systems, the Found 
New Hardware wizard opens with a dialog box for every NI device 
installed. Install the software automatically (Recommended) is selected 
by default. Click Next or Yes to install the software for each device so 
Windows recognizes the device.

When the computer recognizes a USB or IEEE 1394 device, the power 
LED on the device blinks or lights up, depending on the status of your 
device. NI devices for IEEE 1394 also have a COM LED, which should 
blink when the device is detected. For LED pattern descriptions, refer to the 
device documentation as described in Step 10. Browse or Install Device 
Documentation. 

Step 7. Launch Measurement & Automation Explorer (MAX)
Double-click the Measurement & Automation icon on the desktop to 
open MAX.
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Step 8. Confirm That Your Device Is Recognized

Note The following instructions do not apply to devices installed on systems running 
LabVIEW RT Series products. Refer to the Hardware Installation Wizard at ni.com/ 
support/install for setup instructions for RT Series products.

1. Expand Devices and Interfaces. 

2. Check that your device appears under Devices and Interfaces. 

When a device is supported by both Traditional NI-DAQ and 
NI-DAQmx and both are installed, the same device is listed with a 
different name under the Traditional NI-DAQ and NI-DAQmx folders 
in Devices and Interfaces. If your device does not appear, press <F5> 
to refresh the view in MAX. If the device is still not recognized, refer 
to ni.com/support/install for troubleshooting information.

3. Under the folder for the NI-DAQ API you are using to program the 
device, right-click the device you want to test. 

• If the device is under Traditional NI-DAQ, select Properties, then 
click Test Resources in the Properties window.

• If the device is under NI-DAQmx, select Self-Test.
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4. When the self-test finishes, a message indicates if an error occurred. 
If an error occurs, refer to ni.com/support for troubleshooting 
information. 

Step 9. Configure Your Device Settings
Configure each device you install. To use a device in both Traditional 
NI-DAQ and NI-DAQmx, you must configure its properties in each.

1. Right-click the device name and select Properties. Be sure to click the 
device name under the folder for the NI-DAQ API in which you want 
to use the device.

2. Configure the device properties.

• If you are using an accessory, add the accessory information.

• If you are using a device in Traditional NI-DAQ, you can change 
its default settings for AI, AO, OPC, or Remote Access. Refer to 
your device documentation as described in the next step for more 
information about device default settings.

3. Click OK to accept the changes.

Tip For devices supported by both Traditional NI-DAQ and NI-DAQmx, you can 
convert Traditional NI-DAQ virtual channel and scale configurations to an NI-DAQmx 
configuration with the Traditional NI-DAQ to NI-DAQmx Configuration Converter 
Wizard. The wizard also converts SCXI and accessory configurations, but not SCC 
configurations. You must configure SCC information separately in each API you want to 
use. Click Help in the wizard for more information on converting your configurations.
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Step 10. Browse or Install Device Documentation
NI-DAQ 7.x includes the Device Document Browser, which contains 
online documentation for supported DAQ, SCXI, and switch devices. 
Device documentation includes help files describing device terminals, 
device features, device operation, and PDF files of the device documents. 
You can use the Device Document Browser to find, view, and print the 
documents for each device. 

You can use the Device Document Browser at any time by inserting the 
appropriate CD. The NI-DAQ 7.x document browser has the following 
options:

• Browse Device Documents opens the document browser and displays 
the device documentation for each device. 

• Install Device Documents copies the document browser and all 
device documents to the hard drive. After installation, the browser is 
accessible from Start»Programs»National Instruments»NI-DAQ» 
Browse Device Documentation.

If the browser does not open automatically, select Start»Run and enter 
x:\autorun.exe, where x is the letter of the CD drive. 

Note You must have Internet Explorer version 5.0 or later to use some features of the 
NI-DAQ 7.x documentation, including the help system and Device Document Browser.

Step 11. Install SCXI or SCXI Switch Modules, 
if Applicable

If your system includes SCXI signal conditioning or SCXI switch modules 
to connect to DAQ devices, refer to the SCXI Quick Start Guide or the 
NI Switches Getting Started Guide, respectively, to install and configure 
the SCXI or switch hardware.

The rest of this guide applies only to DAQ devices with terminal blocks or 
SCC accessories.
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Step 12. Attach Sensors and Signals
Wire sensors and signals to the device or accessory terminals.

Helpful information is in the following documentation: 

• Signal and terminal connections:

– E Series Help, device user manual PDFs, and accessory PDFs are 
on the Device Document Browser.

– Pin assignments also are located in the Measurement & 
Automation Explorer Help for Traditional NI-DAQ and 
Measurement & Automation Explorer Help for NI-DAQmx, 
both accessible from the MAX Help menu.

• Switch specifications include a topology of the device.

• For more information about using sensors, refer to the following:

– ni.com/sensors

– If you are using LabVIEW, refer to the LabVIEW Measurements 
Manual packaged with LabVIEW or available from ni.com/ 
manuals. 

– If you are using another programming environment and 
NI-DAQmx, refer to the Sensors topic of the NI-DAQmx Help, 
which you can access from Start»Programs»National 
Instruments»NI-DAQ»NI-DAQmx Help. 

– If you are using another programming environment and 
Traditional NI-DAQ, refer to Chapter 5, Transducer Conversion 
Functions, of the Traditional NI-DAQ User Manual, which you 
can access from Start»Programs»National Instruments» 
NI-DAQ»Traditional NI-DAQ User Manual. 

Step 13. Run Test Panels
Many devices have a test panel for testing specific device functionality, 
such as the ability to acquire and generate signals.

1. In MAX, expand Devices and Interfaces.

2. Under Traditional NI-DAQ Devices or NI-DAQmx Devices, 
right-click the device to test. 
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3. Select Test Panels to open a test panel for the selected device. 

An example of a test panel is shown in the following figure. 
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4. Click the tabs to test different functions of the device. Click Help 
for instructions on operating the test panels in NI-DAQmx. Refer to 
Measurement & Automation Explorer Help for Traditional NI-DAQ 
for instructions on operating the test panels in Traditional NI-DAQ.

5. The test panel displays a message indicating if an error occurred. Refer 
to the NI-DAQmx Help or ni.com/support for troubleshooting 
information. 

6. When you finish, click Close to exit the test panel.

Step 14. Configure Any Additional New Devices
If you installed more than one DAQ device, repeat Step 9. Configure Your 
Device Settings through Step 13. Run Test Panels for each device. 

Step 15. Configure Channels and Tasks
A physical channel is a terminal or pin at which you can measure or 
generate an analog or digital signal. A virtual channel is a collection 
of settings that include a name, a physical channel, input terminal 
connections, the type of measurement or generation, and scaling 
information. In Traditional NI-DAQ and earlier versions, configuring 
virtual channels is an optional way to record which channels are being used 
for different measurements. In NI-DAQmx, virtual channels are integral to 
every measurement.

In Traditional NI-DAQ, you configure virtual channels using MAX. In 
NI-DAQmx, you configure virtual channels with the DAQ Assistant, which 
you can open from MAX or your application software. You also can 
configure virtual channels with the NI-DAQmx API in your application 
program.

A task, an important new concept for NI-DAQmx, is a collection of one 
or more virtual channels with timing, triggering, and other properties. 
Conceptually, a task represents a measurement or generation you want 
to perform. You can set up and save all of the configuration information 
in a task and use the task in an application.

In NI-DAQmx, you can configure virtual channels as part of a task or 
separate from a task. Virtual channels created inside a task are local 
channels. Virtual channels defined outside a task are global channels. 
You can create global channels in MAX or in your application software 
and then save them in MAX. You can use global channels in any 
application or add them to a number of different tasks. If you modify a 
global channel, the change affects all tasks in which you reference that 
global channel. In most cases, it is simpler to use local channels.
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Configure a Task in NI-DAQmx
Configure tasks with the DAQ Assistant when you use NI-DAQmx. You 
must have version 7.0 or later of an NI application software package to 
create tasks and channels with the DAQ Assistant.

• In MAX, right-click Data Neighborhood and select Create New. 
In the Create New window, select NI-DAQmx Task and click Next.

• You also can open the DAQ Assistant directly within NI application 
software:

– In LabVIEW, there are several ways to open the DAQ Assistant:

• Place the DAQ Assistant Express VI from the Express Input 
palette, as described in Getting Started with LabVIEW. 

• You also can use the DAQmx Task Name control to open the 
DAQ Assistant. Right-click the control and select New Task 
(DAQ Assistant). The Taking an NI-DAQmx Measurement 
in LabVIEW tutorial has step-by-step instructions on how 
to create a task from the DAQmx Task Name control and 
generate code based on the task. In LabVIEW, select Help» 
Taking an NI-DAQmx Measurement to open the tutorial.

– In LabWindows/CVI, select Tools»Create/Edit DAQmx Tasks. 

– In Measurement Studio, open Visual Studio .NET and select 
Project»Add New Item to open the Add New Item dialog box. 
In the Categories pane, select Measurement Studio»Assistants. 
In the Templates pane, select DAQmx Task Class.
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The DAQ Assistant opens.

Complete the following steps to create a new task: 

1. Select an I/O type, such as analog input.

2. Select the measurement or generation to perform.

3. Choose the sensor to use, if applicable.

4. Select the channels to add to the task. You can add global channels to 
the task or select physical channels from which to create local channels 
in the task.

5. Configure measurement-specific settings, timing, and triggering, if 
necessary. 

6. Save the task.

• If you opened the DAQ Assistant from LabVIEW or 
LabWindows/CVI, click OK. 

• If you opened the DAQ Assistant from Measurement Studio, 
select File»Save. 

• If you opened the DAQ Assistant from MAX, click Save Task. 
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You now can use the task in an application. Refer to the DAQ Assistant 
Help or application software documentation for more information about 
using a task or generating code.

Configure Global Channels in NI-DAQmx
Configure global channels with the DAQ Assistant when you use 
NI-DAQmx.

• In MAX, right-click Data Neighborhood and select Create New. 
In the Create New window, select NI-DAQmx Global Channel 
and click Next.

• You also can open the DAQ Assistant directly within LabVIEW 7.x 
or later, LabWindows/CVI 7.x or later, or Measurement Studio 7.x 
or later: 

– In LabVIEW, use the DAQmx Global Channel control to open the 
DAQ Assistant. Right-click the control and select New Channel 
(DAQ Assistant).

– In LabWindows/CVI or Measurement Studio, first you must 
configure a task as previously described. In the DAQ Assistant, 
click Add Existing DAQmx Global Channels to add global 
channels to your task. You must use MAX to create global 
channels.

The DAQ Assistant opens. 

Complete the following steps to create a new global channel:

1. Select an I/O type, such as analog input. 

2. Select the measurement or generation to perform. 

3. Choose the sensor to use, if applicable. 

4. Select the physical channel to use. 

5. Configure measurement-specific settings. 

6. Save the channel.

• If you opened the DAQ Assistant from LabVIEW or 
LabWindows/CVI, click OK. 

• If you opened the DAQ Assistant from Measurement Studio, 
select File»Save. 

• If you opened the DAQ Assistant from MAX, click Save 
Channel. 

You now can use the global channel in an application or add the global 
channel to a task. Refer to the DAQ Assistant Help or application software 
documentation for more information about using a channel or generating 
code.
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Configure Virtual Channels in Traditional NI-DAQ
When you use Traditional NI-DAQ, complete the following steps to 
configure virtual channels in MAX.

1. In MAX, right-click Data Neighborhood and select Create New. 

2. Select Traditional NI-DAQ Virtual Channel in the Create New 
window and click Finish. The Create New Channel wizard opens. 

3. Follow the instructions in the Create New Channel wizard to create a 
new channel. For additional information about configuring different 
channel types, refer to the Measurement & Automation Explorer Help 
for Traditional NI-DAQ.

Getting Started Developing an Application

Examples
Each API includes a collection of programming examples to help you get 
started developing an application. You can modify example code and save 
it in an application. You can use examples to develop a new application or 
add example code to an existing application.

To locate LabVIEW and LabWindows/CVI examples, open the National 
Instruments Example Finder:

• In LabVIEW, select Help»Find Examples.

• In LabWindows/CVI, select Help»NI Example Finder.
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Measurement Studio, Visual Basic, and ANSI C examples are in the 
directories listed below:

• NI-DAQmx examples for Measurement Studio-supported languages 
are in the following directories:

– MeasurementStudio\VCNET\Examples\DAQmx 

– MeasurementStudio\DotNET\Examples\DAQmx

• Traditional NI-DAQ examples for Visual Basic are in the following 
directories:

– NI-DAQ\Examples\Visual Basic with Measurement 
Studio directory contains a link to the ActiveX control examples 
for use with Measurement Studio.

– NI-DAQ\Examples\VBasic directory contains the examples 
not associated with Measurement Studio.

• NI-DAQmx examples for ANSI C are in the NI-DAQ\Examples\ 
DAQmx ANSI C directory.

• Traditional NI-DAQ examples for ANSI C are in the NI-DAQ\ 
Examples\VisualC directory.

For additional examples, refer to ni.com/zone.

Information about Measurement Applications and Devices
Each application software package and driver includes information about 
writing applications for taking measurements and controlling measurement 
devices. The following references to documents assume you have 
NI-DAQ 7.x, and where applicable, version 7.x of the NI application 
software.

LabVIEW
If you are a new user, complete Getting Started with LabVIEW to 
get acquainted with LabVIEW. Select Start»Programs»National 
Instruments»LabVIEW»Search the LabVIEW Bookshelf. 

The LabVIEW Measurements Manual contains API overviews of 
Traditional NI-DAQ and NI-DAQmx, and describes measurement 
concepts. Select Start»Programs»National Instruments»LabVIEW» 
Search the LabVIEW Bookshelf.

The Taking an NI-DAQmx Measurement in LabVIEW tutorial has 
step-by-step instructions on how to set up a measurement in LabVIEW 
and describes key new NI-DAQmx features and concepts such as the 
DAQ Assistant and tasks. In LabVIEW, select Help»Taking an 
NI-DAQmx Measurement to open the tutorial.
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The LabVIEW Traditional NI-DAQ VI Reference Help and LabVIEW 
NI-DAQmx VI Reference Help describe the LabVIEW VIs and properties. 
In LabVIEW, select Help»LabVIEW Help and the VI reference help 
section for the NI-DAQ API you are using. 

LabWindows/CVI
The Data Acquisition Library book of the main LabWindows/CVI Help 
contains API overviews, measurement concepts, and function references 
for Traditional NI-DAQ and NI-DAQmx. In LabWindows/CVI, select 
Help»Contents.

Measurement Studio
The NI Measurement Studio Help contains the NI-DAQmx API overview, 
measurement tasks and concepts, and function reference. This help file 
is integrated into the Visual Studio .NET documentation. In Visual 
Studio .NET, select Help»Contents.

The Measurement Studio Reference contains the Traditional NI-DAQ API 
overview, measurement concepts, and function reference. In Visual 
Studio .NET, select Measurement Studio»Measurement Studio 
Reference.

ANSI C without NI Application Software
The Traditional NI-DAQ User Manual and the NI-DAQmx Help contain 
API overviews. The NI-DAQmx Help also contains general information 
about measurement concepts. The Traditional NI-DAQ C Reference Help 
and the NI-DAQmx C Reference Help describe the C functions and 
attributes. Select Start»Programs»National Instruments»NI-DAQ and 
the document title for the NI-DAQ API you are using.

.NET Languages without NI Application Software
The NI Measurement Studio Help contains the NI-DAQmx API overview, 
measurement tasks and concepts, and function reference. This help file 
is integrated into the Visual Studio .NET documentation. In Visual 
Studio .NET, select Help»Contents.

Note If you use a .NET language without Visual Studio .NET, you might not be able to 
view the NI Measurement Studio Help.
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Device Documentation
NI-DAQ 7.x includes the Device Document Browser, which contains 
online documentation for supported DAQ, SCXI, and switch devices, such 
as help files describing device pinouts, features, and operation, and PDF 
files of the printed device documents. You can find, view, and/or print the 
documents for each device using the Device Document Browser at any 
time by inserting the CD. After installing the Device Document Browser, 
device documents are accessible from Start»Programs»National 
Instruments»NI-DAQ»Browse Device Documentation. 

SCXI Multi-Chassis Configurations
The SCXI-1346 Shielded Multi-Chassis Cable Adapter Installation Guide 
contains setup instructions for developing SCXI multi-chassis applications.

Switch 
The NI Switches Help contains technical and programming support for the 
switch module and the NI-SWITCH instrument driver.

The NI-SWITCH Instrument Driver Quick Reference Guide contains an 
API overview and function/VI overview.

NI 435x
When you finish configuring and testing the NI 435x, you can use 
VirtualBench-Logger to control the NI 435x without doing any 
programming. Refer to Getting Started with VirtualBench at ni.com/ 
manuals to learn how to use the features of the VirtualBench-Logger.

Training Courses
If you need more help getting started developing an application with 
NI products, NI offers training courses. To enroll in a course or obtain 
a detailed course outline, refer to ni.com/training. 

Technical Support
For additional support, refer to ni.com/support or ni.com/zone. 
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Using Traditional NI-DAQ and NI-DAQmx on the 
Same Computer

Existing applications developed with earlier versions of NI-DAQ will run 
under Traditional NI-DAQ. You can use both the Traditional NI-DAQ API 
and the NI-DAQmx API on the same computer with the following 
restrictions:

• Only one API controls a given device at one time.

– After using a device in NI-DAQmx, you must unreserve all 
NI-DAQmx tasks that are using that device before you can use 
that device through Traditional NI-DAQ. If you use a device 
in NI-DAQmx and then use it in Traditional NI-DAQ without 
unreserving the NI-DAQmx tasks, error code -200587 is 
returned. To unreserve NI-DAQmx tasks, call the DAQmx Clear 
Task VI or functions. 

– After using a device in Traditional NI-DAQ, you must reset the 
device before you can use that device in NI-DAQmx. If you use 
a device in Traditional NI-DAQ and then use it in NI-DAQmx 
without resetting the device, error code -200324 is returned. 

For SCXI devices, you must reset the communicator DAQ device 
in Traditional NI-DAQ before using it in NI-DAQmx. For 
example, E Series devices use lines 0, 1, 2, and 4 on port 0 to 
communicate with the SCXI module. Error code -200158 is 
returned if you do not reset the communicator device in 
Traditional NI-DAQ before using it in NI-DAQmx. 

• Call the Traditional NI-DAQ Device Reset VI or the 
Init_DA_Brds function. 

• To reset devices in Traditional NI-DAQ, you must reset all 
devices at once. Right-click the Traditional NI-DAQ 
Devices folder in MAX and select Reset Driver for 
Traditional NI-DAQ. 

• In an SCXI data acquisition system, you must use the same API to 
program all devices—connected DAQ devices and inserted SCXI 
modules.

Refer to ni.com/support for details and instructions about the following 
topics:

• How to add NI-DAQmx code to a Traditional NI-DAQ application

• How to run both Traditional NI-DAQ applications and NI-DAQmx 
applications that use the same device
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Operating System, Application Software, Programming 
Language, and Device Support in NI-DAQ 7.1

Version 7.1 of NI-DAQmx does not yet support the full line of 
NI measurement devices. The next few releases of NI-DAQ will add 
support for new and existing devices in NI-DAQmx, and will continue 
to include Traditional NI-DAQ.

Operating System Support
NI-DAQmx, Traditional NI-DAQ, and NI-SWITCH 2.1 support 
Windows 2000/NT/XP/Me/98. NI-DAQ 7.x on Windows NT requires 
Service Pack 6 or later. Measurement Studio requires Visual Studio 
.NET 2003, which requires Windows 2000/NT 4.0/XP. For operating 
system-specific installation instructions, use the Hardware Installation 
Wizard at ni.com/support/install.

To find and download an earlier version of NI-DAQ that supports other 
operating systems, refer to ni.com/downloads. 

Application Software and Programming Language Support
Table 1 lists the application software versions supported by NI-DAQmx 
and Traditional NI-DAQ. If you are not using NI application software, refer 
to Table 2.

 
Table 1.  NI-DAQ 7.x Application Software Support

NI Application Software

Versions 
Supported by 
NI-DAQmx

Versions 
Supported by 

Traditional 
NI-DAQ

LabVIEW  7.x 6.0–7.x

LabVIEW RT module — 6.0–7.x1 

LabWindows/CVI  7.x 6.0–7.x

Measurement Studio  7.x 6.0–7.x2

1 LabVIEW RT users must use Traditional NI-DAQ for their DAQ applications. A future 
version of NI-DAQmx will support LabVIEW RT.
2 Traditional NI-DAQ does not include a Measurement Studio C++ or .NET interface.
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Table 2 lists the programming languages and versions supported by 
NI-DAQmx and Traditional NI-DAQ. 

 

Earlier versions of NI-DAQ support other application software and 
language versions. To find and download an earlier version of a driver, 
refer to ni.com/downloads.

Device Support
For specific device model names, refer to the NI-DAQ 7.x Readme on 
the CD. Table 3 lists the families of devices supported by NI-DAQmx, 
Traditional NI-DAQ, and NI-SWITCH 2.1 in NI-DAQ 7.1. 

Table 2.  NI-DAQ 7.x Programming Language Support

Programming Language

Versions 
Supported by 
NI-DAQmx

Versions 
Supported by 

Traditional 
NI-DAQ

ANSI C ✓ ✓

Microsoft Visual C++
Class libraries
C DLL

7.x1

6.0–7.x
—

6.0–7.x

Visual Basic 6.0 through ActiveX — 6.0

Microsoft .NET languages 
(C# and Visual Basic .NET)

.NET 1.1 —

1 Requires Measurement Studio version 7.x.

Table 3.  NI-DAQ 7.1 Device Support

Device NI-DAQmx
Traditional 

NI-DAQ
NI-SWITCH

2.1

Multifunction DAQ

PCI and PXI E Series devices, such as the NI PCI-6052E ✓ ✓ N/A

PCMCIA E Series DAQCard-6024E, DAQCard-6036E, and 
DAQCard-6062E devices

✓ ✓ N/A

NI PCI-6013/6014 16-bit basic devices ✓ ✓ N/A

AT E Series — ✓ N/A

DAQPad devices for USB and FireWire (IEEE 1394) — ✓ N/A

S Series such as the NI PXI-6115 — ✓ N/A

Analog Input

PCMCIA DAQCard-AI-16E-4 and DAQCard-AI-16XE-50 — ✓ N/A
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Refer to the NI-DAQ 7.x Readme on the CD or Start»Programs»National 
Instruments»NI-DAQ for the list of new devices supported by 
NI-DAQ 7.1.

Analog Output

NI 670X — ✓ N/A

NI PCI and PXI 671X/673X — ✓ N/A

NI PCI-672X ✓ — N/A

Counter/Timer

NI 660X — ✓ N/A

NI PCI-6624 isolated ✓ — N/A

AT-AO-6/10 — ✓ N/A

High-Precision DAQ

NI 4350/4351 — ✓ N/A

Digital I/O

NI 6503, NI PXI-6508, NI 6527, and NI PCI-DIO-96 static DIO ✓ ✓ N/A

NI 6509, NI 6514, NI 6515, and NI 6528 static ✓ — N/A

NI 653X high-speed — ✓ N/A

NI DAQCard-DIO-24 and NI DAQPad-6507/6508 for USB static — ✓ N/A

PC-DIO-24 and PC-DIO-96 static — ✓ N/A

AT-DIO-32F — ✓ N/A

Dynamic Signal Acquisition

NI PCI-4451/4452/4454 — ✓ N/A

NI 4551, NI 4552, and NI 447X — ✓ N/A

Signal Conditioning

SCXI modules ✓ ✓ N/A

SCC Series modules ✓ ✓ N/A

NI PXI-4204 and PXI-4220 integrated signal conditioning ✓ — N/A

Switch

NI SCXI-1160, SCXI-1161, and SCXI-1163R modules ✓ ✓ ✓

All other SCXI switch modules ✓ — ✓

NI PXI-2501, PXI-2503, PXI-2565, PXI-2590, and PXI-2591 modules — — ✓

All other PXI switch modules ✓ — ✓

Table 3.  NI-DAQ 7.1 Device Support (Continued)

Device NI-DAQmx
Traditional 

NI-DAQ
NI-SWITCH

2.1
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More Devices in Future Releases of NI-DAQmx
Future releases of NI-DAQ will support additional devices in NI-DAQmx 
that are currently supported only in Traditional NI-DAQ. 

Devices Restricted to Traditional NI-DAQ
NI-DAQmx does not support the following devices. The following devices 
are supported only in Traditional NI-DAQ:

• AT E Series devices 

• AT-AO-6/10 analog output devices 

• AT-DIO-32F 32-bit parallel DIO device

• PCMCIA DAQCard-AI-16E-4 and DAQCard-AI-16XE-50 analog 
input devices

• NI PCI-4451/4452/4454 dynamic signal acquisition and generation 
devices

• NI 4350/4351 high-precision DAQ

• PC-DIO-24 and PC-DIO-96 static digital I/O devices

Devices No Longer Supported in NI-DAQ 7.x
The following products are not supported in NI-DAQ 7.x—NI-DAQmx 
nor Traditional NI-DAQ—and will not be supported in future versions of 
NI-DAQ. You must use NI-DAQ 6.9.x or earlier to program these devices:

• AT-MIO-16F-5 multifunction DAQ device

• DAQCard-500, DAQCard-516, DAQCard-700, DAQCard-1200, and 
DAQCard-AO-2DC PCMCIA devices

• DAQPad-1200 and DAQPad-MIO-16XE-50 devices for parallel port

• Lab-PC family of ISA and PC/XT MIO devices

• PC-516 16-bit, 50 kS/s MIO device

• PC-AO-2DC low-cost AO and current loop DAQ device

• PC-LPM-16PnP MIO device for the PC

• PC-OPDIO-16 optically isolated DIO device for the PC

• PC-TIO-10 timing and DIO interface for the PC

• PCI-1200 12-bit, 100 kS/s MIO device

• SCXI-1200 12-bit DAQ and control module

• SCXI-2000 4-slot chassis

• SCXI-2400 serial interface module

• VXI DAQ modules, VXI-SC carriers and modules, and VXI-TB 
terminal blocks for VXI bus
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Guide de démarrage DAQ
Ce guide décrit les étapes à suivre pour installer le driver NI-DAQ 7.x, ainsi 
qu’un périphérique d’acquisition de données (DAQ), et confirmer que ce 
périphérique fonctionne correctement.

Ces instructions ne s’appliquent pas à la version de NI-DAQ pour le 
système d’exploitation Macintosh. Reportez-vous à la documentation de 
NI-DAQ pour Macintosh.
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Conventions
Les conventions suivantes sont utilisées dans ce manuel.

» Le symbole » vous dirige vers les éléments de menu emboîtés et les options 
de boîtes de dialogue donnant lieu à une action finale. La séquence 
Fichier»Mise en page»Options vous invite à cliquer sur le menu déroulant 
Fichier, à sélectionner l’élément Mise en page, puis Options dans la 
dernière boîte de dialogue.

Cette icône signale une astuce qui vous donne des recommandations.

Cette icône signale une remarque qui vous donne des informations 
importantes.

Cette icône signale un avertissement qui vous indique les précautions à 
prendre pour éviter des préjudices corporels, des pertes de données ou un 
blocage du système.

gras Le texte en gras signale les éléments que vous devez sélectionner ou sur 
lesquels vous devez cliquer dans le logiciel, par exemple les éléments de 
menus et les options de boîtes de dialogue. 

italique Le texte en italique signale une référence croisée ou une introduction à un 
concept clé. Il indique également un texte que vous devez remplacer par un 
mot ou une valeur. 

italique monospace Le texte en italique de cette police signale le texte qui sert d’emplacement 
à un mot ou une valeur que vous devez fournir.



© National Instruments Corporation 37 Guide de démarrage DAQ

monospace Cette police signale du texte ou des caractères que vous devez saisir à partir 
du clavier, des noms propres de disques durs, des chemins, des 
programmes, des fonctions, des noms de fichiers et des extensions.

monospace gras Du texte en gras dans cette police indique les messages et réponses que 
l’ordinateur affiche directement à l’écran.

Par où commencer ?
La figure 1 montre les étapes pour installer NI-DAQ 7.x et un périphérique 
DAQ, et indique où trouver les informations appropriées dans la 
documentation.
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Figure 1.  Vue d’ensemble de la méthode d’installation

* Le nom des signaux ainsi que les connexions des terminaux sont disponibles en ligne dans l’Aide de 
Measurement & Automation Explorer pour la version traditionnelle de NI-DAQ et dans Measurement & 
Automation Explorer Help for NI-DAQmx, documents accessibles à partir du menu Aide de MAX. En outre, ces 
informations et bien d’autres encore sont dans la documentation du périphérique, disponible dans l’explorateur 
Device Document Browser. Reportez-vous à l’Étape 10. Naviguer dans la documentation du périphérique ou 
installer celle-ci pour obtenir des instructions sur la façon d’utiliser la documentation du périphérique.
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Driver NI-DAQ 7.x
Les périphériques de mesures de National Instruments sont livrés avec le 
driver NI-DAQ, une bibliothèque de fonctions et de VIs que vous pouvez 
appeler à partir d’un environnement de développement, tel que LabVIEW 
ou LabWindows™/CVI™, pour programmer toutes les fonctionnalités de 
vos périphériques de mesures NI. Les Périphériques de mesures incluent 
les périphériques DAQ tels que les modules d’E/S multifonctions de la 
série E (MIO), les modules de conditionnement de signaux SCXI et les 
modules de commutation. Le driver est constitué d’une API (Application 
Programming Interface) qui est une bibliothèque de VIs, fonctions, classes, 
attributs et propriétés pour créer des applications pour votre périphérique.

NI-DAQ 7.x comprend deux drivers NI-DAQ, chacun avec sa propre API et 
sa propre configuration matérielle et logicielle. 

• NI-DAQ traditionnel est une mise à jour de la version antérieure de 
NI-DAQ. Ce driver comprend les mêmes VIs et fonctions que 
NI-DAQ 6.9.3 et fonctionne de la même manière, sauf que vous 
pouvez utiliser NI-DAQ traditionnel et NI-DAQmx sur le même 
ordinateur. 

• NI-DAQmx est le tout dernier driver NI-DAQ. Il comprend de 
nouveaux VIs, de nouvelles fonctions et de nouveaux outils de 
développement pour programmer les périphériques de mesure. 
NI-DAQmx possède des avantages par rapport à NI-DAQ traditionnel :

– Assistant DAQ : méthode graphique pour configurer des voies et 
des tâches de mesures pour utiliser votre périphérique avec 
LabVIEW, LabWindows/CVI et Measurement Studio. Vous 
pouvez aussi utiliser l’Assistant DAQ pour générer le code 
NI-DAQmx en fonction des voies et tâches à utiliser dans des 
programmes développés avec un logiciel d’application NI.

– Performances plus élevées, notamment une rapidité accrue pour 
l’E/S d’une valeur analogique unique et le multithreading.

– API plus simple et plus intuitive pour créer des applications DAQ 
grâce à un nombre réduit de fonctions et de VIs comparé aux 
versions antérieures de NI-DAQ.

– Fonctionnalités étendues dans l’API NI-DAQmx pour LabVIEW, 
notamment des nœuds de propriété pour l’acquisition de données 
et un support de type de données waveform amélioré pour les E/S 
analogiques.

– Fonctionnalités et API similaires pour ANSI C, LabWindows/CVI 
et Measurement Studio, y compris les interfaces natives .NET 
et C++.
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Qui peut se servir de NI-DAQmx ?
Installez et utilisez NI-DAQmx si les situations suivantes vous concernent :

• Vous utilisez Windows.

• Vous n’utilisez que des périphériques supportés par NI-DAQmx. 
Reportez-vous à la section Systèmes d’exploitation, logiciels 
d’application, langages de programmation et périphériques supportés 
par NI-DAQ 7.1 pour obtenir la liste des périphériques supportés.

• Si vous programmez avec LabVIEW, LabWindows/CVI ou 
Measurement Studio, vous devez avoir au moins la version 7.x de ces 
logiciels d’application pour utiliser NI-DAQmx.

• Si vous utilisez un des langages de Measurement Studio .NET ou un 
périphérique supporté uniquement par NI-DAQmx, tel que le module 
PXI-4204 ou PXI-4220, vous devez utiliser NI-DAQmx.

Qui peut se servir de NI-DAQ traditionnel ?
Installez et utilisez NI-DAQ traditionnel si l’une des situations suivantes 
s’appliquent :

• Vous avez un périphérique qui n’est pas supporté par NI-DAQmx, 
comme les périphériques DAQ multifonctions de la série E au format 
AT ou les périphériques d’acquisition de signaux dynamiques.

• Vous utilisez le module LabVIEW Real-Time (RT).

• Vous effectuez la mise à jour de NI-DAQ depuis NI-DAQ 6.9.x et vous 
avez des applications existantes que vous ne voulez pas convertir en 
NI-DAQmx maintenant. 

• Vous utilisez une version de LabVIEW, LabWindows/CVI et 
Measurement Studio antérieure à la version 7.0.

• Vous utilisez Visual Basic 6.0.

Remarque NI-DAQ traditionnel ne prend en charge les logiciels d’application NI qu’à 
partir des versions 6.0. Les versions 6.x de LabVIEW, LabWindows/CVI et Measurement 
Studio peuvent utiliser le NI-DAQ traditionnel de la distribution NI-DAQ 7.x.
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Ce qui n’est plus supporté par NI-DAQ traditionnel
NI-DAQ 6.9.3 est la dernière version de NI-DAQ traditionnel à supporter 
les éléments suivants : 

• Les versions de LabVIEW, LabWindows/CVI et Measurement Studio 
antérieures à 6.0

• Windows 95

• Certains périphériques anciens, tels que les périphériques DAQ 
multifonctions de la série 1200, les périphériques VXI DAQ ou les 
périphériques SCXI déportés.

Reportez-vous à la section Systèmes d’exploitation, logiciels d’application, 
langages de programmation et périphériques supportés par NI-DAQ 7.1 
à la fin de ce guide pour obtenir la liste complète des éléments supportés 
ou non. 

Comment NI-DAQ s’ajuste à votre système ?
La figure 2 représente une vue d’ensemble du système de mesure, illustrant 
le chemin depuis le phénomène physique réel jusqu’à votre application de 
mesure.
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Figure 2.  Vue d’ensemble du système de mesures

L’ordinateur reçoit des données brutes via le périphérique de mesures. 
Le système de conditionnement utilise des capteurs et transducteurs pour 
convertir des phénomènes physiques de manière à ce que le périphérique 
de mesure puisse facilement récupérer les données. Le logiciel prend les 
données brutes, les présente sous une forme compréhensible et les gère 
pour qu’elles apparaissent dans un graphe, un fichier ou un rapport. 
Le logiciel contrôle aussi le système de mesures, précisant au périphérique 
quand il doit acquérir ou générer les données, et sur quelles voies.

Votre application de mesures

Logiciels d'application
LabVIEW, LabWindows/CVI, Measurement Studio et 

autres environnements de programmation.

Configuration
Measurement
& Automation

Explorer (MAX)

Application Programming Interface (API)
NI-DAQmx, NI-DAQ traditionnel, NI-SWITCH, etc.

Drivers
NI-DAQmx, NI-DAQ traditionnel, VISA, etc.

Acquisition de données et instrumentation modulaire 

SCXI

Capteurs

Signaux réels et phénomènes physiques

+
V
–

+
HV
–

+
mV
–

+

–

PCI PXI

8

7

6

ON

STANDBY

Combinaison PXI/SCXI SCC 

SC-2345

PCMCIA

Conditionnement de signaux

®

MAINFRAME 

SCXI



© National Instruments Corporation 43 Guide de démarrage DAQ

Les périphériques de mesures et les logiciels d’application NI sont livrés 
avec le driver NI-DAQ qui permet de programmer toutes les fonctionnalités 
de vos périphériques comme la configuration, l’acquisition et la génération 
de données, et l’envoi de données à votre périphérique. NI-DAQ vous 
épargne d’avoir à écrire tous ces programmes vous-même. Le logiciel 
d’application, LabVIEW par exemple, envoie les commandes au driver, 
comme l’acquisition et la lecture d’un thermocouple, puis affiche et analyse 
les données acquises.

Vous pouvez utiliser le driver NI-DAQ à partir de LabVIEW ou de 
n’importe quel environnement de développement qui supporte les appels de 
DLL via des interfaces ANSI C. Indépendamment de votre environnement 
de développement, votre application d’acquisition de données utilise 
NI-DAQ, comme illustré dans la figure 2. 

Étape 1. S’assurer que vous avez installé la version 
correcte du logiciel d’application

Installez maintenant votre logiciel d’application NI, tel que LabVIEW, 
LabWindows/CVI et Measurement Studio. Vous devez avoir la version 7.0 
du logiciel ou la version ultérieure pour l’utiliser avec NI-DAQmx. Vous 
pouvez utiliser la version 6.0 ou ultérieure du logiciel d’application de 
National Instruments pour l’utiliser avec NI-DAQ traditionnel. 
Reportez-vous à la section Systèmes d’exploitation, logiciels d’application, 
langages de programmation et périphériques supportés par NI-DAQ 7.1 à 
la fin de ce guide.

Conseil Si vous avez une application développée avec une version antérieure de votre 
logiciel d’application ou de NI-DAQ, faites-en une sauvegarde. Vous pouvez ensuite mettre 
à jour votre logiciel et modifier l’application. Si vous voulez utiliser l’application originale 
non modifiée avec NI-DAQ traditionnel, vous pouvez utiliser la sauvegarde.

Étape 2. Désinstaller NI-DAQ avant d’installer la mise 
à jour

Si vous voulez installer la mise à jour NI-DAQ 7.x, désinstallez d’abord la 
version précédente de NI-DAQ. Utilisez Panneau de configuration»
Ajout/Suppression de programmes. Reportez-vous à ni.com/
support/install pour obtenir les instructions de désinstallation 
spécifiques à un système d’exploitation. 
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Étape 3. Installer le driver NI-DAQ 7.x

Insérez le CD

Mise en garde N’installez pas NI-DAQ 7.x si votre application inclut des éléments qu’il 
ne prend pas en charge ! Avant d’installer le driver, reportez-vous au fichier NI-DAQ 7.x 
Readme du CD NI-DAQ 7.x ou à la section Systèmes d’exploitation, logiciels 
d’application, langages de programmation et périphériques supportés par NI-DAQ 7.1 
située à la fin de ce guide.

L’installeur NI-DAQ 7.x devrait se lancer automatiquement. Si ce n’est pas 
le cas, sélectionnez Démarrer»Exécuter. Entrez x:\setup.exe, où x 
correspond à la lettre du lecteur CD. Pour connaître les instructions 
d’installation spécifiques à un système d’exploitation, utilisez l’Assistant 
d’installation matériel (Hardware Installation Wizard) que vous trouverez 
à l’adresse ni.com/support/install.

Conseil Installez votre driver avant d’installer de nouveaux périphériques ; sinon, 
Windows risque de ne pas les détecter et vous pourriez recevoir des mises en garde vous 
invitant à installer le driver.

Choisissez l’API (ou les API) à installer

Mise en garde NI-DAQ 7.x ne peut pas co-exister avec une version antérieure de NI-DAQ 
sur le même ordinateur. Lorsque vous installez NI-DAQ 7.x, la dernière version de 
NI-DAQ traditionnel remplace les versions précédentes de NI-DAQ et tous les fichiers 
support installés par celles-ci. Les versions précédentes de NI-DAQ sont supprimées quand 
vous installez NI-DAQmx. 

NI-DAQ 7.x comprend plusieurs drivers avec leur API : NI-DAQ 
traditionnel, NI-DAQmx et NI-SWITCH. Selon les périphériques que vous 
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utilisez, vous pouvez choisir d’installer tous ces drivers ou aucun. 
Reportez-vous au tableau 3, Périphériques supportés par NI-DAQ 7.1 situé 
à la fin de ce guide pour connaître les API à installer pour les périphériques 
de votre système. Reportez-vous à la section Driver NI-DAQ 7.x située au 
début de ce guide pour consulter les descriptions de NI-DAQ traditionnel 
et NI-DAQmx. 

Installez et utilisez NI-SWITCH pour programmer les modules de 
commutation NI. NI-SWITCH est un driver d’instrument de type IVI qui 
supporte tous les modules de commutation NI. NI-SWITCH possède une 
face-avant logicielle interactive pour tester et mettre au point les 
applications de commutation. NI-SWITCH est une couche de driver située 
au-dessus des drivers NI-DAQmx et NI-DAQ traditionnel. Pour utiliser 
NI-SWITCH 2.1 vous devez installer NI-DAQmx et NI-VISA 3.0. 

Installez les fichiers support
L’installeur NI-DAQ 7.x détecte tous les logiciels NI installés sur le 
système et choisit automatiquement sur le CD les fichiers support des 
versions les plus récentes des drivers, logiciels d’application et langages 
qu’il a détectés. 

 

1. Vérifiez que l’installeur a détecté et sélectionné les fichiers support 
appropriés et que le numéro de version du logiciel d’application et/ou 
du langage est correct. Double-cliquez sur le signe plus d’une 
fonctionnalité pour faire apparaître la liste de ses sous-composants, 
comme indiqué ci-dessus. Vous pouvez sélectionner des options 
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complémentaires pour installer les fichiers support, les exemples et la 
documentation. Suivez les instructions du logiciel. 

Remarque Si vous installez d’abord NI-DAQ 7.x, puis que vous installez la version 7.x 
d’un logiciel d’application NI, vous devrez relancer l’installeur NI-DAQ 7.x afin d’installer 
le fichier support pour ce logiciel d’application. Sélectionnez Démarrer»Exécuter. Entrez 
x:\setup.exe, où x correspond à la lettre du lecteur CD.

2. Cliquez sur le bouton Terminer. 

3. Une fois que l’installeur a terminé, un message apparaît pour vous 
demander si vous voulez redémarrer, arrêter ou quitter. 

• Si vous avez un périphérique NI 435x et que vous utilisez 
LabWindows/CVI, C, C++, Visual Basic ou le 
VirtualBench-Logger, choisissez de quitter et installez le logiciel 
provenant du CD NI 435x. 

• Si vous êtes prêt à installer votre périphérique, choisissez d’arrêter 
la machine.

4. Mettez l’ordinateur ou le châssis PXI hors tension, puis débranchez-le. 

Étape 4. Déballer les périphériques, les accessoires et 
les câbles

Votre périphérique est livré dans un sachet antistatique pour éviter les 
dommages dûs aux décharges électrostatiques (EDS). Ces décharges 
peuvent abîmer plusieurs composants du périphérique. 

Mise en garde Ne touchez jamais les broches des connecteurs.

Pour éviter de tels dommages, respectez les précautions suivantes :

• Utilisez un ruban de mise à la masse ou tenez un objet en contact avec 
la masse pour devenir vous-même une référence à la masse. 

• Mettez en contact le sachet antistatique avec la partie métallique du 
châssis de l’ordinateur avant de retirer le périphérique du sachet. 

Retirez le périphérique de son sachet. Examinez les composants pour 
repérer tout signe d’endommagement. Contactez NI si le périphérique 
apparaît endommagé d’une façon quelconque. N’installez jamais un 
périphérique endommagé dans un ordinateur ou dans un châssis PXI 
ou SCXI. 

Conservez le périphérique dans le sachet antistatique quand il n’est pas 
utilisé.
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Pour obtenir des informations de conformité et de sécurité, reportez-vous à 
la documentation du périphérique emballée avec celui-ci ou à l’explorateur 
Device Document Browser du kit logiciel NI-DAQ, comme décrit dans 
l’Étape 10. Naviguer dans la documentation du périphérique ou installer 
celle-ci.

Étape 5. Installer les périphériques, les accessoires et 
les câbles

Si vous avez plusieurs périphériques DAQ à installer, installez-les tous 
maintenant. Pour obtenir des informations complémentaires sur les 
spécifications matérielles de votre périphérique, notamment en ce qui 
concerne les logements dans le châssis, reportez-vous à la documentation 
du périphérique comme expliqué dans l’Étape 10. Naviguer dans la 
documentation du périphérique ou installer celle-ci.

Si votre système comprend des modules de commutation (switch) ou 
de conditionnement de signaux SCXI qui doivent être connectés aux 
périphériques DAQ, installez d’abord les composants DAQ à l’aide de 
ce guide.

Si votre système inclut des modules de commutation (switch) PXI, 
reportez-vous au NI Switches Getting Started Guide pour les installer et les 
configurer.

Périphériques PCI

Mise en garde Assurez-vous que l’ordinateur est hors tension. Respectez les instructions 
de précaution contre les dommages électrostatiques avant d’installer le matériel.

Effectuez les étapes suivantes pour installer un périphérique PCI.

1. Retirez le couvercle de votre ordinateur et le cache du logement 
d’extension. 

2. Touchez n’importe quelle partie métallique de l’ordinateur pour 
décharger l’électricité statique.

3. Insérez le périphérique dans le logement PCI. Ajustez-le 
soigneusement pour qu’il soit parfaitement inséré. Ne forcez pas 
l’insertion dans le logement.
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4. Vissez le support de fixation du périphérique au rail du panneau arrière 
de l’ordinateur.

5. Remettez en place le couvercle de l’ordinateur.

Votre périphérique PCI est installé.

Périphériques PXI

Mise en garde Assurez-vous que le châssis PXI est hors tension. Respectez les instructions 
de précaution contre les dommages électrostatiques avant d’installer le matériel.

Effectuez les étapes suivantes pour installer un module PXI.

1. Retirez le cache de protection d’un logement PXI vide. Pour savoir 
quels logements utiliser dans le châssis, reportez-vous à la 
documentation du périphérique, comme expliqué dans l’Étape 10. 
Naviguer dans la documentation du périphérique ou installer celle-ci.

2. Touchez n’importe quelle partie métallique du châssis pour décharger 
l’électricité statique. 

3. Insérez le périphérique dans le logement PXI. Utilisez la manette 
d’insertion/éjection pour insérer complètement le périphérique. 

4. Vissez le périphérique sur le support de fixation situé à l’avant du 
châssis.

1 Périphérique PCI DAQ
2 Logement système PCI

3 Ordinateur avec logement PCI

1
2

3
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Votre périphérique PXI est installé.

Périphériques PCMCIA

Mise en garde Assurez-vous que l’ordinateur est hors tension. Si votre carte PCMCIA 
supporte l’insertion à chaud, vous pouvez laisser l’ordinateur sous tension. Respectez les 
instructions de précaution contre les dommages électrostatiques avant d’installer le 
matériel.

Vous pouvez installer un périphérique NI PCMCIA dans n’importe quel 
logement de carte PC de type II disponible. Effectuez les étapes suivantes 
pour installer un périphérique PCMCIA.

1. Si nécessaire, retirez le cache de protection du logement PCMCIA.

2. Insérez le connecteur de bus PCMCIA du périphérique PCMCIA dans 
le logement jusqu’à ce qu’il soit solidement installé. Les périphériques 
NI PCMCIA ont deux connecteurs, un connecteur de 68 broches pour 
le bus à une extrémité, et un connecteur d’E/S à l’autre extrémité. Le 
périphérique PCMCIA est muni de détrompeurs de sorte qu’il ne 
puisse être inséré que dans un sens. 

3. Branchez le câble d’E/S. Prenez garde à ne pas appuyer trop fort sur le 
câble d’E/S quand vous insérez ou retirez son connecteur. Saisissez 
toujours le câble par son connecteur quand vous le connectez ou 
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4 Manette d’insertion/éjection
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l’enlevez. Ne tirez jamais directement sur le câble d’E/S pour le 
débrancher du périphérique PCMCIA.

Votre périphérique PCMCIA est installé.

Périphériques USB/IEEE 1394

Mise en garde Respectez les instructions de précaution contre les dommages 
électrostatiques avant d’installer le matériel.

Remarque Si vous utilisez le pack batterie BP-1, suivez les instructions d’installation de 
votre guide d’installation BP-1 et ignorez l’étape 1. Les instructions suivantes s’appliquent 
si vous n’utilisez pas de pack batterie BP-1.

Exécutez les étapes suivantes pour installer un périphérique NI de type 
USB ou 1394.

1. Certains périphériques NI de type USB ou 1394 nécessitent une 
alimentation externe.

• Dans ce cas, assurez-vous que l’alimentation externe de ces 
périphériques est compatible avec le secteur dans votre région 

1 Ordinateur avec logement PCMCIA
2 Prise PCMCIA
3 Périphérique PCMCIA

4 Câble d’E/S
5 Accessoire
6 Signaux d’E/S

®

1
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DAQCard-700
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(120 ou 230 VAC) et avec la tension supportée par votre 
périphérique. Connectez une extrémité du cordon d’alimentation 
à une prise secteur et branchez l’autre à l’arrière du périphérique.

• Effectuez exactement la même chose si votre périphérique est 
fourni avec un câble d’alimentation.

2. Reliez le câble entre le port USB ou 1394, situé directement sur 
le PC ou sur un périphérique dédié, et le port USB ou 1394 de votre 
périphérique. Serrez les vis de montage, s’il y’en a, afin que la 
connexion soit bien ferme. Connectez l’autre extrémité du câble 
USB ou 1394 au port USB ou IEEE 1394 du périphérique. La figure 
suivante représente le câble USB et ses connecteurs.

3. Si votre périphérique USB ou 1394 est équipé d’un bouton 
d’alimentation à l’arrière, mettez-le sous tension. L’ordinateur doit 
immédiatement détecter votre périphérique.

4. Lorsque l’ordinateur reconnaît le périphérique USB ou IEEE 1394 , un 
voyant LED clignote ou s’allume sur la face-avant. Reportez-vous à la 
documentation de votre périphérique pour obtenir des informations sur 
les états de la LED. Reportez-vous à l’Étape 10. Naviguer dans la 
documentation du périphérique ou installer celle-ci pour obtenir des 
informations sur l’installation de la documentation des périphériques à 
l’aide de l’explorateur Device Document Browser.

Votre périphérique USB/IEEE 1394 est installé.

Accessoires
Installez les accessoires, les blocs de connexion et/ou les modules SCC 
suivant les instructions fournies dans leurs guides d’installation respectifs. 
Pour le matériel SCXI, continuez à suivre les instructions de ce guide allant 
jusqu’à l’Étape 11. Installer les modules SCXI ou de commutation SCXI, le 
cas échéant.

1 Connecteur pour l’ordinateur 
ou pour un hub USB

2 Connecteur pour le périphérique

1 2
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Étape 6. Mettre votre ordinateur ou châssis PXI sous 
tension

Windows détecte et reconnaît tous les périphériques nouvellement installés 
dès le premier redémarrage qui suit l’installation. Sur certains systèmes 
Windows, l’Assistant Nouveau matériel détecté s’ouvre avec une boîte de 
dialogue pour chaque périphérique NI installé. Installer le logiciel 
automatiquement (Recommandé) est sélectionné par défaut. Cliquez sur 
Suivant ou sur Oui pour installer le logiciel pour chaque périphérique et 
permettre ainsi à Windows de le reconnaître.

Quand l’ordinateur reconnaît un périphérique USB ou IEEE 1394, la LED 
d’alimentation du périphérique se met à clignoter ou s’allume, selon l’état 
de votre périphérique. Les périphériques NI au format IEEE 1394 
possèdent aussi une LED COM qui doit clignoter quand le périphérique est 
détecté. Pour connaître la signification des états de la LED, reportez-vous 
à la documentation du périphérique, comme expliqué dans l’Étape 10. 
Naviguer dans la documentation du périphérique ou installer celle-ci. 

Étape 7. Lancer Measurement & Automation Explorer 
(MAX)

Double-cliquez sur l’icône Measurement & Automation qui se trouve sur 
le bureau pour ouvrir MAX.

Étape 8. Confirmer que votre périphérique est reconnu

Remarque Les instructions suivantes ne s’appliquent pas aux périphériques installés sur 
des systèmes exécutant des produits de la série LabVIEW RT. Reportez-vous à l’Assistant 
d’installation de matériel (Hardware Installation Wizard) à l’adresse ni.com/support/
install pour obtenir plus de précisions sur l’installation des produits de la série RT.

1. Ouvrez la rubrique Périphériques et Interfaces. 

2. Vérifiez que votre périphérique apparaît bien sous Périphériques et 
Interfaces. 
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Quand un périphérique est supporté à la fois par NI-DAQ traditionnel 
et NI-DAQmx et que ces deux drivers sont installés, le même 
périphérique apparaît avec un nom différent dans les rubriques 
“Périphériques NI-DAQ” et “NI-DAQmx Devices”. Si votre 
périphérique n’apparaît pas, appuyez sur <F5> pour rafraîchir 
l’affichage dans MAX. Si votre périphérique n’est toujours pas 
reconnu, reportez-vous à la page ni.com/support/install pour 
obtenir des informations de dépannage.

3. Dans la rubrique de l’API NI-DAQ que vous utilisez pour programmer 
votre périphérique, cliquez avec le bouton droit sur le périphérique que 
vous voulez tester. 

• Si votre périphérique est sous NI-DAQ traditionnel, sélectionnez 
Propriétés, puis cliquez sur Tester les ressources dans la fenêtre 
de propriétés.

• Si le périphérique est sous NI-DAQmx, sélectionnez Self-Test.
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4. Quand le test automatique est terminé, un message indique si une 
erreur s’est produite. Si c’est le cas, reportez-vous à l’adresse 
ni.com/support pour obtenir des informations de dépannage. 

Étape 9. Configurer les paramètres de votre 
périphérique

Configurez chaque périphérique que vous installez. Pour utiliser un 
périphérique à la fois avec NI-DAQ traditionnel et NI-DAQmx, vous devez 
configurer ses propriétés dans les deux rubriques.

1. Effectuez un clic droit sur le nom du périphérique et sélectionnez 
Propriétés. Assurez-vous de cliquer sur le nom du périphérique se 
trouvant dans la rubrique de l’API de NI-DAQ que vous voulez utiliser.

2. Configurez les propriétés du périphérique.

• Si vous utilisez un accessoire, ajoutez les informations relatives à 
celui-ci.

• Si vous utilisez un périphérique avec NI-DAQ traditionnel, vous 
pouvez changer ses paramètres par défaut pour les entrées 
analogiques, les sorties analogiques, l’OPC et l’accès déporté. 
Reportez-vous à la documentation de votre périphérique, comme 
expliqué dans l’étape suivante, pour obtenir de plus amples 
informations sur les paramètres par défaut du périphérique.

3. Cliquez sur OK pour valider les changements.

Conseil Pour les périphériques supportés à la fois par NI-DAQ traditionnel et NI-DAQmx, 
vous pouvez convertir les configurations d’échelle et les voies virtuelles de NI-DAQ 
traditionnel en une configuration pour NI-DAQmx avec l’Assistant Traditional NI-DAQ to 
NI-DAQmx Converter. Cet assistant convertit aussi les configurations d’accessoires et de 
matériel SCXI, mais pas celles de SCC. Vous devez configurer les informations de SCC 
séparément dans chaque API que vous voulez utiliser. Cliquez sur Aide dans l’assistant 
pour obtenir plus d’informations sur la conversion de vos configurations.

Étape 10. Naviguer dans la documentation du 
périphérique ou installer celle-ci

NI-DAQ 7.x inclut l’explorateur Device Document Browser, qui contient 
la documentation en ligne pour les périphériques DAQ, SCXI et de 
commutation. Ce CD comprend également les fichiers d’aide décrivant les 
terminaux des périphériques, leurs fonctionnalités, les opérations qu’ils 
réalisent et des fichiers de documentation au format PDF. Vous pouvez 
utiliser le Device Document Browser pour trouver, afficher et imprimer les 
documents pour chaque périphérique. 
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Vous pouvez utiliser l’explorateur Device Document Browser à tout 
moment en insérant le CD approprié. L’explorateur de documents de 
NI-DAQ 7.x possède les options suivantes :

• Browse Device Documents ouvre l’explorateur et affiche la 
documentation pour chaque périphérique. 

• Install Device Documents copie l’explorateur et tous les documents 
pour tous les périphériques sur le disque dur. Après l’installation, on 
accède à l’explorateur à partir de Démarrer»Programmes»National 
Instruments»NI-DAQ»Browse Device Documentation.

Si l’explorateur ne s’ouvre pas automatiquement, sélectionnez 
Démarrer»Exécuter et entrez x:\autorun.exe où x est la lettre du 
lecteur CD. 

Remarque Vous devez avoir au moins la version 5.0 de Internet Explorer pour utiliser 
certaines fonctionnalités de la documentation de NI-DAQ 7.x, comme par exemple l’aide 
et l’explorateur Device Document Browser.

Étape 11. Installer les modules SCXI ou de commutation 
SCXI, le cas échéant

Si votre système comprend des modules de conditionnement de signaux 
SCXI ou de commutation SCXI à connecter aux périphériques DAQ, 
reportez-vous respectivement aux documents Guide de démarrage SCXI ou 
NI Switches Getting Started Guide pour installer et configurer le matériel 
SCXI ou de commutation.

La suite de ce guide ne s’applique qu’aux périphériques DAQ équipés de 
blocs de connexion ou d’accessoires SCC.

Étape 12. Connecter vos capteurs et signaux
Câblez les capteurs et les signaux à mesurer aux terminaux du périphérique 
ou des accessoires.

Des informations pratiques se trouvent dans la documentation suivante : 

• Signaux et connexions aux terminaux :

– L’aide E Series Help et le manuel de l’utilisateur au format PDF 
du périphérique ou des accessoires sont compris dans 
l’explorateur Device Document Browser.

– Les affectations de broches sont décrites dans l’Aide de 
Measurement & Automation Explorer pour la version 
traditionnelle de NI-DAQ et dans le Measurement & Automation 
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Explorer Help for NI-DAQmx, ces deux documents étant 
accessibles à partir du menu Aide de MAX.

• Les spécifications d’un module de commutation comprennent une 
topologie de ce périphérique.

• Pour obtenir des informations complémentaires sur l’utilisation de 
capteurs, reportez-vous à :

– ni.com/sensors

– Si vous utilisez LabVIEW, reportez-vous au manuel LabVIEW 
Measurements Manual livré avec LabVIEW ou disponible à 
l’adresse ni.com/manuals. 

– Si vous utilisez un autre environnement de développement et 
NI-DAQmx, reportez-vous à la rubrique Sensors de NI-DAQmx 
Help, accessible à partir de Démarrer»Programmes»National 
Instruments»NI-DAQ»NI-DAQmx Help. 

– Si vous utilisez un autre environnement de développement avec 
NI-DAQ traditionnel, reportez-vous au chapitre 5, Transducer 
Conversion Functions, du manuel Traditional NI-DAQ User 
Manual, accessible à partir de Démarrer»Programmes»
National Instruments»NI-DAQ»Traditional NI-DAQ User 
Manual. 

Étape 13. Exécuter les panneaux de test
De nombreux périphériques comportent un panneau de test pour tester des 
fonctionnalités spécifiques à ce périphérique, par exemple sa capacité à 
acquérir ou à générer des signaux.

1. Dans MAX, développez la rubrique Périphériques et Interfaces.

2. Dans la rubrique NI-DAQmx Devices ou Périphériques NI-DAQ 
traditionnel, cliquez avec le bouton droit sur le périphérique à tester. 

3. Sélectionnez Panneaux de test ou Test Panels pour ouvrir le panneau 
de test correspondant au périphérique. 
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Un exemple de panneau de test est représenté dans la figure suivante. 
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4. Cliquez sur les onglets pour tester différentes fonctions du 
périphérique. Cliquez sur Help pour obtenir des instructions sur le 
fonctionnement des panneaux de tests dans NI-DAQmx. 
Reportez-vous à l’Aide de Measurement & Automation Explorer pour 
la version traditionnelle de NI-DAQ pour obtenir des instructions sur 
le fonctionnement des panneaux de tests dans NI-DAQ traditionnel.

5. Le panneau de test affiche un message indiquant si une erreur s’est 
produite. Reportez-vous à NI-DAQmx Help ou ni.com/support 
pour obtenir des informations de dépannage. 

6. Une fois que vous avez terminé, cliquez sur Fermer ou Close pour 
fermer le panneau de test.

Étape 14. Configurer tous les nouveaux périphériques
Si vous avez installé plus d’un périphérique DAQ, répétez l’ Étape 9. 
Configurer les paramètres de votre périphérique à l’ Étape 13. Exécuter les 
panneaux de test pour chacun d’entre eux. 

Étape 15. Configurer les voies et les tâches
Une voie physique est un terminal ou broche sur laquelle vous pouvez 
mesurer ou générer un signal analogique ou numérique. Une voie virtuelle 
est un ensemble de propriétés comprenant un nom, une voie physique, un 
type de connexion au terminal, le type de mesures (acquisition ou 
génération) et des informations de mise à l’échelle. Dans NI-DAQ 
traditionnel et les versions précédentes, la configuration des voies virtuelles 
est une manière possible d’enregistrer les voies utilisées pour différentes 
mesures. Dans NI-DAQmx, les voies virtuelles font partie intégrante de la 
mesure.

Dans NI-DAQ traditionnel, vous configurez les voies virtuelles avec MAX. 
Dans NI-DAQmx, vous pouvez configurer les voies virtuelles avec 
l’Assistant DAQ, que vous pouvez ouvrir avec MAX ou avec votre logiciel 
d’application. Vous pouvez également configurer les voies virtuelles dans 
votre programme avec l’API de NI-DAQmx.

Une tâche est un ensemble d’une ou de plusieurs voies virtuelles qui inclut 
notamment des propriétés de cadencement et de déchenchement. C’est un 
concept nouveau et important dans NI-DAQmx. Fondamentalement, une 
tâche représente la mesure ou la génération que vous voulez réaliser. Vous 
pouvez définir et enregistrer toutes les informations de configuration dans 
une tâche et l’utiliser dans une application.
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Dans NI-DAQmx, les voies virtuelles peuvent être définies comme faisant 
partie d’une tâche ou être configurées séparément de celle-ci. Les voies 
virtuelles créées à l’intérieur d’une tâche sont des voies locales. Les voies 
virtuelles créées à l’extérieur d’une tâche sont des voies globales. Vous 
pouvez créer des voies globales depuis MAX ou depuis votre application 
logicielle puis les enregistrer sous MAX. Vous pouvez utiliser les voies 
globales dans n’importe quelle application ou les ajouter à d’autres tâches. 
Si vous modifiez une voie globale, les changements affectent toutes les 
tâches dans lesquelles cette voie est utilisée. Dans la plupart des cas, il est 
plus simple d’utiliser les voies locales.

Configurer une tâche dans NI-DAQmx
Sous NI-DAQmx, les tâches se configurent avec l’Assistant DAQ. Vous 
devez avoir la version 7.0 ou ultérieure d’un logiciel d’application NI pour 
créer des voies et des tâches avec l’Assistant DAQ.

• Dans MAX, cliquez avec le bouton droit sur Voisinage de données et 
sélectionnez Créer un nouvel objet. Dans la fenêtre Créer un nouvel 
objet, sélectionnez NI-DAQmx Task, puis cliquez sur Suivant.

• Vous pouvez également ouvrir directement l’Assistant DAQ à partir de 
votre logiciel d’application NI.

– Dans LabVIEW, de nombreuses méthodes permettent d’ouvrir 
l’Assistant DAQ :

• Déposez le VI Express DAQ Assistant à partir de la palette 
“Entrée” des VIs Express, comme expliqué dans le manuel 
Initiation à LabVIEW. 

• Vous pouvez également utiliser la commande Nom de tâche 
DAQmx pour ouvrir l’Assistant DAQ. Cliquez avec le bouton 
droit sur la commande et sélectionnez Nouvelle tâche 
(Assistant DAQ). Le tutorial Taking an NI-DAQmx 
Measurement in LabVIEW contient les instructions pas-à-pas 
pour créer une tâche à partir de la commande Nom de tâche 
DAQmx et générer le code en fonction de la tâche. Dans 
LabVIEW, sélectionnez Aide»Taking an NI-DAQmx 
Measurement pour ouvrir le tutorial.

– Dans LabWindows/CVI, sélectionnez Tools»Create/Edit 
DAQmx Tasks. 

– Dans Measurement Studio, ouvrez Visual Studio .NET et 
sélectionnez Project»Add New Item pour ouvrir la boîte de 
dialogue Add New Item. Dans la sous-fenêtre Categories, 
sélectionnez Measurement Studio»Assistants. Dans la 
sous-catégorie Templates, sélectionnez DAQmx Task Class.
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L’Assistant DAQ s’ouvre.

Effectuez les étapes suivantes pour créer une nouvelle tâche : 

1. Choisissez un type d’E/S, par exemple une entrée analogique (Analog 
Input).

2. Sélectionnez la mesure ou la génération à réaliser.

3. Sélectionnez le capteur à utiliser, le cas échéant.

4. Sélectionnez les voies à ajouter dans la tâche. Vous pouvez ajouter des 
voies globales dans la tâche ou sélectionner des voies physiques à 
partir desquelles vous créez des voies locales dans la tâche.

5. Si nécessaire, configurez des paramètres de mesures spécifiques, 
l’horloge et le déclenchement. 

6. Enregistrez la tâche.

• Si vous avez ouvert l’Assistant DAQ à partir de LabVIEW ou de 
LabWindows/CVI, cliquez sur OK. 

• Si vous l’avez ouvert à partir de Measurement Studio, 
sélectionnez File»Save. 

• Si vous l’avez ouvert à partir de MAX, cliquez sur Save Task. 
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Vous pouvez maintenant utiliser la tâche dans une application. 
Reportez-vous à DAQ Assistant Help ou à la documentation du logiciel 
d’application pour obtenir davantage d’informations sur la manière 
d’utiliser une tâche ou de générer du code.

Configurer des voies globales dans NI-DAQmx
Lorsque vous utilisez NI-DAQmx, configurez les voies globales avec 
l’Assistant DAQ.

• Dans MAX, cliquez avec le bouton droit sur Voisinage de données et 
sélectionnez Créer un nouvel objet. Dans la fenêtre Créer un nouvel 
objet, sélectionnez NI-DAQmx Global Channel puis cliquez sur 
Suivant.

• Vous pouvez aussi ouvrir directement l’Assistant DAQ à partir de 
LabVIEW 7.x, LabWindows/CVI 7.x ou Measurement Studio 7.x. 

– Dans LabVIEW, utilisez la commande Voie globale DAQmx pour 
ouvrir l’Assistant DAQ. Cliquez avec le bouton droit sur la 
commande et sélectionnez Nouvelle voie DAQ (Assistant DAQ).

– Dans LabWindows/CVI ou Measurement Studio, vous devez au 
préalable configurer une tâche, comme expliqué précédemment. 
Dans l’Assistant DAQ, cliquez sur Add Existing DAQmx Global 
Channels pour ajouter des voies globales dans votre tâche. Vous 
devez utiliser MAX pour créer des voies globales.

L’Assistant DAQ s’ouvre. 

Effectuez les étapes suivantes pour créer une nouvelle voie globale :

1. Choisissez un type d’E/S, par exemple une entrée analogique (Analog 
Input). 

2. Sélectionnez la mesure ou la génération à réaliser. 

3. Sélectionnez le capteur à utiliser, le cas échéant. 

4. Sélectionnez la voie physique à utiliser. 

5. Configurez les paramètres de mesure spécifiques. 

6. Enregistrez la voie.

• Si vous avez ouvert l’Assistant DAQ à partir de LabVIEW ou de 
LabWindows/CVI, cliquez sur OK. 

• Si vous l’avez ouvert à partir de Measurement Studio, 
sélectionnez File»Save. 

• Si vous l’avez ouvert à partir de MAX, cliquez sur Save Channel. 

Vous pouvez maintenant utiliser la voie globale dans une application ou 
l’ajouter dans une tâche. Reportez-vous à DAQ Assistant Help ou à la 
documentation du logiciel pour obtenir davantage d’informations sur la 
manière d’utiliser une voie ou de générer du code.
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Configurer des voies virtuelles dans NI-DAQ traditionnel
Lorsque vous utilisez NI-DAQ traditionnel, effectuez les étapes suivantes 
pour configurer des voies virtuelles dans MAX.

1. Dans MAX, cliquez avec le bouton droit sur Voisinage de données et 
sélectionnez Créer un nouvel objet. 

2. Sélectionnez Voie Virtuelle dans la fenêtre Créer un nouvel objet, puis 
cliquez sur Terminer. L’Assistant de création d’une nouvelle voie 
s’ouvre. 

3. Suivez les instructions de cet assistant pour créer une nouvelle voie. 
Pour obtenir des informations complémentaires sur la manière de 
configurer les différents types de voies, reportez-vous à l’Aide de 
Measurement & Automation Explorer pour la version traditionnelle 
de NI-DAQ.

Conseils pour le développement d’une application

Exemples
Chaque API inclut un ensemble d’exemples de programmation vous 
permettant de démarrer le développement d’une application. Vous pouvez 
modifier le code d’un exemple et l’enregistrer dans une nouvelle 
application. Vous pouvez utiliser les exemples pour développer une 
nouvelle application ou ajouter le code des exemples dans une application 
existante.
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Pour trouver des exemples LabVIEW ou LabWindows/CVI, ouvrez l’Outil 
de recherche d’exemples National Instruments :

• Dans LabVIEW, sélectionnez Aide»Recherche d’exemples.

• Dans LabWindows/CVI, sélectionnez Help»NI Example Finder.

Les exemples pour Measurement Studio, Visual Basic et en ANSI C sont 
situés dans les répertoires listés ci-dessous :

• Les exemples de NI-DAQmx pour les différents langages supportés par 
Measurement Studio sont dans :

– MeasurementStudio\VCNET\Examples\DAQmx 

– MeasurementStudio\DotNET\Examples\DAQmx

• Les exemples de NI-DAQ traditionnel pour Visual Basic sont dans les 
répertoires suivants :

– Le répertoire NI-DAQ\Examples\Visual Basic avec 
Measurement Studio contient un lien vers les exemples de 
commandes ActiveX à utiliser avec Measurement Studio.

– Le répertoire NI-DAQ\Examples\VBasic contient des exemples 
non associés à Measurement Studio.

• Les exemples de NI-DAQmx en ANSI C sont dans le répertoire 
NI-DAQ\Examples\DAQmx ANSI C.

• Les exemples de NI-DAQ traditionnel en ANSI C se trouvent dans le 
répertoire NI-DAQ\Examples\VisualC.

Pour consulter d’autres exemples, visitez le site ni.com/zone.

Informations sur les périphériques et les applications de mesure
Tous les logiciels d’application et drivers sont livrés avec des informations 
sur la manière d’écrire des applications de mesure et de contrôle de 
périphériques. Les références suivantes aux documents supposent que 
NI-DAQ 7.x et la version 7.x du logiciel d’application NI éventuel soient 
installés.

LabVIEW
Si vous êtes un nouvel utilisateur, lisez la totalité du document Initiation 
à LabVIEW pour vous familiariser avec LabVIEW. Sélectionnez 
Démarrer»Programmes»National Instruments»LabVIEW»
Recherche dans les manuels PDF. 

Le manuel LabVIEW Measurements Manual contient une vue d’ensemble 
des API de NI-DAQ traditionnel et NI-DAQmx, ainsi qu’une description 
des concepts de mesures. Sélectionnez Démarrer»Programmes»
National Instruments»LabVIEW»Recherche dans les manuels PDF.
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Le tutorial de l’aide Taking an NI-DAQmx Measurement in LabVIEW 
contient des instructions pas-à-pas pour configurer une mesure avec 
LabVIEW. Il décrit aussi les nouvelles fonctionnalités clés de NI-DAQmx 
et les concepts nouveaux comme l’Assistant DAQ et les tâches. Dans 
LabVIEW, sélectionnez Aide»Taking an NI-DAQmx Measurement 
pour ouvrir le tutorial.

Les fichiers d’aide VIs d’acquisition de données de NI-DAQ traditionnel et 
LabVIEW NI-DAQmx VI Reference Help décrivent l’ensemble des VIs et 
propriétés DAQ pour LabVIEW. Dans LabVIEW, sélectionnez Aide»Aide 
LabVIEW, puis la section référence des VIs et des fonctions correspondant 
à l’API de NI-DAQ que vous utilisez. 

LabWindows/CVI
La catégorie Data Acquisition Library de l’aide principale de 
LabWindows/CVI Help contient une vue d’ensemble des API, des concepts 
de mesure et des références des fonctions pour NI-DAQ traditionnel et 
NI-DAQmx. Dans LabWindows/CVI, sélectionnez Help»Contents.

Measurement Studio
Le document NI Measurement Studio Help contient une vue d’ensemble de 
l’API de NI-DAQmx, des tâches de mesure, des concepts et des références 
de fonctions. Le fichier d’aide est intégré dans la documentation de Visual 
Studio .NET. Dans Visual Studio .NET, sélectionnez Help»Contents.

Le document Measurement Studio Reference contient une vue d’ensemble 
de l’API NI-DAQ, des concepts de mesures et des références de fonctions. 
Dans Visual Studio .NET, sélectionnez Measurement Studio»
Measurement Studio Reference.

ANSI C sans logiciel d’application NI
Les documents Traditional NI-DAQ User Manual et NI-DAQmx Help 
contiennent une vue d’ensemble des API. NI-DAQmx Help contient aussi 
des informations d’ordre général sur les concepts de mesures. Les 
documents Traditional NI-DAQ C Reference Help et NI-DAQmx 
C Reference Help décrivent l’ensemble des fonctions C et des attributs. 
Sélectionnez Démarrer»Programmes»National Instruments»NI-DAQ 
et choisissez le titre du document pour l’API de NI-DAQ que vous utilisez.

Langages .NET sans logiciel d’application NI
Le document NI Measurement Studio Help contient une vue d’ensemble de 
l’API de NI-DAQmx, des tâches de mesure, des concepts et des références 
de fonctions. Le fichier d’aide est intégré dans la documentation de Visual 
Studio .NET. Dans Visual Studio .NET, sélectionnez Help»Contents.
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Remarque Si vous utilisez un langage .NET sans Visual Studio .NET, il se peut que vous 
ne puissiez pas ouvrir NI Measurement Studio Help.

Documentation des périphériques
NI-DAQ 7.x comprend l’explorateur Device Document Browser, qui 
contient la documentation en ligne pour les périphériques DAQ, SCXI et 
les périphériques de commutation supportés. Il contient par exemple des 
fichiers d’aide décrivant le périphérique, ses broches, ses fonctionnalités, 
les opérations qu’il peut réaliser et les fichiers PDF correspondant aux 
documents papier livrés avec le périphérique. Vous pouvez trouver, 
afficher et/ou imprimer les documents pour chaque périphérique à tout 
moment en insérant le CD. Après avoir installé l’explorateur Device 
Document Browser, les documents du périphérique sont accessibles en 
allant dans Démarrer»Programmes»National Instruments»NI-DAQ»
Browse Device Documentation. 

Configurations avec plusieurs châssis SCXI
Le document SCXI-1346 Shielded Multi-Chassis Cable Adapter 
Installation Guide contient des instructions pour installer des applications 
SCXI mettant en œuvre plusieurs châssis.

Commutation
Le document NI Switches Help contient des informations techniques pour 
la programmation et le support des modules de commutation, ainsi que sur 
le driver d’instrument NI-SWITCH.

Le document NI-SWITCH Instrument Driver Quick Reference Guide 
contient un aperçu de l’API, des fonctions et des VIs.

NI 435x
Lorsque vous avez fini de configurer et de tester le NI 435x, vous pouvez 
utiliser VirtualBench-Logger pour contrôler le NI 435x sans aucune 
programmation. Reportez-vous au manuel Getting Started with 
VirtualBench sur ni.com/manuals pour appendre à utiliser les 
fonctionnalités de VirtualBench-Logger.

Cours de formation
Si vous avez besoin d’une assistance supplémentaire pour démarrer le 
développement d’une application avec les produits NI, NI offre des cours 
de formations. Pour participer à un cours ou en connaître le contenu, visitez 
la rubrique “Événements/Formations” à l’adresse ni.com/france. 
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Support Technique
Pour obtenir un support complémentaire, visitez les sites ni.com/zone, 
ni.com/support et ni.com/france/support, ce dernier site étant 
exclusivement en français. 

Utiliser NI-DAQ traditionnel et NI-DAQmx sur le même 
ordinateur

Les applications existantes développées avec une version antérieure de 
NI-DAQ s’exécuteront avec NI-DAQ traditionnel. Vous pouvez utiliser 
simultanément les API de NI-DAQ traditionnel et NI-DAQmx sur le même 
ordinateur à condition de respecter les restrictions suivantes :

• Une seule API contrôle un périphérique donné à un moment donné.

– Après avoir utilisé un périphérique avec NI-DAQmx, vous devez 
réinitialiser toutes les tâches NI-DAQmx qui l’ont utilisé avant de 
vous en servir avec NI-DAQ traditionnel. Si vous utilisez un 
périphérique dans NI-DAQmx, puis dans NI-DAQ traditionnel 
sans réinitialiser les tâches NI-DAQmx, le code d’erreur –200587 
est renvoyé. Pour réinitialiser les tâches NI-DAQmx, appelez les 
VIs ou fonctions DAQmx Clear Task. 

– Après avoir utilisé un périphérique avec NI-DAQ traditionnel, 
vous devez le réinitialiser avant de vous en servir avec 
NI-DAQmx. Si vous utilisez un périphérique dans NI-DAQ 
traditionnel, puis dans NI-DAQmx sans le réinitialiser, le code 
d’erreur –200324 est renvoyé. 

Pour les périphériques SCXI, vous devez d’abord réinitialiser le 
périphérique DAQ qui communique avec le châssis dans NI-DAQ 
traditionnel avant de pouvoir l’utiliser dans NI-DAQmx. Par 
exemple, les périphériques de la série E utilisent les lignes 0, 1, 
2 et 4 sur le port 0 pour communiquer avec le module SCXI. Le 
code d’erreur –200158 est renvoyé si vous ne réinitialisez pas le 
périphérique qui communique avec le châssis dans NI-DAQ 
traditionnel avant de l’utiliser dans NI-DAQmx. 

• Appelez le VI Réinitialiser un périphérique (Device Reset.vi) 
de NI-DAQ traditionnel ou la fonction Init_DA_Brds.

• Pour réinitialiser des périphériques dans NI-DAQ 
traditionnel, vous devez d’abord réinitialiser tous les 
périphériques à la fois. Effectuez un clic droit sur le répertoire 
Périphériques NI-DAQ traditionnel dans MAX et 
sélectionnez Réinitialiser le driver pour NI-DAQ 
traditionnel. 
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• Dans un système d’acquisition de données SCXI, vous devez utiliser 
la même API pour programmer tous les périphériques : périphériques 
DAQ connectés et modules SCXI insérés.

Reportez-vous à l’adresse ni.com/support pour obtenir des détails et des 
instructions sur les sujets suivants :

• Comment ajouter du code NI-DAQmx dans une application NI-DAQ 
traditionnel

• Comment exécuter deux applications développées avec NI-DAQmx et 
NI-DAQ traditionnel et qui utilisent le même périphérique

Systèmes d’exploitation, logiciels d’application, 
langages de programmation et périphériques supportés 
par NI-DAQ 7.1

La version 7.1 de NI-DAQmx ne prend pas encore en charge la totalité de 
la gamme NI des périphériques de mesure. Les prochaines versions de 
NI-DAQ supporteront dans NI-DAQmx non seulement les nouveaux 
périphériques, mais aussi davantage de périphériques existants, et 
continueront à inclure NI-DAQ traditionnel.

Support du système d’exploitation
NI-DAQmx, NI-DAQ traditionnel et NI-SWITCH 2.1 sont supportés sous 
Windows 2000/NT/XP/Me/98. NI-DAQ 7.x sous Windows NT nécessite 
au moins le Service Pack 6. Measurement Studio nécessite Visual Studio 
.NET 2003, qui nécessite lui-même Windows 2000/NT 4.0/XP. Pour 
connaître les instructions d’installation spécifiques à un système 
d’exploitation, utilisez l’assistant d’installation du matériel que vous 
trouverez à l’adresse ni.com/support/install.

Pour trouver et télécharger une version antérieure de NI-DAQ qui supporte 
les autres systèmes d’exploitation, reportez-vous à la page ni.com/
downloads. 
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Logiciels d’application et langages de programmation supportés
Le tableau 1 liste les versions des logiciels d’application supportés par 
NI-DAQmx et NI-DAQ traditionnel. Si vous n’utilisez pas un logiciel 
d’application NI, reportez-vous au tableau 2.

 

Le tableau 2 liste les langages de programmation et les versions supportés 
par NI-DAQmx et NI-DAQ traditionnel. 

 

Les versions antérieures de NI-DAQ supportent d’autres versions de ces 
langages et logiciels d’application. Pour trouver et télécharger une version 
antérieure du driver, reportez-vous à la page ni.com/downloads.

Tableau 1.  Logiciels d’application supportés par NI-DAQ 7.x

Logiciels d’application NI

Versions 
supportées par 

NI-DAQmx

Versions 
supportées par 

NI-DAQ 
traditionnel

LabVIEW  7.x 6.0–7.x

Module LabVIEW RT — 6.0–7.x1 

LabWindows/CVI  7.x 6.0–7.x

Measurement Studio  7.x 6.0–7.x2

1 Les utilisateurs de LabVIEW RT doivent utiliser NI-DAQ traditionnel pour leurs 
applications DAQ. Une version future de NI-DAQmx supportera LabVIEW RT.
2 NI-DAQ traditionnel n’inclut pas d’interfaces Measurement Studio C++ ou .NET.

Tableau 2.  Support de langages de programmation par NI-DAQ 7.x

Langage de 
programmation

Versions 
supportées par 

NI-DAQmx

Versions 
supportées par 

NI-DAQ 
traditionnel

ANSI C ✓ ✓

Microsoft Visual C++
Bibliothèques de classes
DLL C

7.x1

6.0–7.x
—

6.0–7.x

Visual Basic 6.0 via ActiveX — 6.0

Langages Microsoft .NET
(C# et Visual Basic .NET)

.NET 1.1 —

1 Nécessite la version 7.x de Measurement Studio.
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Périphériques supportés
Pour obtenir les noms spécifiques des périphériques, consultez le fichier 
NI-DAQ 7.x Readme du CD. Le tableau 3 recense les familles de 
périphériques supportées par NI-DAQmx, NI-DAQ traditionnel et 
NI-SWITCH 2.1 dans NI-DAQ 7.1. 

Tableau 3.  Périphériques supportés par NI-DAQ 7.1

Périphérique NI-DAQmx
NI-DAQ 

traditionnel
NI-SWITCH

2.1

DAQ multifonctions

Périphériques PCI et PXI de la série E, comme le NI PCI-6052E ✓ ✓ N/A

Périphériques DAQCard-6024E, DAQCard-6036E et DAQCard-6062E de 
la série E au format PCMCIA

✓ ✓ N/A

Périphériques classiques 16 bits NI PCI-6013/6014 ✓ ✓ N/A

Série E au format AT — ✓ N/A

Périphériques DAQPad pour liaison USB et FireWire (IEEE 1394) — ✓ N/A

Série E comme le NI PXI-6115 — ✓ N/A

Entrée analogique

DAQCard-AI-16E-4 et DAQCard-AI-16XE-50 au format PCMCIA — ✓ N/A

Sortie analogique

NI 670X — ✓ N/A

NI PCI et PXI 671X/673X — ✓ N/A

NI PCI-672X ✓ — N/A

Compteur

NI 660X — ✓ N/A

NI PCI-6624 avec E/S isolées ✓ — N/A

AT-AO-6/10 — ✓ N/A

DAQ haute précision

NI 4350/4351 — ✓ N/A

E/S numériques

NI 6503, NI PXI-6508, NI 6527 et NI PCI-DIO-96 statiques ✓ ✓ N/A

NI 6509, NI 6514, NI 6515 et NI 6528 statiques ✓ — N/A

NI 653X haute vitesse — ✓ N/A

NI DAQCard-DIO-24 et NI DAQPad-6507/6508 pour USB statiques — ✓ N/A

PC-DIO-24 et PC-DIO-96 statiques — ✓ N/A

AT-DIO-32F — ✓ N/A
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Reportez-vous au fichier Readme NI-DAQ 7.x sur le CD ou à Démarrer»
Programmes»National Instruments»NI-DAQ pour obtenir la liste des 
nouveaux périphériques supportés par NI-DAQ 7.1.

Davantage de périphériques dans les futures 
versions de NI-DAQmx
Dans les futures versions de NI-DAQ, NI-DAQmx supportera des 
périphériques qui ne sont actuellement supportés que par NI-DAQ 
traditionnel. 

Périphériques supportés uniquement par NI-DAQ 
traditionnel
NI-DAQmx ne prend pas en charge les périphériques suivants. Les 
périphériques suivants sont supportés uniquement par NI-DAQ 
traditionnel :

• Périphériques AT de la Série E

• Périphériques de sorties analogiques AT-AO-6/10

• Périphérique d’E/S numériques parallèles 32 bits AT-DIO-32F

• Périphériques DAQCard-AI-16E-4 et DAQCard-AI-16XE-50 au 
format PCMCIA

• Périphériques NI PCI-4451/4452/4454 d’acquisition et de génération 
de signaux dynamiques

Acquisition du signal dynamique

NI PCI-4451/4452/4454 — ✓ N/A

NI 4551, NI 4552 et NI 447X — ✓ N/A

Conditionnement du signal

Modules SCXI ✓ ✓ N/A

Modules de la série SCC ✓ ✓ N/A

Conditionnement de signal intégré avec NI PXI-4204 et PXI-4220 ✓ — N/A

Commutation (Switch)

Modules NI SCXI-1160, SCXI-1161 et SCXI-1163R ✓ ✓ ✓

Tous les autres modules de commutation SCXI ✓ — ✓

Modules NI PXI-2501, PXI-2503, PXI-2565, PXI-2590 et PXI-2591 — — ✓

Tous les autres modules de commutation PXI ✓ — ✓

Tableau 3.  Périphériques supportés par NI-DAQ 7.1 (Suite)

Périphérique NI-DAQmx
NI-DAQ 

traditionnel
NI-SWITCH

2.1
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• Périphériques DAQ haute précision NI 4350/4351

• Périphériques d’E/S numériques statiques PC-DIO-24 et PC-DIO-96

Périphériques qui ne sont plus supportés par 
NI-DAQ 7.x
Les produits suivants ne sont pas supportés par NI-DAQ 7.x (ni par 
NI-DAQmx, ni par NI-DAQ traditionnel) et ne le seront pas par les 
versions futures de NI-DAQ. Vous devez utiliser la version 6.9.x de 
NI-DAQ ou une version antérieure pour programmer ces périphériques :

• Périphérique DAQ multifonctions AT-MIO-16F-5

• Périphériques DAQCard-500, DAQCard-516, DAQCard-700, 
DAQCard-1200 et DAQCard-AO-2DC au format PCMCIA

• Périphériques DAQPad-1200 et DAQPad-MIO-16XE-50 pour le port 
parallèle

• Périphériques MIO de la famille Lab-PC au format ISA et PC/XT

• Périphérique MIO PC-516 16 bits, 50 Kéch./s

• Périphérique PC-AO-2DC

• Périphérique MIO PC-LPM-16PnP

• Périphérique PC-OPDIO-16 avec E/S “opto-isolées”

• Périphérique compteur PC-TIO-10 et DIO

• Périphérique MIO PCI-1200, 12 bits, 100 Kéch./s

• Module DAQ 12 bits et module de commande SCXI-1200

• Châssis SCXI-2000 à 4 logements

• Module d’interface série SCXI-2400

• Modules VXI-DAQ, supports et modules VXI-SC, et blocs de 
connexion VXI-TB pour le bus VXI
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DAQ-Schnellstart-Anleitung
In der vorliegenden Broschüre erhalten Sie eine Anleitung zur Installation 
Ihrer Datenerfassungsgeräte und der Treiber-Software NI-DAQ 7.x und 
erfahren, wie die Geräte auf Funktionstüchtigkeit überprüft werden.

Wenn Sie unter Mac OS arbeiten, lesen Sie bitte die NI-DAQ-
Informationen für Macintosh.
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Symbole und Darstellungen
In dieser Anleitung werden folgende Symbole und Darstellungen 
verwendet:

» Das Symbol » führt durch geschachtelte Menüpunkte und Dialogfelder zu 
einer Zieloption. So wird zum Beispiel mit der Abfolge Datei»
Seiteneinstellungen»Optionen angezeigt, dass zunächst das Menü Datei 
auszuwählen ist, anschließend die Option Seiteneinstellungen und dann 
der Befehl Optionen.

Mit diesem Symbol sind Tipps mit wertvollen Hinweisen gekennzeichnet.

Dieses Symbol steht für einen Hinweis und soll auf wichtige Informationen 
aufmerksam machen.

Mit diesem Symbol sind Warnungen vor möglichen Verletzungen, 
Datenverlust oder Systemabsturz gekennzeichnet.

fett In fettgedruckter Schrift sind Elemente dargestellt, die ausgewählt oder 
angeklickt werden müssen, wie beispielsweise Menüelemente oder 
Optionen in Dialogfeldern.

gesperrt Im Sperrdruck sind Textstellen oder Zeichen dargestellt, die über die 
Tastatur einzugeben sind, wie Bezeichnungen für Laufwerke, Pfade, 
Verzeichnisse, Programme, Funktionen, Dateinamen und Erweiterungen.
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gesperrt fett Mit gesperrt dargestelltem Text im Fettdruck sind auf dem Bildschirm 
ausgegebene Meldungen gekennzeichnet.

gesperrt kursiv An Textstellen, die im kursiven Sperrdruck dargestellt sind, sind Eingaben 
des Anwenders erforderlich.

kursiv Kursiv gedruckt sind Querverweise oder wichtige Begriffe, die erstmals 
erwähnt werden und Textstellen, an denen Wörter bzw. Werte einzusetzen 
sind.

Einstieg
In Abbildung 1 sind die Schritte zur Installation eines DAQ-Gerätes und 
des NI-DAQ-7.x-Treibers dargestellt.
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Abbildung 1.  Installationsvorgang

* Gerätesignale und Pinbelegungen sind in der Hilfe zum Measurement & Automation Explorer für den 
traditionellen NI-DAQ-Treiber und in der Measurement & Automation Explorer for NI-DAQmx Help online 
verfügbar, auf die über das Hilfemenü des Measurement & Automation Explorer (MAX) zugegriffen werden 
kann. Mit dem Device Document Browser kann die Gerätedokumentation nach Pinbelegungen und anderen 
Informationen zu Signalen durchsucht werden. Lesen Sie dazu auch Schritt 10: Installation der 
Gerätedokumentation.

Informieren Sie sich in der NI-DAQ 7.x Readme 
und im Abschnitt über die unterstützten Betriebssysteme, 

 Anwenderprogramme, Programmiersprachen und 
Geräte, welche NI-DAQ-7.x-Komponenten für Ihre 

 Anwendung installiert werden müssen.

NI-DAQmx
Traditioneller

NI-DAQ-Treiber

Konfigurieren Sie mit Hilfe des
DAQ Assistant, der über MAX
oder die Anwendersoftware 

verfügbar ist, die gewünschten 
Kanäle und Tasks. 

Entsprechende Informationen 
finden Sie in der DAQ Assistant  

Help und der 
Measurement & Automation
Explorer Help for DAQmx. 

Konfiguration Sie die Kanäle 
im MAX.  Weitere Informationen
 erhalten Sie in der Hilfe zum 
Measurement & Automation 

Explorer für den 
herkömmlichen NI-DAQ-Treiber.

Sie haben Ihre Geräte installiert und konfiguriert.

 
Überprüfen Sie anhand der 

NI-DAQ 7.x Readme, ob die korrekte Version der 
Anwendungssoftware installiert ist. Ist eine  

 Aktualisierung erforderlich?

Aktualisieren Sie die Software 
anhand der entsprechenden 

Upgrade-Hinweise.Ja

Nein

Ja

Installieren, konfigurieren und  
überprüfen Sie das Modul und/oder 

Chassis nach den Anweisungen 
 des SCXI Quick Start Guide bzw. 
NI Switches Getting Started Guide.

Konfigurieren Sie die 
Kanäle entsprechend der Anleitung 

zu Ihrem Produkt. Mit welcher API soll Ihr 
Gerät programmiert 

werden?

Installieren Sie die Treibersoftware und die Dokumentation 
mit Hilfe der Anweisungen in dieser Anleitung.

Installieren, konfigurieren und überprüfen Sie Ihre 
DAQ-Karte entsprechend dieser Anleitung. Wenn Sie die  

weitere Hilfe benötigen, lesen Sie bitte in der MAX-Hilfe die  
Abschnitte über NI-DAQmx, den traditionellen NI-DAQ-Treiber 

und die Anschlussbelegungen*.

Informieren Sie sich in der Dokumentation über die neue 
DAQmx-Programmierschnittstelle (API) und die anderen 

zur Verfügung stehenden APIs.

Soll ein 
SCXI- oder ein Schaltmodul 

installiert werden?

Nein

Soll ein SCXI- oder 
ein Schaltmodul konfiguriert 

werden?

SCXI

Schaltmodul
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NI-DAQ 7.x
Die Messgeräte von National Instruments werden mit NI-DAQ- 
Treiber-Software ausgeliefert. Diese Software dient zur Programmierung 
der Datenerfassungsgeräte und besteht aus einer Vielzahl von Funktionen 
und VIs für Anwendungen wie LabVIEW oder LabWindows™/CVI™. 
Datenerfassungsgeräte gehören zu den Messgeräten und umfassen 
beispielsweise Multifunktions-I/O-Geräte (MIO-Geräte der E-Serie), 
SCXI-Signalkonditionierungsmodule und Schaltmodule. Zur 
Treibersoftware gehört auch eine API-Schnittstelle in Form einer 
Bibliothek von VIs, Funktionen, Klassen, Attributen und Eigenschaften, 
mit der Sie Anwendungen für Ihre Messgeräte erstellen können.

In NI-DAQ 7.x sind zwei NI-DAQ-Treiber mit jeweils eigener Funktionen- 
und VI-Bibliothek sowie Hardware- und Software-Konfiguration 
integriert.

• Der traditionelle NI-DAQ-Treiber ist eine aktualisierte Version des 
früheren NI-DAQ-Treibers. Er umfasst die gleichen VIs und 
Funktionen und arbeitet auf dieselbe Weise wie NI-DAQ 6.9.3, kann 
jedoch auch zusammen mit NI-DAQmx auf demselben Computer 
verwendet werden.

• Bei NI-DAQmx handelt es sich um einen neu entwickelten 
NI-DAQ-Treiber mit speziellen VIs und Funktionen sowie neuen 
Tools zur Programmierung von Messgeräten. NI-DAQmx zeichnet 
sich gegenüber dem traditionellen NI-DAQ-Treiber durch folgende 
Merkmale aus:

– DAQ-Assistent: Ermöglicht die grafische Konfiguration von 
Kanälen und Messvorgängen für Ihr Gerät zur Anwendung in 
LabVIEW, LabWindows/CVI und Measurement Studio. Darüber 
hinaus kann mit dem DAQ-Assistenten entsprechend der 
konfigurierten Tasks und Kanäle NI-DAQmx-Code für 
NI-Anwendungssoftware erzeugt werden.

– Verbesserte Leistung, zum Beispiel durch die Möglichkeit der 
Einzelwertein- und -ausgabe oder durch Multithreading.

– Einfachere, intuitiver gestaltete Programmierschnittstellen zur 
Erstellung von DAQ-Applikationen, die mit weniger VIs und 
Funktionen als frühere Versionen von NI-DAQ auskommen.

– Größere Vielfalt von DAQmx-Funktionen in LabVIEW, wie 
beispielsweise Eigenschaftsknoten zur Datenerfassung oder 
verbesserte Unterstützung von Signalverlaufsdatentypen für die 
Analog-I/O.

– Ähnliche APIs und Funktionen für ANSI C, LabWindows/CVI 
und Measurement Studio, einschließlich systemeigener .NET- 
und C++-Schnittstellen.
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Anwendungsbereiche von NI-DAQmx
Unter folgenden Umständen empfiehlt sich die Verwendung von 
NI-DAQmx:

• Bei der Verwendung von Windows.

• Bei der ausschließlichen Nutzung von Geräten, die mit NI-DAQmx 
arbeiten. Alle von diesem Treiber unterstützten Geräte sind im 
Abschnitt Von NI-DAQ 7.1 unterstützte Betriebssysteme, 
Anwendungsprogramme, Programmiersprachen und Geräte 
aufgeführt.

• Beim Einsatz von Anwendungssoftware der Firma National 
Instruments, wie zum Beispiel von LabVIEW, LabWindows/CVI oder 
Measurement Studio, sofern mindestens Version 7.x installiert ist.

• Bei der Nutzung von Measurement-Studio-.NET-Sprachen oder 
von Geräten, die nur von NI-DAQmx unterstützt werden, wie 
beispielsweise die PXI-Module des Typs 4204 oder 4220.

Anwendungsbereiche des traditionellen NI-DAQ-Treibers
In folgenden Fällen sollte auf den traditionellen NI-DAQ-Treiber 
zurückgegriffen werden:

• Bei Verwendung von Geräten, die nicht durch NI-DAQmx unterstützt 
werden, wie zum Beispiel Multifunktions-DAQ-Geräte der AT-E-Serie 
oder Geräte zur digitalen Ein- und Ausgabe (DIO) bzw. zur Erfassung 
dynamischer Signale.

• Beim Einsatz des LabVIEW-Echtzeit-Moduls (RT Module).

• Wenn Applikationen aktualisiert werden, die mit NI-DAQ 6.9.x erstellt 
wurden und vorläufig noch nicht auf DAQmx umgestellt werden 
sollen.

• Bei Nutzung einer LabVIEW-, LabWindows-/CVI- oder 
Measurement-Studio-Version vor 7.0.

• Bei der Verwendung von Visual Basic 6.0.

Hinweis Anwendungsprogramme von National Instruments werden seit Version 6.0 von 
NI-DAQ unterstützt. Daher kann für LabVIEW, LabWindows/CVI und Measurement 
Studio 6.x auch der traditionelle NI-DAQ-Treiber der NI-DAQ-7.x-CD verwendet werden.
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Komponenten, die nicht mehr vom traditionellen DAQ-Treiber 
unterstützt werden

Folgende Komponenten werden nur noch durch NI-DAQ 6.9.3 unterstützt:

• LabVIEW-, LabWindows-/CVI- oder Measurement-Studio-
Versionen vor 6.0

• Windows 95

• Einige ältere Geräte, wie die Multifunktions-DAQ-Geräte der 
Serie 1200, VXI-DAQ-Geräte oder SCXI-Netzwerkgeräte

Eine Übersicht über die unterstützte bzw. nicht unterstützte Hard- und 
Software erhalten Sie im Abschnitt Von NI-DAQ 7.1 unterstützte 
Betriebssysteme, Anwendungsprogramme, Programmiersprachen 
und Geräte am Ende dieser Anleitung.
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Systemintegration von NI-DAQ
In Abbildung 2 wird dargestellt, in welchen Schritten in einem Messsystem 
eine physikalische Größe der Mess-Software zur Verarbeitung zugeführt 
wird.

Abbildung 2.  Aufbau eines Messsystems
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Die physikalischen Größen werden über Sensoren und Wandler 
Komponenten zur Signalkonditionierung zugeführt, die die Signale so 
aufbereiten, dass sie vom Messgerät leichter erfasst werden können. Die 
Software nimmt die Messwerte auf, visualisiert sie, zum Beispiel in einem 
Graphen oder einem Diagramm, und protokolliert sie bzw. speichert sie 
anderweitig. Auch das Messgerät wird von der Software gesteuert. Dabei 
erhält es Anweisungen, wann und auf welchen Kanälen Daten empfangen 
bzw. erzeugt werden sollen.

Die NI-DAQ-Treibersoftware, die mit den Messgeräten und der 
Anwendungssoftware von National Instruments ausgeliefert wird, 
gestattet Ihnen eine Konfiguration der Datenerfassungsgeräte sowie der 
Datenerfassung, -erzeugung und des Datenaustausches zwischen Geräten. 
Die Verwendung von NI-DAQ erspart Ihnen somit eine eigenständige 
Programmierung. Über Anwendungssoftware wie LabVIEW werden 
Befehle an den Treiber übermittelt, beispielsweise zum Erfassen von 
Messwerten eines Thermoelements oder zur Analyse und Anzeige der 
Daten.

Der NI-DAQ-Treiber kann in jeder Programmierumgebung eingesetzt 
werden, die ein Aufrufen von DLLs über ANSI-C-Schnittstellen 
unterstützt (wie beispielsweise LabVIEW), da der DAQ-Treiber 
unabhängig von der Anwendersoftware mit der DAQ-Karte kommuniziert 
(siehe auch Abbildung 2).

Schritt 1: Überprüfen der Version der 
Anwendungssoftware

Installieren Sie die NI-Anwendungssoftware, also zum Beispiel LabVIEW, 
LabWindows/CVI oder Measurement Studio. Für NI-DAQmx ist eine 
Version ab 7.0 erforderlich. In Verbindung mit dem traditionellen 
NI-DAQ-Treiber kann NI-Anwendungssoftware ab der Version 6.0 
verwendet werden. Weitere Informationen finden Sie in Abschnitt Von 
NI-DAQ 7.1 unterstützte Betriebssysteme, Anwendungsprogramme, 
Programmiersprachen und Geräte am Ende dieser Anleitung.

Tipp Wenn eine bestehende Anwendung mit einer früheren Version Ihrer Anwendungs-
software oder des NI-DAQ-Treibers erstellt wurde, sollten Sie davon eine Sicherheitskopie 
erstellen. Anschließend kann die Software aktualisiert und die Anwendung modifiziert 
werden. Durch die Sicherheitskopie steht es Ihnen jederzeit frei, die Originalversion 
wieder mit der API des traditionellen NI-DAQ-Treibers zu verwenden.
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Schritt 2: Deinstallation von NI-DAQ vor der 
Aktualisierung

Wenn eine ältere NI-DAQ-Version auf NI-DAQ 7.x aktualisiert werden 
soll, muss die bisherige Version deinstalliert werden. Klicken Sie 
dazu im Start-Menü von Windows auf Systemsteuerung»Software. 
Systemspezifische Deinstallationshinweise finden Sie unter 
ni.com/support/install. 

Schritt 3: Installation von NI-DAQ 7.x

Einlegen der CD

Vorsicht! Wenn die vorhandene Anwendung Komponenten enthält, die von diesem Trei-
ber nicht unterstützt werden, darf NI-DAQ 7.x nicht installiert werden. Vor Installation der 
Software sollten Sie die Datei NI-DAQ 7.x Readme auf der Treiber-CD oder den Abschnitt 
Von NI-DAQ 7.1 unterstützte Betriebssysteme, Anwendungsprogramme, Programmier-
sprachen und Geräte am Ende dieser Anleitung lesen.

Der NI-DAQ-7.x-Installationsassistent sollte sich automatisch öffnen. 
Ansonsten wählen Sie bitte Start»Ausführen und geben Sie 
x:\setup.exe ein (x steht dabei für den CD-Laufwerksbuchstaben). 
Sollten dennoch Probleme auftreten, steht Ihnen der Hardware Installation 
Wizard unter ni.com/support/install zur Verfügung, in dem auch 
betriebssystemspezifische Fragen erläutert werden.

Tipp Damit Geräte in Windows automatisch erkannt werden, sollten Sie immer zuerst den 
Treiber installieren, bevor Sie neue Hardware anschließen. Ansonsten erhalten Sie nach 
dem Anschließen eine Aufforderung zur Installation eines Treibers.
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Auswahl der zu installierende(n) API(s)

Vorsicht! NI-DAQ 7.x darf nicht zusammen mit Vorgängerversionen installiert sein. 
Bei der Installation von NI-DAQ 7.x wird die vorherige Version des traditionellen 
NI-DAQ-Treibers einschließlich aller dazugehörigen Hilfsdateien überschrieben. Bei der 
Installation von NI-DAQmx werden alle Vorgängerversionen von NI-DAQ gelöscht.

In NI-DAQ 7.x sind mehrere Treiber (der traditionelle NI-DAQ-Treiber, 
NI-DAQmx und NI-SWITCH) mit den dazugehörigen APIs enthalten, 
die je nach Art der verwendeten Geräte einzeln oder komplett installiert 
werden können. Eine Übersicht über die für Ihre Geräte zu installierenden 
Treiber erhalten Sie in Tabelle 3, Von NI-DAQ 7.1 unterstützte Geräte, 
am Ende dieser Anleitung. Beschreibungen zum traditionellen NI-DAQ-
Treiber und zu NI-DAQmx finden Sie im Abschnitt NI-DAQ 7.x am 
Anfang dieser Anleitung.

Zur Programmierung eines NI-SWITCH-Moduls muss der NI-SWITCH-
Treiber installiert werden. Dabei handelt es sich um einen IVI-fähigen 
Instrumententreiber für Schaltmodule, der für sämtliche Schaltmodule der 
Firma National Instruments verwendet werden kann. Die Bedienoberfläche 
von NI-SWITCH ist ein interaktives Soft-Frontpanel, mit dem 
Anwendungen mit Schaltmodulen getestet und Fehler gesucht werden 
können. Für NI-SWITCH 2.1 ist die Installation von NI-DAQmx und 
NI-VISA 3.0 erforderlich.

Installation der Hilfsdateien
Das Installationsprogramm von NI-DAQ 7.x erkennt automatisch alle 
installierten Anwendungsprogramme von National Instruments und wählt 
automatisch die neueste Version der Software sowie des Treibers und der 
Hilfsdateien für die unterstützten Programmiersprachen von CD aus.
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1. Überprüfen Sie, ob das Installationsprogramm die richtigen 
Hilfsdateien bzw. die korrekte Version der Anwendersoftware 
und/oder Programmiersprache erkannt und ausgewählt hat. Klicken 
Sie dazu auf das Pluszeichen (siehe Abbildung), um alle 
Unterkomponenten sichtbar zu machen. Zur Installation der 
Hilfsdateien, Beispiele und der Dokumentation stehen Ihnen 
zusätzliche Optionen zur Verfügung. Folgen Sie dazu den 
Eingabeaufforderungen.

Hinweis Wenn NI-DAQ 7.x vor NI-Anwendungssoftware der Version 7 installiert wurde, 
muss der NI-DAQ-7.x-Installationsassistent erneut ausgeführt werden, um die entspre-
chende Unterstützung für die Anwendungssoftware zu aktivieren. Wählen Sie dazu 
Start»Ausführen und geben Sie x:\setup.exe ein (anstelle von x ist der CD-Lauf-
werksbuchstabe zu verwenden).

2. Klicken Sie auf Beenden.

3. Sobald der Installationsvorgang abgeschlossen ist, werden Sie gefragt, 
ob Sie den Computer neu starten, herunterfahren oder das Dialogfeld 
abbrechen möchten.

• Bei der Verwendung eines Gerätes des Typs NI 435x und 
LabWindows/CVI, C, C++, Visual Basic bzw. 
VirtualBench-Logger verlassen Sie das Programm und 
installieren Sie die Software von der Treiber-CD des Gerätes.

• Wenn alles für die Installation Ihres Gerätes bereit ist, wählen Sie 
Herunterfahren.
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4. Schalten Sie den Rechner aus und ziehen Sie den Stecker vom 
Computer oder PXI-Chassis.

Schritt 4: Auspacken des Gerätes, der Zusatzhardware 
und der Kabel

Ihr Modul wurde in einer antistatischen Verpackung ausgeliefert, um zu 
verhindern, dass bestimmte Teile davon durch elektrostatische Entladung 
Schaden nehmen.

Vorsicht! Freiliegende Enden von Anschlusspins nicht mit den Fingern berühren!

Beim Auspacken sollten folgende Vorsichtsmaßnahmen ergriffen werden:

• Erden Sie sich über ein Erdungskabel oder Berühren eines mit Masse 
verbundenen Objekts selbst.

• Bringen Sie die Verpackung vor dem Auspacken mit einem blanken 
Metallteil des Computergehäuses in Kontakt.

Packen Sie das Modul aus und überprüfen Sie, ob sich eventuell Teile 
davon gelöst haben, oder ob es anderweitig beschädigt ist. Sollte es schad-
haft erscheinen, setzen Sie sich bitte mit uns in Verbindung. Beschädigte 
Module auf keinen Fall in das Chassis eingebauen!

Wenn Sie das Gerät nicht nutzen, bewahren Sie es in der antistatischen 
Originalverpackung auf.

Sicherheitshinweise und Informationen zur Einhaltung von Sicher-
heitsstandards finden Sie auch in den Begleitmaterialien zur Ihrem 
Gerät und dem in Schritt 10: Installation der Gerätedokumentation 
beschriebenen Gerätedokumente-Browser, der in der NI-DAQ-Software 
enthalten ist.

Schritt 5: Anschließen der einzelnen Komponenten 
Installieren Sie jetzt alle vorhandenen DAQ-Geräte. Weitere Angaben zur 
Hardware, wie beispielsweise zu verwendende Steckplätze, können der 
Dokumentation des Gerätes entnommen werden. Lesen Sie dazu bitte den 
Abschnitt Schritt 10: Installation der Gerätedokumentation.

Wenn in Ihrem System Schaltmodule oder SCXI-Module zur Signal-
konditionierung enthalten sind, die an DAQ-Geräte angeschlossen werden 
sollen, installieren Sie zunächst anhand der vorliegenden Anleitung die 
DAQ-Komponenten.
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Bei der Nutzung von PXI-Schaltmodulen gehen Sie bitte bei der 
Installation und Konfiguration dieser Komponenten nach den 
Anweisungen des NI Switches Getting Started Guide vor.

PCI-Geräte

Vorsicht! Der Computer muss ausgeschaltet sein. Vor der Installation der Hardware ist 
unbedingt eine Erdung erforderlich, um das Gerät vor Schäden durch elektrostatische Ent-
ladung zu schützen.

Folgende Schritte sind zur Installation einer PCI-Karte durchzuführen:

1. Entfernen Sie das Computergehäuse und die Abdeckung für den 
Erweiterungssteckplatz.

2. Berühren Sie zur elektrostatischen Entladung ein beliebiges Metallteil 
des Computers.

3. Führen Sie die Karte in den PCI-Steckplatz ein und drücken Sie sie 
vollständig in den Steckplatz. Wenden Sie dabei keine Gewalt an!

 

4. Sichern Sie die Karte.

5. Montieren Sie das Computergehäuse.

Die PCI-Karte ist nun installiert.

1 PCI-DAQ-Karte
2 PCI-Steckplatz

3 Computer mit PCI-Steckplatz

1
2

3
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PXI-Geräte

Vorsicht! Das PXI-Chassis muss ausgeschaltet sein. Vor der Installation der Hardware ist 
unbedingt eine Erdung erforderlich, um das Gerät vor Schäden durch elektrostatische Ent-
ladung zu schützen.

Folgende Schritte sind zur Installation eines PXI-Moduls durchzuführen:

1. Entfernen Sie die Blende eines freien PXI-Steckplatzes. Informationen 
zu Steckplatzanforderungen finden Sie in der Gerätedokumentation 
unter Schritt 10: Installation der Gerätedokumentation.

2. Berühren Sie zur elektrostatischen Entladung ein beliebiges Metallteil 
des Chassis.

3. Stecken Sie das PXI-Modul in den Steckplatz ein. Verriegeln Sie den 
Arretierhebel, um das Gerät zu befestigen.

4. Schrauben Sie die Frontplatte auf der Montageschiene des Chassis 
fest.

 

Die PXI-Karte ist nun installiert.

1 PXI-Chassis
2 PXI-Modul

3 Schrauben
4 Arretierhebel

8

7

6

5

4

3

2

1

ON

STANDBY

1

2

4

3
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PCMCIA-Karten

Vorsicht! Der Computer muss ausgeschaltet sein. Sollte der PCMCIA-Adapter einen 
Wechsel auch im laufenden Betrieb zulassen, kann der Computer eingeschaltet bleiben. 
Vor der Installation der Hardware ist unbedingt eine Erdung erforderlich, um das Gerät vor 
Schäden durch elektrostatische Entladung zu schützen.

PCMCIA-Karten von National Instruments lassen sich auf jeden beliebi-
gen PC-Kartensteckplatz des Typs II montieren. Zur Installation sind 
folgende Schritte durchzuführen:

1. Entfernen Sie die Abdeckung des PCMCIA-Steckplatzes (sofern 
vorhanden).

2. Führen Sie den Busanschluss des Gerätes in den Steckplatz ein, bis 
dieser fest sitzt. PCMCIA-Karten von National Instruments haben an 
der einen Seite einen Busanschluss mit 68 Pins und auf der anderen 
Seite einen I/O-Anschluss. Die Karten sind so konstruiert, dass sie nur 
in eine Richtung eingebaut werden können.

3. Schließen Sie das Kabel an. Gehen Sie beim Einstecken bzw. Entfer-
nen des Kabels vorsichtig vor und üben Sie keinen Zug aus. Beim 
Einstecken und Herausziehen sollte immer der Stecker angefasst wer-
den. Ziehen Sie niemals direkt am Kabel!
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Die PCMCIA-Karte ist nun installiert.

1 Computer mit PCMCIA-Steckplatz
2 PCMCIA-Steckplatz
3 PCMCIA-Karte

4 I/O-Kabel
5 Zubehör
6 I/O-Signale

®

1

2

4

5

6

DAQCard-700

3
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USB/IEEE-1394-Geräte

Vorsicht! Vor der Installation der Hardware ist unbedingt eine Erdung gemäß VDE 
erforderlich.

Hinweis Bei Verwendung des BP-1 Batteriepaketes sind die Anweisungen der entspre-
chenden Installationsanleitung mit Ausnahme von Schritt 1 zu befolgen. Ansonsten richten 
Sie sich bitte nach der nachfolgenden Anleitung.

NI-Geräte mit USB- oder 1394-Schnittstelle werden folgendermaßen 
installiert:

1. Für einige Geräte wird eine externe Stromzufuhr benötigt.

• Vergewissern Sie sich bei Geräten mit einem externen Netzteil, 
dass die auf dem Netzteil angegebene Spannung mit der lokalen 
Netzspannung (120 oder 230 V~) und der des Gerätes 
übereinstimmt. Schließen Sie das Netzteil an die Spannungsquelle 
an und verbinden Sie das andere Ende des Kabels mit der 
Rückseite Ihres Gerätes.

• Wenn für das Gerät ein Netzkabel vorhanden ist, schließen Sie das 
Gerät damit an die Steckdose an.

2. Verbinden Sie das USB-Kabel entweder mit der USB- bzw. 
1394-Schnittstelle des Rechners, einem Hub oder einem anderen 
Gerät des Typs 1394. Ziehen Sie ggf. die Befestigungsschrauben 
an. Verbinden Sie das andere Ende mit dem USB- oder 
IEEE-1394-Anschluss des Gerätes. Das USB-Kabel ist in der 
folgenden Abbildung dargestellt.

1 Anschluss an den Computer bzw. 
USB-Hub

2 Geräteseitiger Anschluss

1 2
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3. Geräte mit einem Netzschalter auf der Rückseite sind nun 
einzuschalten. Das Gerät sollte automatisch vom Computer erkannt 
werden.

4. Wenn das Gerät erkannt wurde, wird dies durch eine aufleuchtende 
oder blinkende LED auf der Frontplatte signalisiert. In welcher Form 
das Gerät anzeigt, dass es erkannt wurde, erfahren Sie in der dazuge-
hörigen Beschreibung. Hinweise zur Installation der Dokumentation 
mit Hilfe des Device Document Browsers erhalten Sie im Abschnitt 
Schritt 10: Installation der Gerätedokumentation.

Das Gerät ist nun installiert.

Zubehör
Die Installation der Zubehörteile, Anschlussblöcke und/oder SCC-Module 
wird in der Beschreibung Ihres Gerätes erörtert. Für SCXI folgen Sie bitte 
den Anweisungen in dieser Anleitung bis zum Schritt 11: Installation der 
SCXI- oder Schaltmodule (sofern vorhanden).

Schritt 6: Einschalten des Computers bzw. PXI-Chassis
Nach einem Neustart des Computers wird neu installierte Hardware von 
Windows automatisch erkannt. In manchen Windows-Versionen wird nach 
Erkennung der Hardware der Assistent “Neue Hardware gefunden” mit 
einem Dialogfeld für jedes neu installierte National-Instruments-Gerät 
geöffnet. Die Voreinstellung lautet: Software automatisch installieren 
(empfohlen). Klicken Sie auf Weiter bzw. Ja, um die Treiber zu 
installieren, so dass das jeweilige Gerät von Windows beim nächsten Start 
erkannt wird.

Wenn der Computer ein Gerät mit USB- oder IEEE-1394-Bus erkannt hat, 
leuchtet an diesem Gerät die LED für die Betriebsanzeige auf oder blinkt, 
je nachdem, ob ein Fehler vorliegt oder nicht. NI-Geräte mit IEEE-1394-
Schnittstelle haben darüber hinaus eine COM-LED, die zu blinken beginnt, 
wenn das Gerät gefunden wurde. Beschreibungen zu den einzelnen 
LED-Signalen finden Sie in den unter Schritt 10: Installation der Geräte-
dokumentation erläuterten Begleitmaterialien zu Ihrem Gerät.
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Schritt 7: Starten des Measurement & Automation 
Explorer (MAX)

Klicken Sie das Symbol des Measurement & Automation Explorer auf 
dem Desktop doppelt an, um diesen zu öffnen.

Schritt 8: Erfolgreiche Erkennung des Gerätes 
überprüfen

Hinweis Die nachfolgenden Anweisungen gelten nicht für Geräte in Systemen, für die  
LabVIEW RT verwendet wird. Die Konfiguration von Produkten der RT-Serie wird im 
Hardware Installation Wizard unter ni.com/support/install erläutert.

1. Erweitern Sie in der Verzeichnisstruktur die Kategorie Geräte und 
Schnittstellen.

2. Überprüfen Sie, ob das neue Gerät angezeigt wird.

Falls eine Hardwarekomponente sowohl vom traditionellen 
NI-DAQ-Treiber als auch von NI-DAQmx unterstützt wird, und beide 
Treiber installiert sind, wird diese unter Geräte und Schnittstellen 
mit unterschiedlichen Namen in beiden Kategorien aufgeführt. Sollte 
das Gerät nicht automatisch angezeigt werden, ist es unter Umständen 
notwendig, die Anzeige über die <F5>-Taste zu aktualisieren. Falls das 
Gerät dann immer noch nicht erscheint, liegt ein Fehler vor. Besuchen 
Sie dann bitte die Seite ni.com/support/install für Informatio-
nen zur Fehlerdiagnose.
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3. Klicken Sie das zu testende Gerät unter der NI-DAQ-API, die 
zur Programmierung des Gerätes verwendet wird, mit der rechten 
Maustaste an.

• Wenn das Gerät unter dem traditionellen NI-DAQ-Treiber aufge-
führt ist, wählen Sie Eigenschaften und klicken dann auf die 
Schaltfläche Ressourcen testen.

• Wenn sich das Gerät unter NI-DAQmx befindet, wählen Sie 
Selbsttest.

 

4. Nach Beendigung des Selbsttests erscheint eine Meldung, die angibt, 
ob ein Fehler vorliegt. Informationen zur Fehlerdiagnose finden Sie 
unter ni.com/support.

Schritt 9: Konfiguration der Geräteeinstellungen
Jede neu installierte Hardwarekomponente muss konfiguriert werden. 
Um ein Gerät sowohl mit dem traditionellen NI-DAQ-Treiber als auch mit 
NI-DAQmx verwenden zu können, müssen für beide Treiber Einstellungen 
vorgenommen werden.

1. Klicken Sie dazu mit der rechten Maustaste auf den Gerätenamen und 
wählen Sie Eigenschaften. Vergewissern Sie sich, dass das Gerät 
unter der korrekten NI-DAQ-API ausgewählt wurde.

2. Konfigurieren Sie die Eigenschaften des Gerätes.

• Falls Sie zusätzliche Hardware verwenden, wählen Sie bitte unter 
Zubehör den Namen des Gerätes aus.

• Wenn Sie ein Gerät mit dem traditionellen NI-DAQ-Treiber 
ansteuern möchten, können die Gerätevoreinstellungen für AI, 
AO, OPC oder Netzwerkzugriff verändert werden. Weitere 
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Informationen über Gerätevoreinstellungen finden Sie in den 
im nächsten Schritt beschriebenen Unterlagen zu Ihrem Gerät.

3. Klicken Sie auf OK, um die vorgenommenen Änderungen zu 
speichern.

Tipp Bei Geräten, die sowohl durch den traditionellen NI-DAQ-Treiber als auch durch 
NI-DAQmx unterstützt werden, kann die Konfiguration virtueller Kanäle und Skalierun-
gen für den traditionellen NI-DAQ-Treiber in eine NI-DAQmx-Konfiguration 
umgewandelt werden. Verwenden Sie dazu den Traditional NI-DAQ to NI-DAQmx Confi-
guration Converter Wizard. Mit Hilfe dieses Programms können auch Konfigurationen für 
SCXI- und Zusatzhardware umgewandelt werden. SCC-Konfigurationen sind nicht auto-
matisch konvertierbar und müssen daher für beide Treiber einzeln vorgenommen werden. 
Klicken Sie für weitere Hinweise im Assistenten auf die Schaltfläche Hilfe.

Schritt 10: Installation der Gerätedokumentation
Der NI-DAQ-7.x-Treiber enthält mit dem Device Document Browser 
eine Suchmaschine für Gerätebeschreibungen im PDF-Format und 
Hilfedateien, in denen die Anschlüsse, Leistungsmerkmale und die 
Betriebsweise der unterstützten DAQ-, SCXI- und Schaltgeräten erläutert 
sind. Alle Dokumente können vom Device Document Browser aus geöffnet 
und ausgedruckt werden.

Über die entsprechende CD steht Ihnen diese Suchmaschine jederzeit zur 
Verfügung. Der Device Document Browser zu NI-DAQ 7.x bietet folgende 
Optionen:

• Browse Device Documents: Öffnet die Suchmaschine und zeigt die 
Begleitmaterialien zu jedem Gerät an.

• Install Device Documents: Kopiert die Suchmaschine und alle darin 
befindlichen Dokumente auf die Festplatte. Nach der Installation kann 
diese über Start»Programme»National Instruments»NI-DAQ»
Browse Device Documentation geöffnet werden.

Sollte sich das Programm nicht automatisch öffnen, kann es über 
Start»Ausführen und die Eingabe von x:\autorun.exe manuell 
gestartet werden (anstelle von x ist der CD-Laufwerksbuchstabe 
einzugeben).

Hinweis Um die Hilfe, den Device Document Browser und bestimmte andere 
Komponenten der NI-DAQ-7.x-Dokumentation nutzen zu können, muss eine Version des 
Internet Explorer ab 5.0 installiert sein.
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Schritt 11: Installation der SCXI- oder Schaltmodule 
(sofern vorhanden)

Wenn Sie Ihre DAQ-Karte mit SCXI-Modulen zur Signalkonditionierung 
oder Schaltmodulen verwenden möchten, folgen Sie bei der Installation 
und Konfiguration der Module der SCXI-Schnellstart-Anleitung bzw. dem 
NI Switches Getting Started Guide.

Die nachfolgenden Anweisungen gelten nur für DAQ-Karten mit 
Anschlussblöcken oder SCC-Zubehör.

Schritt 12: Anschließen der Sensoren und Signale
Verbinden Sie die Anschlüsse der Geräte mit Sensoren oder anderen 
Signalquellen.

Zu diesem Thema stehen Ihnen die nachfolgend aufgeführten 
Informationsquellen zur Verfügung:

• die Dokumentation zu Signalen und Pinbelegungen:

– Über den Gerätedokumente-Browser können Sie auf die E-Series 
Help sowie auf Gerätehandbücher im PDF-Format zugreifen.

– Pinbelegungen können der Hilfe zum Measurement & Automation 
Explorer für den traditionellen NI-DAQ-Treiber und der 
Measurement & Automation Explorer Help for NI-DAQmx 
entnommen werden, auf die über das MAX-Hilfemenü 
zugegriffen werden kann.

• die Beschreibungen der Schaltmodule, die auch Angaben zur 
Gerätearchitektur enthalten.

• Weitere Informationen über Sensoren finden Sie:

– auf der Webseite ni.com/sensors

– im Handbuch LabVIEW Measurements Manual, das mit 
LabVIEW mitgeliefert wird bzw. über die Webseite 
ni.com/manuals verfügbar ist.

– im Kapitel Sensors der Hilfedatei NI-DAQmx Help, auf die über 
Start»Programme»National Instruments»NI-DAQ»
NI-DAQmx Help zugegriffen werden kann, wenn Sie eine andere 
Programmierumgebung und NI-DAQmx verwenden.

– im Kapitel 5, Transducer Conversion Functions, des Traditional 
NI-DAQ User Manual, das Sie über Start»Programme»
National Instruments»NI-DAQ»Traditional NI-DAQ 
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User Manual öffnen können, wenn Sie eine andere 
Programmierumgebung und den traditionellen NI-DAQ-Treiber 
nutzen.

Schritt 13: Starten der Test-Panels
Bei vielen Geräten sind Testläufe zur Überprüfung bestimmter Gerätefunk-
tionen möglich, wie beispielsweise der Ein- und Ausgabe von Signalen. 
Im MAX kann ein Gerät folgendermaßen getestet werden:

1. Erweitern Sie die Kategorie Geräte und Schnittstellen.

2. Klicken Sie unter Traditionelle NI-DAQ-Geräte oder 
NI-DAQmx-Geräte das zu überprüfende Gerät mit der rechten 
Maustaste an.

3. Wählen Sie anschließend die Option Test Panels aus.
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In der nachstehenden Abbildung sehen Sie ein Beispiel für ein 
Testpanel. 

4. Klicken Sie zur Überprüfung der einzelnen Gerätefunktionen auf die 
verschiedenen Register. Hinweise zur Handhabung der Test-Panels bei 
Nutzung des traditionellen NI-DAQ-Treibers finden Sie in der Hilfe 
zum Measurement & Automation Explorer für den herkömmlichen 
NI-DAQ-Treiber und bei NI-DAQmx über die Menüoption Help.

5. Wenn ein Fehler vorliegt, wird im Testpanel eine entsprechende 
Meldung ausgegeben. Informationen zur Fehlerdiagnose sind in der 
NI-DAQmx Help bzw. unter ni.com/support zu finden.

6. Zum Verlassen des Testpanels klicken Sie auf Schließen.

Schritt 14: Konfiguration aller neu angeschlossenen 
Geräte

Wenn Sie mehrere DAQ-Geräte installiert haben, müssen Schritt 9: 
Konfiguration der Geräteeinstellungen bis Schritt 13: Starten der 
Test-Panels für jedes einzelne Gerät wiederholt werden.
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Schritt 15: Konfiguration der Kanäle und Tasks
Ein physikalischer Kanal ist ein Anschluss bzw. Steckkontakt, an dem ein 
analoges oder digitales Signal gemessen werden kann oder erzeugt wird. 
Ein virtueller Kanal umfasst eine Vielzahl von Einstellungen zu einem 
physikalischen Kanal (z. B. Bezeichnung, Art der vorzunehmenden 
Messung bzw. Signalerzeugung oder Skalierung). Beim traditionellen 
NI-DAQ-Treiber und in früheren Versionen von NI-DAQ kann über die 
Konfiguration virtueller Kanäle festgelegt werden, welche Kanäle für 
verschiedene Messungen verwendet werden. Bei NI-DAQmx sind virtuelle 
Kanäle Bestandteil einer jeden Messung.

Beim traditionellen NI-DAQ-Treiber werden virtuelle Kanäle mit Hilfe des 
MAX konfiguriert. In NI-DAQmx können virtuelle Kanäle über den 
DAQ-Assistenten konfiguriert werden, der sich vom MAX oder von der 
Applikationssoftware aus öffnen lässt. Ein Konfigurieren virtueller Kanäle 
ist aber auch mit der NI-DAQmx-API Ihres Anwendungsprogramms 
möglich.

Ein Task ist ein wichtiger neuer Bestandteil von NI-DAQmx, der mehrere 
virtuelle Kanäle umfasst sowie Einstellungen zum Timing, zur Triggerung 
und zu weiteren Eigenschaften ermöglicht. Ein Task steht für eine durch-
zuführende Messung oder Signalerzeugung. Sämtliche Einstellungen eines 
Tasks sind konfigurierbar und lassen sich speichern, so dass dieser auch in 
einer Applikation verwendet werden kann.

In NI-DAQmx können virtuelle Kanäle als Teil eines Tasks konfiguriert 
oder von diesem getrennt werden. Virtuelle Kanäle, die innerhalb eines 
Tasks erstellt wurden, werden als lokale Kanäle bezeichnet, und solche, die 
außerhalb eines Tasks erstellt werden, als globale Kanäle. Globale Kanäle 
können im MAX erstellt werden oder in der Anwendungssoftware erzeugt 
und anschließend im MAX gespeichert werden. Sie sind in beliebigen 
Anwendungen einsetzbar und können verschiedenen Tasks hinzugefügt 
werden. Eine Änderung an einem globalen Kanal wirkt sich auf alle Tasks 
aus, in denen der Kanal verwendet wird. In den meisten Fällen ist es jedoch 
einfacher, lokale Kanäle zu verwenden.
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Konfiguration eines Tasks in NI-DAQmx
Unter NI-DAQmx werden Tasks mit Hilfe des DAQ-Assistenten 
konfiguriert. Zum Erstellen von Tasks und Kanälen mit dem 
DAQ-Assistenten muss das Anwendungssoftwarepaket von National 
Instruments der Version 7.0 oder einer aktuelleren Version installiert sein.

• Klicken Sie im MAX mit der rechten Maustaste auf Datenumgebung 
und wählen Sie Neu. Klicken Sie auf die Schaltfläche NI-DAQmx 
Task und anschließend auf Weiter.

• Der DAQ-Assistent lässt sich auch direkt von der NI-Applikations-
software öffnen.

– In LabVIEW gibt es zum Öffnen des DAQ-Assistenten folgende 
Möglichkeiten:

• Fügen Sie entsprechend der Beschreibung unter Erste 
Schritte mit LabVIEW das Express-VI “DAQ-Assistent” 
der Express-Palette in das Blockdiagramm ein.

• Alternativ kann auch das Bedienelement “DAQmx-
Taskname” verwendet werden. Klicken Sie das Element mit 
der rechten Maustaste an und wählen Sie Neuer Task 
(DAQ-Assistent). In der Hilfedatei Taking an NI-DAQmx 
Measurement in LabVIEW ist schrittweise beschrieben, wie 
mit dem Element DAQmx-Task-Name ein Task erstellt und 
Blockdiagrammcode erzeugt wird. Um sie zu öffnen, klicken 
Sie auf Hilfe»Taking an NI-DAQmx Measurement.

– In LabWindows/CVI ist Tools»Create/Edit DAQmx Tasks 
auszuwählen.

– Nach dem Öffnen von Visual Studio .NET in Measurement 
Studio wählen Sie Project»Add New Item und klicken im 
Kategorie-Fenster auf Measurement Studio»Assistants. 
Wählen Sie anschließend aus dem Vorlagen-Fenster DAQmx 
Task Class aus.



DAQ Schnellstart-Anleitung 100 ni.com

Der DAQ-Assistent wird geöffnet.

Gehen Sie bei der Erstellung eines neuen Tasks wie folgt vor:

1. Wählen Sie einen I/O-Typ aus (z. B. analoger Eingang).

2. Bestimmen Sie anschließend die Art der auszuführenden Messung 
bzw. Signalerzeugung.

3. Wenn vorhanden, wählen Sie den zu verwendenden Sensor aus.

4. Wählen Sie die Kanäle aus, die dem Task hinzugefügt werden sollen. 
Es können globale Kanäle hinzugefügt werden oder physikalische 
Kanäle gewählt werden, aus denen dann innerhalb des Tasks lokale 
Kanäle erzeugt werden.

5. Nehmen Sie nun bei Bedarf Einstellungen zum Mess-/Ausgabesignal, 
-takt, -modus und und zur Triggerung vor.

6. Speichern Sie den Task.

• Wenn der DAQ-Assistent von LabVIEW oder von 
LabWindows/CVI aus geöffnet wurde, klicken Sie auf OK.

• In Measurement Studio klicken Sie auf File»Save.

• Wenn der DAQ-Assistent von MAX aus geöffnet wurde, wählen 
Sie Save Task.
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Nun kann der Task in einer Applikation verwendet werden. Weitere 
Informationen über die Verwendung eines Tasks und zum Erzeugen von 
Blockdiagrammcode finden Sie in der DAQ Assistant Help und der 
Dokumentation zu Ihrer Anwendungssoftware.

Konfiguration globaler Kanäle in NI-DAQmx
Bei der Verwendung von NI-DAQmx müssen globale Kanäle mit Hilfe des 
DAQ-Assistenten konfiguriert werden.

• Klicken Sie dazu im MAX mit der rechten Maustaste auf 
Datenumgebung und wählen Sie Neu. Klicken Sie im Fenster 
Hinzufügen auf die Schaltfläche NI-DAQmx - Globaler Kanal und 
anschließend auf Weiter.

• In LabVIEW-, LabWindows/CVI- und Measurement-Studio-
Versionen ab 7.x kann der DAQ-Assistent auch direkt aufgerufen 
werden.

– Verwenden Sie in LabVIEW das Element “DAQmx - Globaler 
Kanal”. Klicken Sie es mit der rechten Maustaste an und wählen 
Sie Neuer Kanal (DAQ-Assistent).

– In LabWindows/CVI und Measurement-Studio muss zunächst, 
wie zuvor beschrieben, ein Task erstellt werden. Um dem Task 
globale Kanäle hinzuzufügen, klicken Sie im DAQ-Assistenten 
auf Add Existing DAQmx Global Channels. Das Erstellen von 
globalen Kanälen ist allerdings nur im MAX möglich.

Der DAQ-Assistent wird geöffnet.

Gehen Sie bei der Erstellung eines neuen globalen Kanals wie folgt vor:

1. Wählen Sie einen I/O-Typ aus (z. B. analoger Eingang).

2. Bestimmen Sie anschließend die Art der auszuführenden Messung 
bzw. Signalerzeugung.

3. Wenn vorhanden, wählen Sie den zu verwendenden Sensor aus.

4. Bestimmen Sie den zu verwendenden physikalischen Kanal.

5. Nehmen Sie alle messungsspezifischen Einstellungen vor.

6. Speichern Sie den Kanal.

• Wenn der DAQ-Assistent von LabVIEW oder von 
LabWindows/CVI aus geöffnet wurde, klicken Sie auf OK.

• In Measurement Studio klicken Sie auf File»Save.

• Wenn der DAQ-Assistent von MAX aus geöffnet wurde, wählen 
Sie Save Channel.

Der globale Kanal kann nun in jeder beliebigen Applikation verwendet 
oder einem Task hinzugefügt werden. Weitere Informationen über die 
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Verwendung eines Kanals und das Erstellen von Blockdiagrammcode 
erhalten Sie in der DAQ Assistant Help bzw. in der Dokumentation zu 
Ihrem Anwendungsprogramm.

Konfiguration virtueller Kanäle für den traditionellen NI-DAQ-Treiber
Bei Verwendung des traditionellen NI-DAQ-Treibers sind virtuelle Kanäle 
im MAX zu konfigurieren.

1. Klicken Sie im MAX mit der rechten Maustaste auf Datenumgebung 
und wählen Sie Neu.

2. Wählen Sie anschließend Virtueller Kanal und klicken Sie auf 
Beenden. Daraufhin öffnet sich der Assistent “Neuen Kanal erstellen”. 

3. Folgen Sie den Anweisungen des Assistenten. Zusätzliche 
Informationen zur Konfiguration verschiedener Kanaltypen finden 
Sie in der Hilfe zum Measurement & Automation Explorer für den 
traditionellen NI-DAQ-Treiber.

Erste Schritte zum Erstellen einer Applikation

Beispiele
Jede API enthält Programmierbeispiele, die das Erstellen einer Applikation 
vereinfachen sollen. Diese lassen sich bearbeiten und zur Weiterver-
wendung speichern. So kann auf Grundlage eines Beispiels eine neue 
Applikationen erstellt oder eine bestehende Applikation erweitert werden.
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Ein Suchen von LabVIEW- oder LabWindows/CVI-Beispielen ist über die 
NI-Beispielsuchmaschine möglich, die folgendermaßen geöffnet wird:

• Wählen Sie in LabVIEW Hilfe»Beispiele suchen.

• Klicken Sie in LabWindows/CVI auf Help»NI Example Finder.

Beispiele für Measurement Studio, Visual Basic und ANSI C sind in den 
nachfolgend aufgeführten Verzeichnissen verfügbar:

• NI-DAQmx-Beispiele für von Measurement Studio unterstützte 
Programmiersprachen:

– MeasurementStudio\VCNET\Examples\DAQmx

– MeasurementStudio\DotNET\Examples\DAQmx

• Beispiele für den traditionellen NI-DAQ-Treiber zur Verwendung in 
Visual Basic:

– Das Verzeichnis NI-DAQ\Examples\Visual Basic with 
Measurement Studio enthält einen Link zu den 
Anwendungsbeispielen für ActiveX-Elemente in Measurement 
Studio.

– Das Verzeichnis NI-DAQ\Examples\VBasic enthält von 
Measurement Studio unabhängige Beispiele.

• Im Verzeichnis NI-DAQ\Examples\DAQmx ANSI C befinden sich 
NI-DAQmx-Beispiele für ANSI C.

• Im Verzeichnis NI-DAQ\Examples\VisualC sind Beispiele für den 
traditionellen NI-DAQ-Treiber für ANSI C verfügbar.

Zusätzliche Beispiele sind unter ni.com/zone zu finden.

Informationen zu Messapplikationen und -geräten
Jedes Anwendungssoftwarepaket mit Treiber enthält Informationen zum 
Erstellen von Anwendungen für Messungen sowie zur Steuerung von 
Messgeräten. Die im Folgenden genannten Informationsquellen gelten für 
den Fall, dass NI-DAQ 7.x und, wo notwendig, NI-Anwendungssoftware 
der Version 7.x installiert sind.

LabVIEW
Neuanwender sollten sich zunächst mit dem Handbuch Erste Schritte mit 
LabVIEW befassen, um mit LabVIEW vertraut zu werden. Zum Öffnen 
dieser PDF-Datei ist Start»Programme»National Instruments»
LabVIEW»Im LabVIEW-Bücherregal suchen auszuwählen.



DAQ Schnellstart-Anleitung 104 ni.com

Im LabVIEW Measurements Manual finden Sie API-Übersichten 
zum traditionellen NI-DAQ- und zum NI-DAQmx-Treiber sowie 
Beschreibungen zu Messvorgängen. Klicken Sie dazu Start»
Programme»National Instruments»LabVIEW»LabVIEW-Bibliothek 
durchsuchen an.

In der Hilfedatei Taking an NI-DAQmx Measurement in LabVIEW wird 
schrittweise beschrieben, wie eine Messung in LabVIEW vorbereitet wird, 
und es werden die neuen NI-DAQmx-Funktionen sowie DAQmx-
spezifische Begriffe, wie beispielsweise “DAQ-Assistent” oder “Task”, 
erläutert. Um die Hilfe zu öffnen, klicken Sie auf Hilfe»Taking an 
NI-DAQmx Measurement.

In der LabVIEW Traditional NI-DAQ VI Reference Help und der LabVIEW 
NI-DAQmx VI Reference Help werden LabVIEW-VIs und ihre 
Eigenschaften beschrieben. Zum Öffnen dieser Dateien klicken Sie in 
LabVIEW auf Hilfe»VI-, Funktionen- und Anwendungshilfe und 
wählen dann den Abschnitt über die VIs der verwendeten NI-DAQ-
API aus.

LabWindows/CVI
In der Datenerfassungsbibliothek der LabWindows/CVI Help werden die 
Funktionen des traditionellen NI-DAQ- bzw. des NI-DAQmx-Treibers 
beschrieben sowie Grundlagen zur Messtechnik und den verschiedenen 
APIs vermittelt. Um die Hilfe zu öffnen, wählen Sie in LabWindows/CVI 
Help»Contents.

Measurement Studio
Die NI Measurement Studio Help enthält eine Übersicht über NI-DAQmx-
APIs, Messvorgänge und vermittelt grundlegende Informationen zu 
Messungen und Funktionen. Diese Hilfedatei ist Bestandteil der 
Dokumentation zu Visual Studio .NET. Um sie zu öffnen, klicken Sie 
in Visual Studio .NET die Option Help»Contents an.

Die Measurement Studio Reference verschafft Ihnen einen Überblick 
über die APIs des traditionellen NI-DAQ-Treibers und vermittelt 
Grundlagenwissen zu Messvorgängen bzw. Funktionen. Um sie zu öffnen, 
klicken Sie in Visual Studio .NET Measurement Studio»Measurement 
Studio Reference an.

ANSI C ohne NI-Anwendungssoftware
Übersichten über APIs finden Sie im Traditional NI-DAQ User Manual 
und der NI-DAQmx Help. Die NI-DAQmx Help enthält zusätzlich 
allgemeine Informationen zu Messvorgängen. In der Traditional NI-DAQ 
C Reference Help und der NI-DAQmx C Reference Help erhalten Sie eine 
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Übersicht über die Funktionen und Attribute von C. Wählen Sie 
Start»Programme»National Instruments»NI-DAQ und den Titel des 
Dokuments der verwendeten NI-DAQ-API aus.

.NET-Sprachen ohne NI-Anwendungssoftware
Die NI Measurement Studio Help enthält eine Übersicht über 
NI-DAQmx-APIs, Messvorgänge und vermittelt grundlegende 
Informationen zu Messungen und Funktionen. Diese Hilfedatei ist 
Bestandteil der Visual-Studio-.NET-Dokumentation. Um sie zu öffnen, 
klicken Sie in Visual Studio .NET die Option Help»Contents an.

Hinweis Bei Verwendung einer .NET-Sprache ohne Visual Studio .NET kann es vorkom-
men, dass die NI Measurement Studio Help nicht eingesehen werden kann.

Gerätedokumentation
Zu NI-DAQ 7.x gibt es eine Online-Dokumentation über unterstützte 
DAQ-Geräte sowie SCXI- und Schaltmodule, die über den Device 
Document Browser einsehbar sind. Dabei handelt es sich zum Beispiel 
um Hilfedateien über die Anschlüsse, Leistungsmerkmale und die 
Betriebsweise der Geräte oder um Gerätebeschreibungen im PDF-Format. 
Diese Suchmaschine steht Ihnen jederzeit zur Verfügung, da sie sich 
auf der CD mit der Gerätedokumentation befindet. Nachdem die 
Suchmaschine installiert wurde, kann sie über Start»Programme»
National Instruments»NI-DAQ»Geräte-Dokumentation finden 
aufgerufen werden.

Konfiguration mehrerer SCXI-Chassis
Im SCXI-1346 Shielded Multi-Chassis Cable Adapter Installation 
Guide wird erläutert, welche Schritte zur Entwicklung einer SCXI-
Multichassis-Applikation erforderlich sind.

Schaltmodule
In der NI Switches Help finden Sie technische Unterstützung und Program-
mierhilfen für Schaltmodule und den NI-SWITCH-Instrumententreiber.

Der NI-SWITCH Instrument Driver Quick Reference Guide enthält eine 
Übersicht über APIs, VIs und Funktionen.

NI 435x
Nach der Konfiguration und Überprüfung können PCI-Karten des Typs 
435x mit dem Programm VirtualBench-Logger gesteuert werden, so dass 
keinerlei eigenständige Programmierung Ihrerseits erforderlich ist. Wie der 
VirtualBench-Logger zu diesem Zweck einzusetzen ist, wird in der Bro-
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schüre Getting Started with VirtualBench beschrieben, die unter 
ni.com/manuals zu finden ist.

Kurse
Für weiterführende Anleitung bei der Entwicklung von Applikationen mit 
NI-Produkten bietet die Firma National Instruments Trainingskurse an. 
Informationen über Kursinhalte und zur Anmeldung können der Webseite 
ni.com/training entnommen werden.

Technische Unterstützung
Weitere Unterstützung finden Sie unter ni.com/support oder 
ni.com/zone.

Verwendung des traditionellen NI-DAQ- und des 
NI-DAQmx-Treibers auf demselben Computer

Bestehende Applikationen, die mit früheren Versionen von NI-DAQ 
erstellt wurden, können mit auch mit der vorliegenden Version des 
traditionellen NI-DAQ-Treiber ausgeführt werden. Wenn sowohl die 
traditionelle NI-DAQ-API als auch die NI-DAQmx-API auf demselben 
Computer verwendet werden, gelten jedoch folgende Einschränkungen:

• Ein Gerät kann nur von jeweils einer API gesteuert werden.

– Nach der Verwendung eines Gerätes mit NI-DAQmx müssen alle 
NI-DAQmx-Tasks, bei denen auf das Gerät zugegriffen wird, 
zurückgesetzt werden, bevor das Gerät mit dem traditionellen 
NI-DAQ-Treiber verwendet werden kann. Ansonsten wird ein 
Fehler mit dem Code –200587 ausgegeben. NI-DAQmx-Tasks 
werden mit dem VI “DAQmx - Task zurücksetzen” aufgehoben.

– Nach Verwendung eines Gerätes mit dem traditionellen 
NI-DAQ-Treiber muss das Gerät zurückgesetzt werden, bevor es 
mit NI-DAQmx arbeiten kann. Ansonsten wird ein Fehler mit dem 
Code –200324 ausgegeben.

Bei SCXI-Modulen muss vor Verwendung von NI-DAQmx das 
kommunizierende DAQ-Gerät zurückgesetzt werden, wenn zuvor 
mit dem traditionellen NI-DAQ-Treiber gearbeitet wurde. Bei 
Geräten der E-Serie wird beispielsweise über die Leitungen 0, 1, 
2 und 4 des Ports 0 mit dem SCXI-Modul kommuniziert. Wenn 
das Gerät nicht zurückgesetzt wird, erscheint eine Fehlermeldung 
mit dem Code –200158.

• Rufen Sie dazu das VI “Gerät zurücksetzen” des 
traditionellen NI-DAQ-Treibers oder die Funktion 
Init_DA_Brds auf.
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• Beim traditionellen DAQ-Treiber ist nur ein Zurücksetzen 
aller Geräte auf einmal möglich. Klicken Sie dazu im MAX 
auf die Kategorie Traditional NI-DAQ Devices und wählen 
Sie die Option Reset Driver for Traditional NI-DAQ.

• Innerhalb eines SCXI-Datenerfassungssystems müssen alle 
Geräte (sowohl angeschlossene DAQ-Geräte als auch eingefügte 
SCXI-Module) mit derselben API programmiert werden.

Auf der Internetseite ni.com/support finden Sie Beschreibungen und 
Anleitungen zu folgenden Themen:

• Einfügen von NI-DAQmx-Code in Applikationen für den 
traditionellen NI-DAQ-Treiber

• Ausführen von Applikationen mit traditionellen NI-DAQ- und 
NI-DAQmx-Treiber, die dasselbe Gerät verwenden

Von NI-DAQ 7.1 unterstützte Betriebssysteme, 
Anwendungsprogramme, Programmiersprachen 
und Geräte 

Mit dem Treiber NI-DAQmx 7.1 kann noch nicht die gesamte Palette von 
NI-Messgeräten unterstützt werden. Die kommenden Versionen von 
NI-DAQ werden sowohl neue/bestehende Geräte für NI-DAQmx als auch 
die Gerät für den traditionellen NI-DAQ-Treiber unterstützen.

Unterstützte Betriebssysteme
NI-DAQmx, der traditionelle NI-DAQ-Treiber und NI-SWITCH 2.1 
können unter Windows 2000/NT/XP/Me/98 eingesetzt werden. Für 
NI-DAQ 7.x ist unter Windows NT ein Service-Pack ab Version 6 
erforderlich. Für Measurement Studio wird Visual Studio .NET 2003 
benötigt, was wiederum Windows 2000/NT 4.0/XP voraussetzt. Für 
systemspezifische Installationsanweisungen sollte der Hardware-
Installationsassistent unter ni.com/support/install genutzt werden.

Unter ni.com/downloads können frühere Versionen von NI-DAQ, 
die auch auf anderen Betriebssystemen lauffähig sind, heruntergeladen 
werden.

Unterstützte Anwendungsprogramme und Programmiersprachen
In der Tabelle 1 sind alle Versionen der Anwendungssoftware von National 
Instruments aufgeführt, die von NI-DAQmx und vom traditionellen 
NI-DAQ-Treiber unterstützt werden. Für andere Programmiersprachen gilt 
Tabelle 2.
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In Tabelle 2 sehen Sie die Programmiersprachen und Versionen, die von 
NI-DAQmx und dem traditionellen NI-DAQ-Treiber unterstützt werden.

 

Bei Vorgängerversionen von NI-DAQ werden andere Versionen von 
Anwendungssoftware und Programmiersprachen unterstützt. Ältere 
Treiberversionen können unter ni.com/downloads heruntergeladen 
werden.

Unterstützte Hardware
Die genauen Geräte-Modellnamen finden Sie in der Datei NI-DAQ 7.x 
Readme auf der CD. In Tabelle 3 sind die Gerätefamilien aufgeführt, 
die von NI-DAQmx, dem traditionellen NI-DAQ-Treiber und 
NI-SWITCH 2.1 unterstützt werden.

Tabelle 1.  Von NI-DAQ 7.x unterstützte Anwendungssoftware

Programm NI-DAQmx
Traditioneller 

NI-DAQ-Treiber

LabVIEW  7.x 6.0–7.x

LabVIEW-RT-Modul — 6.0–7.x1

LabWindows/CVI  7.x 6.0–7.x

Measurement Studio  7.x 6.0–7.x2

1 Für LabVIEW-RT-Applikationen muss der traditionelle NI-DAQ-Treiber verwendet 
werden. In zukünftigen Versionen von NI-DAQmx wird jedoch auch LabVIEW-RT 
unterstützt.
2 Der traditionelle NI-DAQ-Treiber hat keine Measurement-Studio-C++- oder 
.NET-Schnittstelle.

Tabelle 2.  Von NI-DAQ 7.x unterstützte Programmiersprachen

Programmiersprache NI-DAQmx
Traditioneller 

NI-DAQ-Treiber

ANSI C ✓ ✓

Microsoft Visual C++
Klassen-Bibliotheken
C-DLL

7.x1

6.0–7.x
—

6.0–7.x

Visual Basic 6.0 durch ActiveX — 6.0

Microsoft-.NET-Sprachen
(C# und Visual Basic .NET)

.NET 1.1 —

1 Measurement Studio 7.x erforderlich.
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Tabelle 3.  Von NI-DAQ 7.1 unterstützte Geräte

Gerät NI-DAQmx
Traditioneller 

NI-DAQ-Treiber
NI-SWITCH

2.1

Multifunktions-DAQ-Geräte

PCI- und PXI-Karten der E-Serie wie NI PCI-6052E ✓ ✓ Nicht 
verfügbar

PCMCIA E-Serie DAQCard-6024E, DAQCard-6036E und 
DAQCard-6062E

✓ ✓ Nicht 
verfügbar

NI PCI-6013/6014 16-Bit-Basis-Geräte ✓ ✓ Nicht 
verfügbar

AT E-Serie — ✓ Nicht 
verfügbar

DAQPad-Geräte für USB und FireWire (IEEE 1394) — ✓ Nicht 
verfügbar

Geräte der S-Serie wie NI PXI-6115 — ✓ Nicht 
verfügbar

Analoge Erfassung

PCMCIA DAQCard-AI-16E-4 und DAQCard-AI-16XE-50 — ✓ Nicht 
verfügbar

Analoge Ausgabe

NI670X — ✓ Nicht 
verfügbar

NI PCI und PXI 671X/673X — ✓ Nicht 
verfügbar

NI PCI-672X ✓ — Nicht 
verfügbar

Counter/Timer

NI660X — ✓ Nicht 
verfügbar

NI PCI-6624 (isoliert) ✓ — Nicht 
verfügbar

AT-AO-6/10 — ✓ Nicht 
verfügbar

Hochpräzisions-DAQ-Geräte

NI 4350/4351 — ✓ Nicht 
verfügbar
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Alle Geräte, die nun auch von NI-DAQ-7.x unterstützt werden, entnehmen 
Sie bitte der Datei NI-DAQ 7.x Readme, die über die CD oder über Start»
Programme»National Instruments»NI-DAQ eingesehen werden kann.

Digital-I/O

NI 6503, NI PXI-6508, NI 6527 und NI PCI-DIO-96 ✓ ✓ Nicht 
verfügbar

NI 6509, NI 6514, NI 6515 und NI 6528 ✓ — Nicht 
verfügbar

NI 653X (Hochgeschwindigkeitsgeräte) — ✓ Nicht 
verfügbar

NI DAQCard-DIO-24 und NI DAQPad-6507/6508 für USB — ✓ Nicht 
verfügbar

PC-DIO-24 und PC-DIO-96 — ✓ Nicht 
verfügbar

AT-DIO-32F — ✓ Nicht 
verfügbar

Erfassung dynamischer Signale

NI PCI-4451/4452/4454 — ✓ Nicht 
verfügbar

NI 4551, NI 4552 und NI 447X — ✓ Nicht 
verfügbar

Signalkonditionierung

SCXI-Module ✓ ✓ Nicht 
verfügbar

Module der SCC-Serie ✓ ✓ Nicht 
verfügbar

NI PXI-4204 und PXI-4220 mit integrierter 
Signalkonditionierung

✓ — Nicht 
verfügbar

Schaltmodule

NI SCXI-1160, SCXI-1161 und SCXI-1163R ✓ ✓ ✓

Alle anderen SCXI-Schaltmodule ✓ — ✓

NI PXI-2501, PXI-2503, PXI-2565, PXI-2590 und PXI-2591 — — ✓

Alle anderen PXI-Schaltmodule ✓ — ✓

Tabelle 3.  Von NI-DAQ 7.1 unterstützte Geräte (Fortsetzung)

Gerät NI-DAQmx
Traditioneller 

NI-DAQ-Treiber
NI-SWITCH

2.1
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Weitere Geräte in künftigen Versionen von 
NI-DAQmx
In künftigen Versionen von NI-DAQ werden auch solche Geräte von 
NI-DAQmx unterstützt, die derzeit nur durch den traditionellen 
NI-DAQ-Treiber angesteuert werden können.

Auf den traditionellen NI-DAQ-Treiber beschränkte 
Geräte
Folgende Geräte werden nicht von NI-DAQmx unterstützt, sondern 
ausschließlich durch den traditionellen NI-DAQ-Treiber:

• Geräte der AT-E-Serie

• AT-AO-6/10-Analogausgabe-Geräte

• AT-DIO-32F 32-Bit-Parallel-DIO-Geräte

• PCMCIA DAQCard-AI-16E-4- und 
DAQCard-AI-16XE-50-Analogeingabe-Geräte

• NI-PCI-4451/4452/4454-Geräte zur Erfassung und Ausgabe von 
dynamischen Signalen

• NI-4350/4351-Hochpräzisions-DAQ-Geräte

• PC-DIO-24 und PC-DIO-96 (digitale I/O-Geräte)

Geräte, die von NI-DAQ 7.x nicht mehr unterstützt 
werden
Die nachfolgend aufgeführten Produkte werden nicht durch NI-DAQ 7.x 
unterstützt – also weder durch NI-DAQmx noch durch den herkömmlichen 
NI-DAQ-Treiber – und werden auch in zukünftigen Versionen von 
NI-DAQ nicht mehr enthalten sein. Zur Programmierung dieser Geräte ist 
NI-DAQ 6.9.x oder eine frühere Version erforderlich:

• AT-MIO-16F-5 - Multifunktions-DAQ-Karten

• DAQCard-500, -516, -700, -1200 und -AO-2DC - PCMCIA-Karten

• DAQPad-1200 und -MIO-16XE-50-Geräte für parallele Ports

• Lab-PC Familie der ISA- und PC/XT MIO-Karten

• PC-516 16-Bit, 50 kS/s MIO-Karten

• PC-AO-2DC Low-Cost-AO- und Stromschleifen-DAQ-Geräte

• PC-LPM-16PnP-MIO-Karten für den PC

• PC-OPDIO-16 (optisch isolierte DIO-Karten für den PC)

• PC-TIO-10 (Timing- und DIO- Schnittstellen für den PC)

• PCI-1200 12-Bit, 100 kS/s (MIO-Karten)
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• SCXI-1200-12-Bit-DAQ- und Steuerungsmodule

• SCXI-2000-Chassis mit 4 Steckplätzen

• SCXI-2400-Module für serielle Schnittstellen

• VXI-DAQ-Module, VXI-SC-Carrier und -Module sowie 
VXI-TB-Anschlussblöcke für den VXI-Bus
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DAQ クイックスタートガイド

この文書では、NI-DAQ 7.xドライバソフトウェアおよびデータ集録

（DAQ）デバイスのインストール方法およびデバイスが適切に動作してい

るかどうかを確認する方法について説明します。

この文書では、Macintosh オペレーティングシステム用 NI-DAQ につい

ては割愛します。Macintosh をご使用の場合には、Macintosh 用の

NI-DAQ を参照してください。
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本書で使用する表記規則
本書では以下の表記規則を使用します。

→ →記号に沿って、入れ子のメニュー項目やダイアログボックスをたどって
いくと、最終的に必要な操作を実行することができます。ファイル→ペー
ジ設定→オプションという順になっている場合、まずファイルメニューを
プルダウンし、次にページ設定項目を選択して、最後のダイアログボック
スからオプションを選択します。

このアイコンは、ユーザへのアドバイスを表しています。

このアイコンは、注意すべき重要な情報があることを示しています。

このアイコンは、人体への損傷、データの損失、システムのクラッシュな

どを防止するための注意事項があることを示しています。

太字 太字のテキストは、メニュー項目やダイアログボックスなど、ソフトウェ

アでユーザが選択（クリック）する必要のある項目を表します。また、フ

ロントパネル上のパラメータ名、制御器やボタン、ダイアログボックスま

たはその一部、メニュー名、パレット名も表します。

下線 下線つきのテキストは、重要な事項を示します。

斜体 このフォントスタイルは変数を示します。または、ユーザが入力する必要

がある語または値のプレースホルダを示します。

monospace このフォントのテキストは、キーボードから入力する必要のあるテキスト

や文字、 コードの一部、プログラムサンプル、構文例を表します。また、

ディスクドライブ名、パス名、ディレクトリ名、プログラム名、サブプロ

グラム名、サブルーチン名、デバイス名、関数名、演算名、変数名、ファ



© National Instruments Corporation 115 DAQ クイックスタートガイド

monospace bold このフォントの太字テキストは、画面に自動印刷されるメッセージや応答

を示します。また、 他のサンプルとは異なるコードラインを強調する場合

にも使用します。ただし、日本語の文字の入力や表示は、前後の文と区別

するため、「」で囲んでいる場合もあります。

monospace の斜体 このフォントの斜体のテキストは、ユーザが提供する必要のある言葉や値

のためのプレースホルダ（テキスト）を表します。

概要

図 1 は、NI-DAQ 7.xおよび DAQ デバイスをインストールする手順と、

文書内の関連情報の掲載箇所を示します。
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図 1 インストールの概要

* デバイス信号と端子接続についての情報は、Measurement & Automation Explorer（MAX）のヘルプトピックにある
『Measurement & Automation Explorer の従来型 NI-DAQ 対応ヘルプ』および『Measurement & Automation Explorer 
Help for NI-DAQmx』を参照してください。さらに、デバイス信号接続およびその他の信号に関する情報については、

Device Document Browser のデバイスのドキュメントから入手できます。デバイスの文書の使用方法については、「手順

10. デバイスの文書を参照またはインストールする」を参照してください。
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NI-DAQ 7.xソフトウェア

ナショナルインスツルメンツの計測デバイスには、LabVIEW または

LabWindows™/CVI™ など、アプリケーションソフトウェアから呼び出す

ことができる VI や関数の豊富なライブラリである NI-DAQ ドライバソフ

トウェアが同梱されており、NI の計測デバイスの機能をすべてプログラ

ムすることができます。計測デバイスには、E シリーズマルチファンク

ション I/O（MIO）デバイス、SCXI 信号調節モジュール、およびスイッ

チモジュールなどの DAQ デバイスが含まれます。また、ドライバソフト

ウェアには、デバイスのアプリケーションを作成するための、VI、関数、

クラス、属性、およびプロパティのライブラリであるアプリケーションプ

ログラミングインタフェース（API）が含まれています。

NI-DAQ 7.xには、NI-DAQ ドライバが 2 つ含まれており、それぞれのド

ライバには独自の API、ハードウェア構成、およびソフトウェア構成があ

ります。 

• 従来型 NI-DAQ は、NI-DAQ の旧バージョンがアップグレードされ

たものです。従来型 NI-DAQ には、NI-DAQmx と同じコンピュータ

で使用できるという点を除き、NI-DAQ 6.9.3 と同様に機能する VI お
よび関数が含まれています。 

• NI-DAQmx は、計測デバイスのプログラムを作成するための新しい

VI、関数、および開発ツールを備えた最新の NI-DAQ ドライバです。

従来型 NI-DAQ と比べ、NI-DAQmx には以下の優位点があります。

– DAQ アシスタント： LabVIEW、LabWindows/CVI、および

Measurement Studio でデバイスの制御に使用する、チャネル

および計測タスクを構成するグラフィカルツールです。また、こ

の DAQ アシスタントを使用して、NI アプリケーションソフト

ウェアプログラムで使用するタスクとチャネルを基にした

NI-DAQmx コードを生成することもできます。

– 高速化シングルポイントアナログ I/O およびマルチスレッドな

ど、パフォーマンスの向上。

– NI-DAQ の旧バージョンと比べて、わずかな関数と VI で DAQ
アプリケーションを作成できる、シンプルで直感的な API。

– データ集録用プロパティノードや優れたアナログ I/O 用波形

データタイプサポートなど、機能拡張された LabVIEW 
NI-DAQmx API。

– ANSI C、LabWindows/CVI、ネイティブ .NET と C++ インター

フェースを含む Measurement Studio と同様の API と機能性を

提供。

NI-DAQmx の使用条件
NI-DAQmx は、以下の条件を満たす場合に使用できます。

• Windows を使用している。
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• 使用するデバイスがすべて、NI-DAQmx によってサポートされてい

る。サポートされているデバイスのリストについては、「NI-DAQ 7.1
のオペレーティングシステム、アプリケーションソフトウェア、プロ

グラミング言語、およびデバイスサポート」セクションを参照してく

ださい。

• NI-DAQmx の使用には、LabVIEW、LabWindows/CVI、
Measurement Studio などの NI アプリケーションソフトウェアを

使用する場合、それらのソフトウェアの 7.xまたはそれ以降のバー

ジョンが必要です。

• Measurement Studio .NET 言語や、PXI-4204 モジュールまたは

PXI-4220 モジュールなどの NI-DAQmx によってのみサポートされて

いるデバイスを使用する場合には、必ず NI-DAQmx を使用してくだ

さい。

従来型 NI-DAQ の使用が必要な場合
以下の状況が 1 つでも該当する場合は、従来型 NI-DAQ をインストール

して使用する必要があります。

• AT E シリーズマルチファンクション DAQ デバイスやダイナミック

信号集録デバイスなど、NI-DAQmx でサポートされていないデバイ

スを使用している。

• LabVIEW Real-Time（RT）モジュールを使用している。

• NI-DAQ 6.9.xからアップグレードして、NI-DAQmx に移植する予定

のない既存アプリケーションがある。

• 7.0 より前のバージョンの LabVIEW、LabWindows/CVI、または

Measurement Studio を使用している。

• Visual Basic 6.0 を使用している。

メモ NI-DAQ 7.0 の従来型 NI-DAQ でサポートされている NI アプリケーションソフ

トウェアで最も古いバージョンは 6.0 です。LabVIEW、LabWindows/CVI、
または Measurement Studio 6.xでは、NI-DAQ 7.xから従来型 NI-DAQ を使用

できます。

従来型 NI-DAQ でサポートが廃止されたもの
下記の項目は、NI-DAQ 6.9.3 でサポートされ、従来型 NI-DAQ でサポー

トが廃止されたものです。

• LabVIEW、LabWindows/CVI、または Measurement Studio アプ

リケーションソフトウェアでバージョンが 6.0 より前のもの

• Windows 95

• 1200 シリーズマルチファンクション DAQ デバイス、VXI DAQ デバ

イス、またはリモート SCXI デバイスなどの以前のデバイス
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サポートの有無を示す項目リストについては、この文書の最後にある

「NI-DAQ 7.1 のオペレーティングシステム、アプリケーションソフト

ウェア、プログラミング言語、およびデバイスサポート」セクションを参

照してください。

NI-DAQ のシステムの適合性
図 2 はこの計測システムの概要で、実際の物理現象がどのような流れで

計測アプリケーションに取り入れられるかを示しています。

図 2 計測システムの概要
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コンピュータは計測デバイスから生データを受け取ります。信号調節デバ

イスは、センサーとトランスデューサを使用して、物理現象を計測デバイ

スがデータを扱えるような電気信号に調節します。ソフトウェアは生デー

タを取得し、人間が理解できる形式で表し、データを処理することによ

り、グラフ、チャート、またはレポート用ファイルとして使用することが

できます。また、ソフトウェアは計測システムを制御し、いつ、どのチャ

ネルからデータを集録または出力するかを計測デバイスに伝えます。

NI の計測デバイスおよびアプリケーションソフトウェアには、データの

構成、集録、生成、NI の計測デバイスへのデータの送信といった NI の計

測デバイスの機能をすべてプログラムするための NI-DAQ ドライバソフ

トウェアが梱包されています。NI-DAQ を使用すると、そのようなプログ

ラムを作成する時間や手間が省けます。LabVIEW のようなアプリケー

ションソフトウェアは、たとえば熱電対の値を読み取って返すようなコマ

ンドをドライバへ送信し、集録されたデータの表示や解析をします。

NI-DAQ ドライバは、LabVIEW または ANSI C インタフェースを介した

ダイナミックリンクライブラリ（DLL）の呼び出しをサポートするプログ

ラミング環境から使用できます。図 2 のように、プログラミング環境に

関係なく、DAQ アプリケーションは NI-DAQ を使用します。

手順 1. アプリケーションソフトウェアの正しいバー
ジョンがインストールされたことを確認する

LabVIEW、LabWindows/CVI、および Measurement Studio を含む

NI アプリケーションソフトウェアをインストールします。NI-DAQmx を

使用する場合は、NI アプリケーションソフトウェアの 7.0 またはそれ以

降のバージョンを使用する必要があります。従来型 NI-DAQ を使用する

場合は、NI アプリケーションソフトウェアの 6.0 またはそれ以降のバー

ジョンを使用する必要があります。この文書の最後にあるセクションの

「NI-DAQ 7.1 のオペレーティングシステム、アプリケーションソフト

ウェア、プログラミング言語、およびデバイスサポート」を参照してくだ

さい。

ヒント 旧バージョンのアプリケーション開発環境または NI-DAQ で作成されたアプリ

ケーションが存在する場合、そのアプリケーションのバックアップコピーを作

成します。その後、ソフトウェアをアップグレードして、そのアプリケーショ

ンを修正することができます。従来型 NI-DAQ API のまま変更せず元のアプリ

ケーションを使用する場合には、そのバックアップコピーを使用することがで

きます。
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手順 2. NI-DAQ をアンインストールする（旧バージョ
ンからアップグレードする場合）

旧バージョンから NI-DAQ 7.xをアップグレードする場合、現在のバー

ジョンをインストールする前に NI-DAQ の旧バージョンをアンインス

トールします。コントロールパネル→プログラムの追加と削除を使用しま

す。各オペレーティングシステムのアンインストールについての説明は、

ni.com/support/install（英語）を参照してください。

手順 3. NI-DAQ 7.xソフトウェアをインストールする

CD を挿入する

注意 既存のアプリケーションがサポートされていないコンポーネントを含む場合、

NI-DAQ 7.xをインストールしないでください。ソフトウェアをインストールす

る前に、NI-DAQ 7.xの CD に含まれている『NI-DAQ 7.x Readme』ファイル

またはこの文書の最後にあるセクションの「NI-DAQ 7.1 のオペレーティングシ

ステム、アプリケーションソフトウェア、プログラミング言語、およびデバイ

スサポート」を参照してください。

NI-DAQ 7.xのインストーラが自動的に起動します。起動しない場合は、

スタート→ファイル名を指定して実行を選択します。x:¥setup.exeを

入力します。ここで、xは CD ドライブの文字を示します。トラブル

シューティングと各オペレーティングシステムの説明については、

ni.com/support/ja/daqのトラブルシューティングウィザードを参照

してください。

ヒント 新しいデバイスをインストールする前にドライバソフトウェアをインストール

してください。これをインストールしないと、Windows はデバイスを検出しな

い可能性があり、ドライバのインストールを促す警告が表示されることがあり

ます。
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インストールする API を選択する

注意 NI-DAQ 7.xは、NI-DAQ の旧バージョンと同じシステムに共存させることがで

きません。NI-DAQ 7.xをインストールすると、最新バージョンの従来型

NI-DAQ が旧バージョンの NI-DAQ を上書きします。また、旧バージョンによ

りインストールされたサポートファイルも最新のものになります。NI-DAQmx
のインストール時に、旧バージョンの NI-DAQ は削除されます。

NI-DAQ 7.xは、複数のドライバおよびその API（従来型 NI-DAQ、

NI-DAQmx、および NI-SWITCH）を含みます。ドライバのいずれかまた

はすべてのドライバをインストールするかどうかは、使用するデバイスに

よって決まります。どの API をご使用のシステムにインストールすれば

よいか判断するには、この文書の最後にある表 3、「NI-DAQ 7.1 デバイス

サポート」で確認してください。従来型 NI-DAQ および NI-DAQmx の説

明については、この文書の最初にあるセクションの「NI-DAQ 7.x ソフト

ウェア」を参照してください。

NI スイッチモジュールをプログラムするには、NI-SWITCH をインストー

ルして使用します。NI-SWITCH は、NI のスイッチモジュールのすべてを

サポートする IVI 準拠のスイッチ計測器ドライバです。NI-SWITCH には、

スイッチアプリケーションのテストとトラブルシューティング用の対話式

ソフトフロントパネルがあります。NI-SWITCH は、NI-DAQmx と従来型

NI-DAQ ドライバの上にあるドライバ層です。NI-SWITCH 2.1 には

NI-DAQmx および NI-VISA 3.0 のインストールが必要です。

サポートファイルをインストールする
NI-DAQ 7.xインストーラはシステムにインストールされている NI ソフト

ウェアを検出し、最新のドライバ、アプリケーションソフトウェア、およ

び言語サポートファイルを CD から自動的にインストールします。
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1. インストーラが正しいサポートファイル、アプリケーションソフト

ウェアや言語の正しいバージョンを検出して選択したかどうかを確認

します。上の図のように、機能サブコンポーネントのリストを表示す

るには、機能のリストの先頭に表示されている＋記号をクリックしま

す。サポートファイル、サンプル、および文書をインストールするた

めの追加オプションを選択できます。ソフトウェアの指示に従ってく

ださい。

メモ NI-DAQ 7.xをインストールしてから NI アプリケーションソフトウェア 7.xをイ

ンストールする場合には、NI-DAQ 7.xインストーラをもう一度実行して正しい

アプリケーションソフトウェアサポートをインストールする必要があります。

スタート→ファイル名を指定して実行を選択します。x:¥setup.exeを入力し

ます。ここで、xは CD ドライブの文字を示します。

2. 終了をクリックします。

3. インストールが完了したら、今再起動、シャットダウン、または終了

するかどうかを尋ねるメッセージが表示されます。

• NI 435xデバイスを使用していて、LabWindows/CVI、C、

C++、Visual Basic、または VirtualBench-Logger を使用して

いる場合には、プログラムを終了し、NI 435xCD からソフト

ウェアをインストールしてください。

• デバイスをインストールする準備ができたら、終了します。

4. コンピュータまたは PXI シャーシの電源を切り、コードを抜きます。
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手順 4. デバイス、アクセサリ、およびケーブルの梱包
を解く

ご使用のデバイスは、静電気による損傷（ESD、静電破壊）を防ぐため、

静電防止の梱包で出荷されます。これは、静電破壊によってデバイスの部

品が損傷を受けるおそれがあるためです。

注意 露出しているコネクタピンには絶対に触れないでください。

このような損傷を回避するには、以下の予防措置を講じてください。

• 接地ストラップを使用したり、接地された物体に触れたりして、身体

を接地する。

• 静電防止の梱包をシャーシの金属部分に接触させてから、デバイスを

梱包箱から取り出す。

デバイスを箱から取り出し、部品がゆるんでいないかどうか、また、

損傷箇所がないかどうか調べてください。デバイスが損傷している場合

は、ナショナルインスツルメンツまでご連絡ください。コンピュータ、

PXI シャーシ、または SCXI シャーシに損傷したデバイスをインストール

しないでください。

デバイスを使用しないときは、静電防止の梱包に保管してください。

安全およびコンプライアンスの情報については、デバイスに梱包されてい

た、もしくは「手順 10. デバイスの文書を参照またはインストールする」

に記述されているように、NI-DAQ ソフトウェアキットの Device 
Document Browser 上のデバイスの関連文書を参照してください。

手順 5. デバイス、アクセサリ、およびケーブルの梱包
をインストールする

複数の DAQ デバイスをインストールする場合には、それらのデバイスを

すべてここでインストールしてください。スロットの必要条件など、デバ

イスのハードウェアの詳細については、「手順 10. デバイスの文書を参照

またはインストールする」に記述されているデバイスの文書を参照してく

ださい。

DAQ デバイスに接続されるスイッチまたは SCXI 信号調節モジュールが

システムに含まれる場合は、この文書を参照して DAQ コンポーネントを

先にインストールします。

システムに PXI スイッチモジュールが含まれる場合には、『NI Switches 
Getting Started Guide』（英語）を参照して PXI スイッチのインストー

ルや構成を行ってください。
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PCI デバイス

注意 コンピュータの電源がオフであることを確認してください。適切な静電破壊防

止対策により身体が接地されていることを必ず確認してから、ハードウェアを

取り付けてください。

PCI デバイスをインストールするには、以下の手順に従ってください。

1. コンピュータと拡張スロットのカバーを外します。

2. 静電気を放電するため、コンピュータの金属部分に接触します。

3. PCI システムスロットにデバイスを挿入します。そっと揺り動かしな

がら、デバイスをスロットに差し込みます。デバイスをスロットへ無

理に押し込まないでください。
 

4. デバイスの取り付け金具をコンピュータのバックパネルレールに取り

付けます。

5. コンピュータのカバーを元の位置に戻します。

これで、PCI デバイスがインストールされました。

1 PCI DAQ デバイス

2 PCI システムスロット
3 PCI コンピュータ
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PXI デバイス

注意 PXI シャーシの電源がオフであることを確認してください。適切な静電破壊防止

対策により身体が接地されていることを必ず確認してから、ハードウェアを取

り付けてください。

PXI モジュールをインストールするには、以下の手順に従ってください。

1. 未使用の PXI スロットのカバーパネルを外します。スロットの要件に

ついては、「手順 10. デバイスの文書を参照またはインストールする」

に記述されているデバイスの関連文書を参照してください。

2. 静電気を放電するため、シャーシの金属部分に触れます。

3. PXI システムスロットにデバイスを挿入します。デバイスを完全に挿

入するには、脱着ハンドルを使用します。

4. シャーシのフロントパネル取り付けレールに、デバイスのフロントパ

ネルをネジで取り付けます。
 

これで、PXI デバイスがインストールされました。

1 PXI シャーシ

2 PXI モジュール
3 ネジ

4 脱着ハンドル

8

7

6

5

4

3

2

1

ON

STANDBY

1

2

4

3
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PCMCIA デバイス

注意 コンピュータの電源がオフであることを確認してください。PCMCIA スロット

がホットスワップをサポートしている場合、コンピュータの電源はオンでもか

まいません。適切な静電破壊防止対策により身体が接地されていることを必ず

確認してから、ハードウェアを取り付けてください。

NI PCMCIA デバイスは、Type II の PC カードの空きスロットにインス

トールすることができます。PCMCIA デバイスをインストールするには、

以下の手順に従ってください。

1. コンピュータの PCMCIA スロットカバーを外します（該当する場合）。

2. コネクタがしっかりと接続されるまで、PCMCIA デバイスの

PCMCIA バスコネクタをスロットに挿入します。NI PCMCIA デバ

イスには、一端には 68 ピンの PCMCIA バスコネクタ、もう一端に

は I/O コネクタの 2 つのコネクタがあります。PCMCIA デバイス

は、一方向にしか挿入できないよう保護されています。

3. I/O ケーブルを取り付けます。ケーブルコネクタの挿入や取り外しで

は、I/O ケーブルに負担をかけないように注意してください。常に、

挿入するまたは外すケーブルのコネクタの部分をしっかりとつかんで

ください。PCMCIA デバイスから I/O ケーブルを絶対に直接引き抜

かないでください。

1 PCMCIA コンピュータ

2 PCMCIA ソケット

3 PCMCIA デバイス

4 I/O ケーブル

5 アクセサリ

6 I/O 信号

®

1

2

4

5

6

DAQCard-700

3
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これで、PCMCIA デバイスがインストールされました。

USB/IEEE 1394 デバイス

注意 適切な静電破壊防止対策により身体が接地されていることを必ず確認してから、

ハードウェアを取り付けてください。

メモ BP-1 バッテリパックを使用している場合には、BP-1 のインストールガイドのイ

ンストールの手順（手順 1 は除く）に従ってください。BP-1 バッテリパックを

使用していない場合には、以下の手順に従ってください。

USB または 1394 用の NI デバイスをインストールするには、以下の手順

に従ってください。

1. USB または 1394 用の NI デバイスの中には外部電源が必要なデバイ

スもあります。

• デバイスに外部電源がある場合、外部電源の電圧（該当する場

合）がユーザがデバイスを使用する場所の電圧（120/230 VAC）

とデバイスに必要な電圧に一致するかどうかを確認してくださ

い。電源の片方をコンセントに接続し、もう片方をデバイスの後

部に取り付けます。

• デバイスに電源コードがある場合は、電源コードの片方をデバイ

スに接続し、もう片方をコンセントに接続します。

2. コンピュータの USB または 1394 ポート、その他のハブ、1394 デバ

イス上の使用可能な USB または 1394 ポートにケーブルを接続しま

す。取り付けネジを締めて接続を固定します（該当する場合）。デバ

イスの USB/IEEE 1394 ポートに USB/1394 ケーブルのもう片方を接

続します。USB ケーブルとそのコネクタを以下に示します。

3. USB または IEEE 1394 デバイスの後部パネルに電源スイッチがある場

合、デバイスの電源を入れます。コンピュータがデバイスを即座に検

出します。

4. コンピュータが USB や IEEE 1394 デバイスを認識すると、フロント

パネルの LED が点滅または点灯します。LED の点滅パターンについ

1 コンピュータ /USB ハブのコネクタ 2 デバイスのコネクタ
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ては、そのデバイスの関連文書を参照してください。Device 
Document Browser を使用したデバイスの関連文書のインストール

については、「手順 10. デバイスの文書を参照またはインストールす

る」を参照してください。

これで、USB/IEEE 1394 デバイスがインストールされました。

アクセサリ
インストールガイドの手順に従って、アクセサリ、ターミナルブロック、

SCC モジュールを取り付けます。SCXI については、「手順 11. SCXI また

はスイッチモジュールをインストールする（該当する場合）」までは、こ

の文書の手順に従ってください。

手順 6. コンピュータまたは PXI シャーシに電源を入れる

Windows は、ハードウェアのインストール後に初めてコンピュータが再

起動されたときに、新しくインストールされたデバイスを認識します。一

部の Windows システムでは、インストールされたすべての NI デバイス

に対して、新しいハードウェアの検索ウィザードが起動します。デフォル

トにより、デバイスに最適なドライバを検索する（推奨）が選択されま

す。Windows がデバイスを認識するように、次へまたははいをクリック

して各デバイスのソフトウェアをインストールします。

コンピュータが USB/IEEE 1394 デバイスを認識すると、デバイスの状態

に応じて電源 LED が点滅または点灯します。また、IEEE 1394 用 NI デバ

イスには、デバイスが検出されると点滅する COM LED があります。

LED の点灯点滅パターンの説明については、デバイスの文書の「手順 10. 
デバイスの文書を参照またはインストールする」を参照してください。

手順 7. Measurement & Automation Explorer
（MAX）を起動する

デスクトップにある Measurement & Automation アイコンをダブルク

リックして、MAX を開きます。
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手順 8. デバイスが認識されたことを確認する

メモ 以下の手順は、LabVIEW RT シリーズの製品が動作するシステムにインストー

ルされたデバイスには適用されません。RT シリーズの製品のセットアップ手順

については、ni.com/support/installから Hardware Installation Wizard
（英語）を参照してください。

1. デバイスとインタフェースを展開します。

2. デバイスとインタフェースの下に表示されるデバイスを確認します。 

従来型 NI-DAQ と NI-DAQmx の両方でデバイスがサポートされてい

て、その両方ともインストールされている場合は、同じデバイスは

「デバイスとインタフェース」の従来型 NI-DAQ フォルダおよび

NI-DAQmx フォルダの下にそれぞれ表示されます。デバイスが表示

されない場合には、<F5> を押して MAX の表示を更新します。デバ

イスがまだ認識されないときは、ni.com/support/ja/troubleの

トラブルシューティングを参照してください。

3. デバイスのプログラムに使用する NI-DAQ API のフォルダの下で、

テストするデバイスを右クリックします。

• デバイスが Traditional NI-DAQ に表示される場合、プロパティ

を選択して、プロパティウィンドウに表示されるリソース確認を

クリックします。

• デバイスが NI-DAQmx に表示される場合は、Self-Test を選択し

ます。
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4. セルフテストが終了すると、エラーが発生したかどうかを示すメッ

セージが表示されます。エラーが発生した場合、トラブルシューティ

ングに関する情報については、ni.com/support/jaを参照してくだ

さい。

手順 9. デバイス設定を構成する

インストールする各デバイスを構成します。従来型 NI-DAQ と

NI-DAQmx の両方でデバイスを使用するには、それぞれの API でデバイ

スのプロパティを構成する必要があります。

1. デバイス名を右クリックしてプロパティを選択します。デバイスを使

用する NI-DAQ API フォルダの下のデバイス名を必ずクリックしてく

ださい。

2. デバイスプロパティを構成します。

• アクセサリを使用している場合、アクセサリについての情報を追

加します。

• 従来型 NI-DAQ でデバイスを使用している場合、AI、AO、

OPC、またはリモートアクセスのデフォルト設定を変更できま

す。デバイスのデフォルト設定についての詳細は、デバイスの文

書を参照してください。

3. OK をクリックして変更を承諾します。

ヒント 従来型 NI-DAQ と NI-DAQmx の両方でサポートされているデバイスについて

は、Traditional NI-DAQ to NI-DAQmx Configuration Converter Wizard で従

来型 NI-DAQ の仮想チャネルおよびスケール構成を変換することができます。ま

た、ウィザードは SCXI とアクセサリの構成を変換しますが、SCC 構成は変換し
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ません。SCC を使用する場合、各 API で別々に SCC の情報を構成する必要があ

ります。構成の変更については、ウィザードのヘルプを参照してください。

手順 10. デバイスの文書を参照またはインストールする

NI-DAQ 7.xソフトウェアには Device Document Browser が含まれて

おり、これにはサポートされる DAQ、SCXI、およびスイッチデバイスの

オンライン文書があります。デバイスの文書には、デバイスの端子、機

能、および操作を説明するヘルプファイル、およびデバイスの文書の

PDF ファイルが含まれています。また、Device Document Browser を
使用して、各デバイスの文書を検索、表示、印刷することができます。

Device Document Browser は、適切な CD を挿入するといつでも使用

することができます。NI-DAQ 7.xドキュメントブラウザには以下のオプ

ションがあります。

• Browse Device Documents によりドキュメントブラウザが開か

れ、それぞれのデバイスの文書が表示されます。

• Install Device Documents によりドキュメントブラウザとデバイス

の文書がハードドライブにコピーされます。ドキュメントブラウザを

インストールすると、デバイスの文書をスタート→プログラム→

National Instruments → NI-DAQ → Browse Device 
Documentation から表示できます。

ブラウザが自動的に開かない場合には、スタート→ファイル名を指定して

実行を選択して、x:¥autorun.exeを選択します（ここで、xは CD ド

ライブの文字を表します）。

メモ ヘルプシステムおよび Device Document Browser を含む NI-DAQ 7.xの文書

の機能には、Internet Explorer 5.0 またはそれ以降のバージョンのインストール

が必要なものもあります。

手順 11. SCXI またはスイッチモジュールをインストー
ルする（該当する場合）

DAQ デバイスに接続する SCXI 信号調節モジュールまたはスイッチモ

ジュールがシステムに含まれる場合、SCXI またはスイッチハードウェア

のインストールおよび構成には、『SCXI クイックスタートガイド』または

『NI Switches Getting Started Guide』を参照してください。

この文書の手順 12 以降は、DAQ デバイスをターミナルブロックまたは

SCC アクセサリと一緒に使用する場合のみに該当します。
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手順 12. センサーと信号を取り付ける

センサーと信号をデバイスまたはアクセサリ端子に配線します。

以下の文書には、有用な情報が記載されています。

• 信号および端子の接続：

– 『E Series Help』、デバイスのユーザマニュアルやアクセサリの

文書（PDF）は、Device Document Browser から参照するこ

とができます。

– ピンの並び順については、MAX のヘルプメニューから表示でき

る『Measurement & Automation Explorer Help for 
NI-DAQmx』に記載されています。

• スイッチの仕様にはデバイスのトポロジーが含まれています。

• センサーの使用については、以下のリソースを参照してください。

– ni.com/sensors（英語）

– LabVIEW を使用する場合は、LabVIEW に同梱されている

『LabVIEW Measurements Manual』または ni.com/jp/

manualsを参照してください。

– 他のプログラミング環境と NI-DAQmx を使用する場合には、

スタート→プログラム→ National Instruments → NI-DAQ →

NI-DAQmx Help から表示できる『NI-DAQmx Help』の

「Sensors」のトピックを参照してください。

– 他のプログラミング環境と従来型 NI-DAQ を使用する場合には、

スタート→プログラム→ National Instruments → NI-DAQ →

Traditional NI-DAQ User Manual から表示できる

『Traditional NI-DAQ User Manual』の Chapter 5
「Transducer Conversion Functions」を参照してください。

手順 13. テストパネルを実行する

多くのデバイスには、信号の集録や生成などの特定のデバイス機能をテス

トするためのテストパネルがあります。

1. MAX で、デバイスとインタフェースを展開します。

2. 従来型 NI-DAQ デバイスまたは NI-DAQmx デバイスの下で、テスト

するデバイスを右クリックします。
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3. 選択されたデバイスのテストパネルを開くには、 テストパネル

（NI-DAQmx では Test Panels）を選択します。

テストパネルの例を以下の図に示します。
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4. デバイスのさまざまな機能をテストするには、タブをクリックしま

す。NI-DAQmx でのテストパネルの操作については、ヘルプを参照

してください。従来型 NI-DAQ のテストパネルの操作については、

『Measurement & Automation Explorer の従来型 NI-DAQ 対応ヘ

ルプ』を参照してください。

5. テストパネルには、エラーが発生したかどうかを示すメッセージが表

示されます。トラブルシューティングについては、『NI-DAQmx 
Help』または ni.com/support/jaを参照してください。

6. 終了したら、Close をクリックして、テストパネルを終了します。

手順 14. 追加の新しいデバイスを構成する

複数の DAQ デバイスをインストールする場合、各デバイスごとに手順

「手順 9. デバイス設定を構成する」～「手順 13. テストパネルを実行す

る」を繰り返します。

手順 15. チャネルの構成とタスクの設定

物理チャネルとは、アナログ / デジタル信号を計測または生成できる端子

またはピンのことです。これに対して、仮想チャネルとは、名前、物理

チャネル、入力端子接続、計測または生成のタイプ、およびスケール情報

を含むことができる設定のコレクションです。従来型 NI-DAQ とそれ以

前のバージョンでは、仮想チャネルの構成は、どのチャネルがどの計測に

使用されているかを登録するオプション機能です。NI-DAQmx では、仮

想チャネルはすべての計測に不可欠です。

従来型 NI-DAQ では、MAX を使用して仮想チャネルを構成しますが、

NI-DAQmx では、DAQ アシスタントで仮想チャネルを構成することが

できます。この DAQ アシスタントは、MAX やアプリケーションソフト

ウェアから開くことができます。また、アプリケーションプログラムで、

NI-DAQmx API を使用して仮想チャネルを構成することもできます。

タスクとは、NI-DAQmx の新しい重要な概念で、タイミング、トリガ、

その他のプロパティを備えた単一または複数の仮想チャネルを集めたもの

です。概念としては、タスクは実行する計測または生成を意味していま

す。タスク内の構成情報はすべて設定または保存して、アプリケーション

で使用することができます。

NI-DAQmx では、仮想チャネルをタスクの一部として、またはタスクか

ら切り離して構成できます。タスク内に作成した仮想チャネルは、ローカ

ルチャネルです。タスク外に定義した仮想チャネルは、グローバルチャネ

ルです。グローバルチャネルは、MAX 内あるいはアプリケーションソフ

トウェア内に作成して、MAX に保存することができます。また、どのア

プリケーションでも使用することができる上、さまざまなタスクにそれら

を追加することもできます。グローバルチャネルを変更した場合は、その
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変更がそのグローバルチャネルに関連するすべてのタスクに影響を及ぼし

ます。通常、ローカルチャネルを使用するほうが簡単です。

NI-DAQmx でタスクを設定する
NI-DAQmx を使用する場合は、DAQ アシスタントでタスクを構成しま

す。DAQ アシスタントでタスクおよびチャネルを作成するには、NI アプ

リケーションソフトウェアパッケージの 7.0 またはそれ以降のバージョン

を必ず使用してください。

• MAX でデータ設定を右クリックして、新規作成を選択します。新規

作成ウィンドウで NI-DAQmx Task を選択して、次へをクリックし

ます。

• また、NI アプリケーションソフトウェアの中から直接 DAQ アシス

タントを開くこともできます。

– LabVIEW では、さまざまな方法で DAQ アシスタントを開くこ

とができます。

• 『LabVIEW 入門』の説明に従って、DAQ アシスタント

Express VI を Express 入力パレットから取り出します。

• DAQmx タスク名制御器を使用して DAQ アシスタントを開

くこともできます。制御器を右クリックして、新規タスク

（DAQ アシスタント ) を選択します。「Taking an 
NI-DAQmx Measurement in LabVIEW」チュートリアル

には、DAQmx タスク名制御器でタスクを作成する方法お

よびタスクに基づいたコードを生成する方法が段階的に説明

してあります。LabVIEW では、ヘルプ→ Taking an 
NI-DAQmx Measurement を選択してチュートリアルを開

きます。

– LabWindows/CVI では、Tools → Create/Edit DAQmx Tasks
を選択します。

– Measurement Studio では、Visual Studio .NET を開き、

Project → Add New Item を選択して Add New Item ダイアロ

グボックスを開きます。Categories ぺーンで、Measurement 
Studio → Assistants を選択します。Templates ぺーンでは、

DAQmx Task Class を選択します。
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DAQ アシスタントが開きます。

新しいタスクを作成するには、以下の手順に従ってください。

1. アナログ入力などの I/O タイプを選択します。

2. 実行する計測または生成を選択します。

3. 使用するセンサーを選択します（該当する場合）。

4. チャネルを選択して、タスクを追加します。グローバルチャネルをタ

スクに追加するか、タスク内のローカルチャネルを作成する物理チャ

ネルを選択します。

5. 必要に応じて、その計測に適した設定、タイミング、およびトリガを

設定します。 

6. タスクを保存します。

• LabVIEW または LabWindows/CVI から DAQ アシスタントを

開いた場合は、OK をクリックします。

• Measurement Studio から DAQ アシスタントを開いた場合は、

File → Save を選択します。

• MAX から DAQ アシスタントを開いた場合には、Save Task を

クリックします。
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これで、アプリケーションでタスクを使用することができるようになりま

した。タスクやコード生成についての詳細は、『DAQ Assistant Help』を

参照するか、アプリケーションソフトウェアのマニュアルを参照してくだ

さい。

NI-DAQmx のグローバルチャネルを構成する
NI-DAQmx を使用する場合は、DAQ アシスタントでグローバルチャネ

ルを構成します。

• MAX でデータ設定を右クリックして、新規作成を選択します。新規

作成ウィンドウで、NI-DAQmx Global Channel を選択して、次へ

をクリックします。

• LabVIEW、LabWindows/CVI、Measurement Studio のそれぞれ

7.xまたはそれ以降のバージョンの中から DAQ アシスタントを直接

開くこともできます。

– LabVIEW では、DAQmx グローバルチャネル制御器を使用して

DAQ アシスタントを開いてください。制御器を右クリックし

て、新規チャネル（DAQ アシスタント）を選択します。

– LabWindows/CVI または Measurement Studio では、前述の

ように最初にタスクを必ず構成してください。DAQ アシスタン

トでは、Add Existing DAQmx Global Channels をクリック

して、タスクにグローバルチャネルを追加します。グローバル

チャネルを作成するには、MAX を必ず使用してください。

DAQ アシスタントが開きます。

新しいグローバルチャネルを作成するには、以下の手順に従ってください。

1. アナログ入力などの I/O タイプを選択します。

2. 実行する計測または生成を選択します。

3. 使用するセンサーを選択します（該当する場合）。

4. 使用する物理チャネルを選択します。

5. その計測に適した設定を構成します。

6. チャネルを保存します。

• LabVIEW または LabWindows/CVI から DAQ アシスタントを

開いた場合は、OK をクリックします。

• Measurement Studio から DAQ アシスタントを開いた場合は、

File → Save を選択します。

• MAX から DAQ アシスタントを開いた場合には、Save 
Channel をクリックします。

これで、アプリケーションでのグローバルチャネルの使用およびグローバ

ルチャネルのタスクへの追加ができるようになりました。チャネルの使用

やコード生成についての詳細は、『DAQ Assistant Help』またはアプリ

ケーションソフトウェアの文書を参照してください。
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従来型 NI-DAQ で仮想チャネルを構成する
従来型 NI-DAQ を使用する際は、以下の手順に従って MAX で仮想チャ

ネルを構成してください。

1. MAX でデータ設定を右クリックして、新規作成を選択します。

2. 新規作成ウィンドウで従来型 NI-DAQ 仮想チャネルを選択し、終了

をクリックします。新規作成ウィザードが開きます。

3. 新規作成チャネルウィザードの説明に従って、新しいチャネルを作成

します。さまざまなチャネルタイプの構成についての詳細は、

『Measurement & Automation Explorer の従来型 NI-DAQ 対応ヘ

ルプ』を参照してください。

アプリケーション開発を開始する

サンプル
各 API にはプログラミングサンプルのコレクションが含まれており、ア

プリケーション開発を手がける際に役立ちます。サンプルのコードを変更

したり、アプリケーションに保存したりすることができます。また、サン

プルを使用して、新しいアプリケーションを開発したり、サンプルのコー

ドを既存のアプリケーションに加えたりすることができます。

LabVIEW および LabWindows/CVI のサンプルを検索するには、以下の

要領で NI サンプルファインダを開いてください。

• LabVIEW では、ヘルプ→サンプルを検索を選択します。

• LabWindows/CVI では、Help → NI Example Finder を選択します。
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Measurement Studio、Visual Basic、および ANSI C のサンプルは、以

下のディレクトリにあります。

• Measurement Studio でサポートされる言語の NI-DAQmx のサン

プルは、以下のディレクトリにあります。

– MeasurementStudio¥VCNET¥Examples¥DAQmx 

– MeasurementStudio¥DotNET¥Examples¥DAQmx

• Visual Basic 用の従来型 NI-DAQ サンプルは、以下のディレクトリ

にあります。

– NI-DAQ¥Examples¥Visual Basic with Measurement Studio
ディレクトリには、Measurement Studio と併用する ActiveX
コントロールのサンプルへのリンクがあります。

– NI-DAQ¥Examples¥VBasicディレクトリには、Measurement 
Studio を使用しない VisualBasic のサンプルがあります。

• ANSI C 用 NI-DAQmx サンプルは、NI-DAQ¥Examples¥DAQmx ANSI C
ディレクトリにあります。

• ANSI C 用従来型 NI-DAQ サンプルは、NI-DAQ¥Examples¥VisualC

ディレクトリにあります。

その他のサンプルについては、ni.com/zone（英語）を参照してください。

計測アプリケーションとデバイスの情報
各アプリケーションソフトウェアのパッケージおよびドライバには、計測

および計測デバイス制御用アプリケーションの構築についての情報が含ま

れています。以下のリファレンス文書では、NI-DAQ 7.x、NI アプリケー

ションソフトウェア 7.x（該当する場合）を使用していることを前提とし

ています。

LabVIEW
はじめてご使用になる場合には、『LabVIEW 入門』をお読みになり、

LabVIEW の基本操作を習得してください。スタート→プログラム→

National Instruments → LabVIEW → LabVIEW ドキュメントライブラ

リを検索を選択します。

『LabVIEW Measurements Manual』には従来型 NI-DAQ および

NI-DAQmx の API の概要が記載されており、計測の概念が説明されてい

ます。スタート→プログラム→ National Instruments → LabVIEW →

LabVIEW ドキュメントライブラリを検索を選択します。

「Taking an NI-DAQmx Measurement in LabVIEW」チュートリアルで

は、LabVIEW での計測をセットアップする方法が段階ごとに説明されて

います。また、新しい重要な特徴や概念も説明してあります。LabVIEW
の、ヘルプ→ Taking an NI-DAQmx Measurement からチュートリア

ルを開いてください。
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『LabVIEW 従来型 NI-DAQ VI リファレンスヘルプ』および『LabVIEW 
NI-DAQmx VI リファレンスヘルプ』には、LabVIEW VI およびプロパ

ティについての説明があります。LabVIEW の、ヘルプ→オンラインヘル

プリファレンスから、ご使用の NI-DAQ API の VI のリファレンスヘルプ

セクションを選択します。

LabWindows/CVI
LabWindows/CVI Help のデータ集録ライブラリには、従来型 NI-DAQ
および NI-DAQmx の API の概要、計測の概念、関数のリファレンスが含

まれます。LabWindows/CVI では、Help → Contents を選択します。

Measurement Studio
『NI Measurement Studio Help』には、NI-DAQmx API の概念、計測タ

スクおよび概念、関数リファレンスについて記載されています。このヘル

プファイルは Visual Studio .NET のマニュアルに統合されています。

Visual Studio .NET では、Help → Contents を選択します。

『Measurement Studio Reference』には、従来型 NI-DAQ API の概要

や、計測の概念、関数リファレンスが記載されています。Visual Studio 
.NET では、Measurement Studio → Measurement Studio Reference
を選択します。

ANSI C - NI アプリケーションソフトウェア不使用
『Traditional NI-DAQ User Manual』および『NI-DAQmx Help』には、

API の概念について説明してあります。『NI-DAQmx Help』にも、計測

の概念についての一般情報が含まれています。『Traditional NI-DAQ 
C Reference Help』および『NI-DAQmx C Reference Help』には、

C 関数と属性についての説明が記載されています。スタート→プログ

ラム→ National Instruments → NI-DAQ を選択して、使用している

NI-DAQ API のマニュアルのタイトルを選択します。

.NET 言語 - NI アプリケーションソフトウェア不
使用

『NI Measurement Studio Help』には、NI-DAQmx API の概念、計測タ

スクおよび概念、関数リファレンスについて記載されています。このヘル

プファイルは Visual Studio .NET のマニュアルに統合されています。

Visual Studio .NET では、Help → Contents を選択します。

メモ Visual Studio .NET を使わずに .NET 言語を使用する場合は、

『NI Measurement Studio Help』を表示できない可能性があります。



DAQ クイックスタートガイド 142 ni.com/jp

デバイスの文書
NI-DAQ 7.xには Device Document Browser があり、サポートのある

DAQ、SCXI やスイッチデバイスのオンライン文書（デバイスのピンの並

び順、特性、操作を説明したヘルプファイル、デバイスのドキュメント

（PDF）など）が含まれます。CD を挿入して Device Document 
Browser を使用すると、各デバイスのドキュメントを検索、表示、印刷

することができます。Device Document Browser をインストール後、

デバイスの文書はスタート→プログラム→ National Instruments →

NI-DAQ → Browse Device Documentation から表示できます。

SCXI マルチシャーシ構成

『SCXI-1346 Shielded Multi-Chassis Cable Adapter Installation 
Guide』には、SCXI の開発とスイッチマルチシャーシのアプリケーショ

ンのセットアップの説明が記載されています。

スイッチ

『NI Switches Help』には、スイッチモジュールおよび NI-SWITCH 計測

器ドライバ用の技術プログラムサポートがあります。

『NI-SWITCH Instrument Driver Quick Reference Guide』には、API の
概要および関数 /VI の概念の説明が記載されています。

NI 435x
NI 435xの構成とテストが終了したら、VirtualBench-Logger を使用し

てプログラミングの手間をかけずに NI 435xを制御することができます。

ni.com/manuals（英語）の『Getting Started with VirtualBench』を

参照して、VirtualBench-Logger の機能の使用方法を確認してください。

カスタマートレーニング
ナショナルインスツルメンツでは、NI 製品を使用してアプリケーション

開発を行うためのトレーニングコースを用意しています。トレーニング

コースへのご登録、またはそのコース概要については、ni.com/jp/

trainingをご覧ください。

技術サポート
その他のサポートについては、ni.com/support/jaまたは ni.com/

zone（英語）を参照してください。
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従来型 NI-DAQ と NI-DAQmx を同じコンピュータで
使用する

NI-DAQ の旧バージョンで開発された既存のアプリケーションは従来型

NI-DAQ で動作します。従来型 NI-DAQ API および NI-DAQmx API の同

じコンピュータでの使用については、以下の制約があります。

• 一度に 1 つの API しかデバイスを制御できません。

– NI-DAQmx でデバイスを使用後、従来型 NI-DAQ でデバイスを

使用する前に、そのデバイスを使用しているすべての

NI-DAQmx のタスクを解除する必要があります。デバイスを

NI-DAQmx で使用した後で、NI-DAQmx のタスクを予約解除せ

ずに従来型 NI-DAQ で使用すると、エラーコード –200587が返

されます。NI-DAQmx タスクを解除するには、DAQmx Clear 
Task VI または関数を呼び出します。

– 従来型 NI-DAQ でデバイスを使用した後は、NI-DAQmx でデバ

イスを使用する前にそのデバイスをリセットする必要がありま

す。デバイスを従来型 NI-DAQ で使用した後で、デバイスをリ

セットせずに NI-DAQmx で使用すると、エラーコード –200324

が返されます。

SCXI デバイスでは、DAQ 通信デバイスは NI-DAQmx で使用す

る前に従来型 NI-DAQ で必ずリセットしてください。たとえば、

E シリーズデバイスではポート 0 のライン 0、1、2、および 4 を

使用して SCXI モジュールと通信します。通信デバイスは、

NI-DAQmx で使用する前に従来型 NI-DAQ でリセットしない

と、エラーコード –200158が返されます。

• 従来型 NI-DAQ デバイスリセット VI または Init_DA_Brds

関数を呼び出します。

• 従来型 NI-DAQ でデバイスをリセットする際は、すべての

デバイスを必ず同時に行ってください。MAX の従来型

NI-DAQ デバイスフォルダを右クリックして、従来型

NI-DAQ 用にドライバをリセットを選択します。

• 1 つの SCXI データ集録システムのすべてのデバイス（接続された

DAQ デバイスおよび挿入された SCXI モジュール）をプログラムす

るには、同じ API を使用する必要があります。

以下のトピックの詳細と説明については、ni.com/support/jaを参照し

てください。

• 従来型 NI-DAQ アプリケーションに NI-DAQmx コードを追加する方法

• 同じデバイスを使用する、従来型 NI-DAQ アプリケーションおよび

NI-DAQmx アプリケーションの両方を実行する方法



DAQ クイックスタートガイド 144 ni.com/jp

NI-DAQ 7.1 のオペレーティングシステム、アプリケー
ションソフトウェア、プログラミング言語、およびデバ
イスサポート

現在、NI-DAQmx 7.1 ではすべての NI 計測デバイス製品がサポートされ

ているわけではありません。将来の NI-DAQ のリリースでは、新規デバ

イスおよび既存デバイス用の NI-DAQmx のサポートが追加されます。

また、引き続き従来型 NI-DAQ もサポートします。

オペレーティングシステムサポート
NI-DAQmx、従来型 NI-DAQ、および NI-SWITCH 2.1 では、

Windows 2000/NT/XP/Me/98 がサポートされています。Windows NT
上の NI-DAQ 7.xではサービスパック 6 またはそれ以降が必要です。

Measurement Studio には Windows 2000/NT 4.0/XP で動作する

Visual Studio .NET 2003 が必要です。各オペレーティングシステムでの

インストール方法については、ni.com/support/ja/daqから DAQ イ

ンストールウィザードを使用します。

他のオペレーティングシステムをサポートする NI-DAQ の旧バージョン

をダウンロードするには、ni.com/support/ja/downloadを参照して

ください。

アプリケーションソフトウェアおよびプログラミング言語サ
ポート

表 1 は、NI-DAQmx および従来型 NI-DAQ でサポートされるアプリケー

ションソフトウェアのバージョンです。NI のアプリケーションソフト

ウェアを使用しない場合は、表 2 を参照してください。
 

表 1 NI-DAQ 7.x アプリケーションソフトウェアサポート

NI アプリケーションソフ

トウェア

NI-DAQmx でサ

ポートされている

バージョン

従来型 NI-DAQ で

サポートされてい

るバージョン

LabVIEW  7.x 6.0 ～ 7.x

LabVIEW RT モジュール — 6.0 ～ 7.x1 

LabWindows/CVI  7.x 6.0 ～ 7.x

Measurement Studio  7.x 6.0 ～ 7.x2

1 LabVIEW RT を使用する際には、該当する DAQ アプリケーションの従来型 NI-DAQ が必
要です。NI-DAQmx の今後リリースされるバージョンでは、LabVIEW RT がサポートされ
ます。

2 従来型 NI-DAQ には Measurement Studio C++ や .NET インタフェースは含まれません。



© National Instruments Corporation 145 DAQ クイックスタートガイド

表 2 は、NI-DAQmx および従来型 NI-DAQ がサポートするプログラミン

グ言語とそのバージョンです。
 

NI-DAQ の旧バージョンは他のアプリケーションソフトウェアおよび他の

言語のバージョンをサポートします。ドライバの旧バージョンをダウン

ロードするには、ni.com/support/ja/downloadを参照してください。

デバイスサポート
特定のデバイスのモデル名については、CD にある『NI-DAQ 7.x 
Readme』を参照してください。表 3 は、NI-DAQ 7.1 の NI-DAQmx、
従来型 NI-DAQ、および NI-SWITCH 2.1 でサポートされるデバイスの種

類です。 

表 2 NI-DAQ 7.x プログラミング言語サポート

プログラミング言語

NI-DAQmx でサ

ポートされている

バージョン

従来型 NI-DAQ で

サポートされてい

るバージョン

ANSI C ✓ ✓

Microsoft Visual C++
Class ライブラリ
C DLL

7.x1

6.0 ～ 7.x
—

6.0 ～ 7.x

Visual Basic 6.0
（ActiveX 使用）

— 6.0

Microsoft .NET 言語 
(C# および Visual 
Basic .NET)

.NET 1.1 —

1 Measurement Studio 7.xが必要です。

表 3 NI-DAQ 7.1 デバイスサポート

デバイス NI-DAQmx
従来型

NI-DAQ NI-SWITCH 2.1

マルチファンクション DAQ

NI PCI-6052E などの PCI/PXI E シリーズ
のデバイス

✓ ✓ 該当なし

PCMCIA E シリーズ DAQCard-6024E、
DAQCard-6036E、および

DAQCard-6062E デバイス

✓ ✓ 該当なし

NI PCI-6013/6014 16 ビットベーシックデ
バイス

✓ ✓ 該当なし

AT E シリーズ — ✓ 該当なし
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USB および FireWire（IEEE 1394）用

DAQPad デバイス

— ✓ 該当なし

NI PXI-6115 などの S シリーズ — ✓ 該当なし

アナログ入力

PCMCIA DAQCard-AI-16E-4/
DAQCard-AI-16XE-50

— ✓ 該当なし

アナログ出力

NI 670X — ✓ 該当なし

NI PCI/PXI 671X/673X — ✓ 該当なし

NI PCI-672X ✓ — 該当なし

カウンタ / タイマ

NI 660X — ✓ 該当なし

NI PCI-6624 光絶縁 ✓ — 該当なし

AT-AO-6/10 — ✓ 該当なし

高精度 DAQ

NI 4350/4351 — ✓ 該当なし

デジタル I/O

NI 6503/NI PXI-6508/NI 6527/
NI PCI-DIO-96 デジタル I/O

✓ ✓ 該当なし

NI 6509/NI 6514/NI 6515/NI 6528
デジタル I/O

✓ — 該当なし

NI 653Xデジタル波形生成 / アナライザ — ✓ 該当なし

NI DAQCard-DIO-24/
NI DAQPad-6507/
6508 USB デジタル I/O

— ✓ 該当なし

PC-DIO-24/PC-DIO-96 デジタル I/O — ✓ 該当なし

AT-DIO-32F — ✓ 該当なし

ダイナミック信号集録

NI PCI-4451/4452/4454 — ✓ 該当なし

NI 4551/NI 4552/NI 447X — ✓ 該当なし

表 3 NI-DAQ 7.1 デバイスサポート（続き）

デバイス NI-DAQmx
従来型

NI-DAQ NI-SWITCH 2.1
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NI-DAQ 7.1 で初めてサポートされるようになったデバイスのリストは、

CD またはスタート→プログラム→ National Instruments → NI-DAQ か

ら、『NI-DAQ 7.x Readme』を参照してください。

NI-DAQmx の今後のリリースでサポートされる
デバイス
NI-DAQ の今後のリリースでは、現在は従来型 NI-DAQ でのみサポート

されているデバイスを NI-DAQmx でサポートします。

従来型 NI-DAQ でのみサポートされているデバイス
NI-DAQmx では、以下のデバイスはサポートされません。これらのデバ

イスは従来型 NI-DAQ のみでサポートされます。

• AT E シリーズデバイス

• AT-AO-6/10 アナログ出力デバイス

• AT-DIO-32F 32 ビットパラレル DIO デバイス

• PCMCIA DAQCard-AI-16E-4/DAQCard-AI-16XE-50 アナログ入力

マルチファンクション DAQ

• NI PCI-4451/4452/4454 ダイナミック信号集録生成デバイス

• NI 4350/4351 高精度温度 / 電圧測定器

• PC-DIO-24/PC-DIO-96 スタティックデジタル I/O デバイス

信号調節

SCXI モジュール ✓ ✓ 該当なし

SCC シリーズモジュール ✓ ✓ 該当なし

NI PXI-4204/PXI-4220 信号調節実装 ✓ — 該当なし

スイッチ

NI SCXI-1160/SCXI-1161/SCXI-1163R 
モジュール

✓ ✓ ✓

その他すべての SCXI スイッチ
モジュール

✓ — ✓

NI PXI-2501/PXI-2503/PXI-2565/
PXI-2590/PXI-2591 モジュール

— — ✓

その他すべての PXI スイッチモジュール ✓ — ✓

表 3 NI-DAQ 7.1 デバイスサポート（続き）

デバイス NI-DAQmx
従来型

NI-DAQ NI-SWITCH 2.1
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NI-DAQ 7.xでサポートが廃止されたデバイス
以下のデバイスは NI-DAQ 7.x（NI-DAQmx または従来型 NI-DAQ）でサ

ポートされず、NI-DAQ の今後のバージョンでもサポートされません。

これらのデバイスをプログラムするには、NI-DAQ 6.9.xまたはそれ以前

のバージョンが必要です。

• AT-MIO-16F-5 マルチファンクション DAQ デバイス

• DAQCard-500、DAQCard-516、DAQCard-700、
DAQCard-1200、および DAQCard-AO-2DC PCMCIA デバイス

• パラレルポート用 DAQPad-1200 および DAQPad-MIO-16XE-50 デ

バイス

• PCISA および PC/XT MIO デバイスの Lab-PC シリーズ

• PC-516 16 ビット 50 kS/ 秒 MIO デバイス

• PC-AO-2DC 低コスト AO および電流ループ DAQ デバイス

• PC 用 PC-LPM-16PnP MIO デバイス

• PC 用 PC-OPDIO-16 光絶縁 DIO デバイス

• PC 用 PC-TIO-10 タイミングおよび DIO インタフェース

• PC-1200 12 ビット 100 kS/ 秒 MIO デバイス

• SCXI-1200 12 ビット DAQ および制御モジュール

• SCXI-2000 4 スロットシャーシ

• SCXI-2400 シリアルインタフェースモジュール

• VXI DAQ モジュール、VXI-SC キャリアおよびモジュール、および

VXI バス用 VXI-TB ターミナルブロック
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